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refacio

Gracias por comprar este producto Topcon. El material que se
ofrece en el presente Manual (el “Manua”) ha sido preparado por
Topcon Positioning Systems, Inc. (“TPS’) paralos propietarios de
productos Topcon y ha sido disefiado parafacilitarles el uso del
receptor, estando su uso sujeto a los presente términos y
condiciones (los “Términos y Condiciones’).

@ AVISO

Por favor lea cuidadosamente los presentes Términos y
Condiciones.

Términos y Condiciones

USO PROFESIONAL - Este producto ha sido disefiado para ser
utilizado por un profesional. Es necesario que €l usuario seaun
topografo profesional o cuente con un amplio conocimiento de la
topografia para que pueda entender las instrucciones para el usuario
y de seguridad antes de operar, inspeccionar o efectuar gjustar al
equipo. Siempre debe utilizar vestimenta de seguridad apropiada
(calzado de seguridad, casco de seguridad, etc.) cuando opere e

equipo.

DERECHOS DE AUTOR - Toda lainformacién contenida en el
presente Manual es propiedad intelectual de TPSy esta sujetaalos
derechos de autor de TPS. Se reservan todos los derechos. Usted no
puede utilizar, leer, copiar, guardar, mostrar, crear obras derivadas,
vender, maodificar, publicar, distribuir, o permitir el acceso de
terceros alos gréficos, contenido, informacién o datos incluidos en
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e presente Manual sin €l expreso consentimiento por escrito de
TPSYy Unicamente podra utilizar estainformacién parael cuidado y
operacion de su receptor. Lainformacién y datos contenidos en €l
presente Manual constituyen un activo valioso de TPS, han sido
desarrollados gracias alainversion considerable de trabajo, tiempo
y dinero y son resultado de la seleccion original, coordinacion, y
adaptacion realizadas por TPS.

MARCAS REGISTRADAS — Topcon®, HiPer® y Topcon
Positioning Systems™ son marcas registradas de TPS. Windows®
es una marca registrada de Microsoft Corporation. La marca
Bluetooth® y sus respectivos | ogotipos son propiedad de Bluetooth
SIG, Incy Topcon Positioning Systems, Inc. se encuentra
autorizado, por medio de unalicencia, a hacer uso de tales marcas
por Topcon Positioning Systems, Inc. Otros productosy nombres
de compaiiias a las que se hace mencién en el presente documento
Son marcas registradas de sus respectivos propietarios.

CLAUSULA DE EXENCION DE RESPONSABILIDAD —
CON EXCEPCION DE LAS GARANTIAS QUE SE
DESCRIBEN EN LOSAPENDICES O EN LA TARJETA DE
GARANTIA QUE ACOMPANA AL PRODUCTO, EL
PRESENTE MANUAL Y EL RECEPTOR SE ENTREGAN “TAL
COMO ESTAN”. NO EXISTEN OTRAS GARANTIAS. TPS
DESCONOCE CUALQUIER GARANTIA IMPLICITA DE
COMERCIALIZACION O IDONEIDAD PARA UN USO O FIN
PARTICULAR. TPSY SUSDISTRIBUIDORESNO ASUMIRAN
RESPONSABILIDAD ALGUNA POR ERRORES TECNICOS O
EDITORIALESU OMISIONES COMETIDASEN EL
PRESENTE DOCUMENTO; NI EN CASO DE DANOS
INCIDENTALES O QUE SE RESULTEN DE LA PROVISION,
RENDIMIENTO O USO DE ESTE MATERIAL O DEL
RECEPTOR. DICHOS DANOS INCLUYEN, ENTRE OTROS,
PERDIDA DE TIEMPO, PERDIDA O DESTRUCCION DE
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Términos y Condiciones

DATOS, LUCRO CESANTE, PERDIDAS DE AHORROS O
GANANCIAS O PERDIDAS GENERADAS POR EL USO DE
LOS PRODUCTOS. ADEMAS, TPS NO SE RESPONSABILIZA
POR DANOS O COSTOS INCURRIDOS EN RELACION CON
LA OBTENCION DE PRODUCTOS O SOFTWARE
SUSTITUTOS, RECLAMOS DE TERCERQOS,
INCONVENIENCIA, U OTROS COSTOS. EN CUALQUIER
CASO, TPSNO ASUMIRA RESPONSABILIDAD POR LOS
DANOS U OTROS A USTED O A CUALQUIER OTRA
PERSONA O ENTIDAD POR UN MONTO SUPERIOR AL
PRECIO DE COMPRA DEL RECEPTOR.

CONVENIO DE LICENCIA —El uso de programas de
computadoras o software suministrados por TPS o que hayan sido
descargados de un sitio web de TPS (el “ Software”) en relacion con
€l receptor constituye la aceptacion de los Términos y Condiciones
contenidos en el presente Manual e indica su conformidad y
aceptacion de los presentes Términosy Condiciones. Sele otorgaal
usuario unalicencia personal, no exclusiva e intransferible de
utilizar dicho Software de conformidad con |os términos sefial ados
en el presente documento y en cualquier caso Unicamente con un
sblo receptor o una sola computadora. Usted no debera entregar o
transferir el Software o estalicenciasin el expreso consentimiento
de TPS. Estalicenciatendra validez hasta que se dé por terminada.
Usted puede dar por terminadala licencia en cualquier momento
mediante la destruccion del Softwarey del Manual. TPS podria dar
por terminadalalicenciasi usted deja de cumplir con cualquierade
los Términos 'y Condiciones. Usted se compromete a destruir €l
Software y el manual después de concluir con el uso del receptor.
Todos | os derechos de propiedad, derechos de autor y de propiedad
intelectual del Software le pertenecen a TPS. Si considera que los
términos de esta licencia no son aceptables, devuelva el softwarey
el manual sin utilizar.

P/N 7010-0557-SP www.topconpositioning.com
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CONFIDENCIALIDAD —El presente Manual, sus contenidosy €l
Software (denominados en conjunto, “Informacién Confidencial™)
constituyen informacién confidencial y son propiedad de TPS.
Usted se compromete atratar la Informacion Confidencial de TPS
con un nivel de cuidado no menos estricto que el que utilizariapara
proteger sus documentos secretos de comercializacion més
valiosos. Nada de lo contenido en este parrafo implica que usted
guede impedido de divulgar Informacién Confidencial a sus
empleados que sea necesaria 0 conveniente parala operacion o
cuidado del receptor. Dichos empleados también deben mantener
de manera confidencial laInformacion de Confidencialidad. En el
caso gue usted se vea legalmente obligado a divulgar la
Informacion Confidencial, debe comunicarselo inmediatamente a
TPS de manera que TPS pueda buscar una orden de proteccién u
otro remedio adecuado.

SITIO WEB; OTRAS DECLARACIONES— Ninguna
declaracion contenidaen el sitio web de TPS (o en cualquier otro
sitio web) o en publicidad o literatura de TPS 0 hecha por un
empleado o un contratista independiente de TPS modificalos
presentes Términos y Condiciones (incluyendo lalicencia, garantia
y limitacién de responsabilidad del Software).

SEGURIDAD - El uso inadecuado del receptor puede ocasionar
dafios a personas o propiedad y/o e funcionamiento incorrecto del
producto. El receptor Unicamente deberd ser reparado por los
centros de servicio de garantia autorizados de TPS. Los usuarios
deben revisar y prestar atencion alas advertencias de seguridad
contenidas en el Apéndice B.

VARIOS - Los Términos y Condiciones antes mencionados
podrian ser enmendados, modificados, anulados, o cancelados, en
cualquier momento por parte de TPS. Los Términos y Condiciones
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Informacion Regulatoria

antes mencionados seran regulados, e interpretados de conformidad
con las leyes del Estado de California, sin referenciaal conflicto de

leyes.

Informacion Regulatoria

L as siguientes secciones ofrecen informacion sobre el
cumplimiento de este producto con las regul aciones
gubernamental es.

Cumplimiento Clase B de la FCC

Este dispositivo cumple con la Parte 15 de lasreglas FCC. La
operacion se encuentra sujeta a las dos condiciones siguientes:

1. Estedispositivo no debe causar interferencia peligrosa; y

2. Estedispositivo debe aceptar las interferencias recibidas,
incluyendo aquellas que pudiesen provocar una operacion
indeseada.

Este equipo ha sido probado y se ha determinado que cumple
con los limites establecidos para un dispositivo digital de Clase
B, de conformidad con la Parte 15 de las regulaciones de la
FCC. Estos limites han sido disefiados para ofrecer una
proteccién razonabl e contra unainterferencia peligrosa en
instalaciones residenciales. Este equipo genera, utilizay puede
emitir energia de radio frecuenciay en caso que no sea
instalado o utilizado de conformidad con las instrucciones,
podria causar unainterferencia peligrosa alas comunicaciones
deradio. Sin embargo, no se garantiza que no ocurratal
interferencia en unainstalacion en particular.

En caso que este equipo cause interferencia en larecepcion de
equipos de radio o television, lo cual puede determinarse
apagando y encendiendo el equipo, se recomienda al usuario a
intentar corregir lainterferenciatomando unao més de las
siguientes medidas:

« Reoriente o0 reubique la antena de recepcion.

P/N 7010-0557-SP www.topconpositioning.com

ix



Prefacio

» Algje el equipo del receptor.

Enchufe el equipo en un tomacorriente en un circuito
diferente a utilizado para alimentar €l receptor.

 Consulte con € distribuidor o un técnico experimentado en
radio/television y solicitele sugerencias adicionales

PRE£CI6N PRECA UCIO’N

Cualquier cambio o modificacién al equipo que no
haya sido expresamente aprobado y que sea
efectuado por la parte responsable del cumplimiento
podria invalidar su autoridad para operar dicho
equipo.

Requerimientos Canadienses relacionados
con el Etiquetado de Emisiones

Este equipo digital delaClase B cumple con todos los
reguerimientos de las Regulaciones Canadienses
correspondientes a Equipos que Causan Interferencias.

Cet appareil numérique de la classe B respecte toutes les
exigences du Réglement sur le matériel brouilleur du Canada.

Convenciones utilizadas en el presente
Manual

El presente manual utiliza las siguientes convenciones:
Ejemplo Descripcion

File » Exit Haga clic en e menu File (Archivo) y después en
Exit (Salir)

Enter Presione o haga clic sobre el boton o tecla Enter
(Aceptar).
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Convenciones utilizadas en el presente Manual

RECOMMENDACION

Informacién complementaria que puede ayudarlo a
configurar, mantener, o instalar un sistema.

@ AVISO

Informacion complementaria que puede tener un efecto
sobre la operacion del sistera, rendimiento del sistema,
mediciones o seguridad personal.

chms PRECAUCION

Notificacién que una accion puede tener efectos
adversos en la operacion del sistema, rendimiento
del sistema, integridad de los datos o la salud
personal.

ADVERTENCIA

Notificacion que una accién generara el dafio del
sistema, pérdida de datos, pérdida de la garantia o
danos personales.

@ PELIGRO

BAJO NINGUNA CIRCUNSTANCIA DEBE EJECUTAR ESTA
ACCION.
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Notas:

Xii
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Capitulo 1

ntroduccion

El presente capitulo describe:
 Losreceptores HiPer® Lite e HiPer® Lite+ (Figura 1-1)
» El GPSYy su receptor
 Funciones comunes del receptor

Contenido del paquete estdndar y configuraciones
» Componentes del receptor

El Archivo de Autorizacion de Opciones (OAF)

HiPeryjer =5

Figura 1-1. Receptores HiPer Lite y HiPer Lite+
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Introduccién

Descripcion General

El HiPer Litey el HiPer Lite+ de Topcon Positioning Systems son
receptores GPS+ de dobl e frecuencia disefiados para ser 1os
receptores méas avanzados y compactos del mercado topogréfico. El
HiPer Litey el HiPer Lite+ son receptores multi-funciones y multi-
propésito disefiados para mercados de precision. El término
mercados de precision hace referencia a equipos, sub-sistemas,
componentes y software para topografia, construccion, mapeo
comercial, ingenieria civil, agriculturade precision y construccion
entierray control de maquinaria para agricultura, mapeo
fotogramétrico, hidrografiay todo uso que razonablemente se
relacione con |os que se han mencionado anteriormente.

Tanto el HiPer Lite como & HiPer Litet pueden recibir y procesar
seflalesL1y L2, mejorando la precision de sus puntosy posiciones
de levantamiento. La doble frecuenciay las caracteristicas GPS+
del HiPer Litey del HiPer Lite+ se combinan para ofrecerle el
anico sistema cinemético en tiempo real (RTK) preciso paralineas
de base tanto cortas como largas. Otras caracteristicas més, entrelas
gue seincluyen lamitigacion del efecto multipath 'y el rastreo
cooperativo, garantizan la recepcién con un follagje denso y con una
sefial débil. Los receptores ofrecen lafuncionalidad, precision,
disponibilidad e integridad requeridas para una col eccién de datos
rapiday sencilla

Principios de Operacion

Si el usuario utiliza el receptor GPS correcto, podra efectuar
levantamientos con un posicionamiento preciso y exacto, un
requerimiento indispensabl e para cualquier proyecto topogréfico.

Esta seccién le ofrece una descripcion general del GPSy de las
funciones del receptor con € objeto de ayudarlo a entender y
aplicar los principios GPS para que pueda sacarle el maximo
provecho a su receptor.
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Principios de Operacion

Descripcion General del GPS

El Sistema de Posicionamiento Global (GPS) es un sistemade
navegacion radial basado en satélitesy en lalineade vision, €
cual esdirigido por el Departamento de Defensa (DoD) de los
Estados Unidos. Este sistema ofrece un servicio ofrece un
posicionamiento global en todo tipo de climas, 24 horas al dia,
con rapidez y atiempo atodo usuario que cuente con un
receptor de rastreo GPS, gque se encuentre en o cercade la
superficie terrestre. El Sistema Global de Navegacion Satelital
(GLONASS), eslacontraparte del Ministerio de Defensadela
Federacion Rusa para el GPS. En cualquier momento, con un
angulo estandar de 15 grados, hasta 10 6 12 satélites son
visibles en cualquier punto de latierra. Cuando un receptor
también rastrea satélites GLONASS, entre 10 y 16 satélites son
visibles.

Si desea obtener informacion sobre el estado actual dela
constelacion GPS, visite http://tycho.usno.navy.mil/ o
http://www.navcen.uscg.gov/. En el caso de GLONASS, visite
http://www.glonass-center.ru/frame.html.

A pesar de las numerosas diferenciastécnicas en la
implementacién de estos sistemas, tanto el GPS como
GLONASS estan formados por tres componentes esenciales:

 Espacio — Satélites GPSy GLONASS orbitan a
aproximadamente 12,000 millas n&uticas sobre la Tierray
estén equipados con un reloj y un radio. Estos satélites
transmiten informacién digital (efemérides, almanaques,
correcciones de frecuencia de tiempo, €etc.).

* Control — Estaciones terrestres ubicadas arededor de la
tierra que monitorean los satélites y cargan datos,
incluyendo correcciones horarias y efemérides nuevas
(posiciones satelitales como una funcién de tiempo) con e
fin de asegurar que los satélites transmitan los datos
correctamente.
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Introduccién

Topcon

» Usuario — Lacomunidad civil y militar que utilizalos
receptores GPS/GLONASSYy |os satélites correspondientes
para calcular posiciones.

Calculo de Posiciones

Unavez que €l receptor capta un satélite, empiezaa
registrar medicionesy recibir informacion digital diversa
(efeméride, almanague, etc.), la cual estransmitida por los
satélites. Para calcular una posicion, los receptores utilizan
la siguiente formula:

Velacidad x Tiempo = Distancia

Donde Velocidad eslarapidez con laque vigjan las ondas
radiales (es decir, lavelocidad delaluz) y Tiempo esla
diferenciaentre €l tiempo de transmisién de sefia y el
tiempo de recepcion de lamisma.

Para calcular posiciones 3-D absolutas: latitud, longitud, y
altitud, el receptor debe captar cuatro satélites. En un
escenario mixto, GPSy GLONASS, € receptor debe captar
por |o menos cinco satélites para obtener una posicion
absoluta.

Para garantizar unatolerancia alasfallas utilizando sdlo
GPS 0 s6lo GLONASS, € receptor debe captar un quinto
satélite. Seis satélites ofreceran unatoleranciaalasfallas
en escenarios mixtos. Generalmente, el nimero de satélites
GPSy GLONASS que pueden observarse no superalos
veinte (20).

Una que vez captado un satélite, €l receptor colecta
efemérides y almanagues, y guarda esta informacion en su
NVRAM (RAM no volatil).

» Lossatélites GPSy GLONASS transmiten datos de
efemérides ciclicamente, con un intervalo de 30
segundos.
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Principios de Operacion

* Los satélites GPS transmiten datos de almanague
ciclicamente con un intervalo de 12.5 minutos; los
satélites GLONASS transmiten datos de almanagque
ciclicamente con un intervalo de 2.5 minutos.

Posicionamiento GPS

L os tres elementos siguientes son necesarios para asegurar
un posicionamiento de calidad:

* Precisién — La precision de una posicién depende del
numero, integridad de la sefial y ubicacion (también
conocida como Dilucién de Precision o DOP) de los
satélites.

—El GPSdiferencial (DGPS) disminuye en gran medida
los errores atmosféricos y orbitales, y contrarrestalas
sefial es anti-spoofing trasmitidas con las sefiales GPS
por el Departamento de Defensa de los Estados Unidos.

—Mientras mayor sea el nimero de satélites visibles,
maés fuerte serala sefia, y menor el nimero de DOR, y
se obtendra un posi cionamiento Mas preciso.

* Disponibilidad — La disponibilidad de los satélites
afecta el cllculo de las posiciones vdlidas. Mientras
mayor sea el nimero de satélites disponibles, més
validay precisa seralaposicion. Los objetos naturales
y aquellos creados por el hombre pueden bloquear,
interrumpir y debilitar las sefiales, disminuyendo el
numero de satélites disponibles.
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* Integridad - Latoleranciaalasfallas hace posible que

una posicion tenga mayor integridad, mejorando asi la
precision de lamisma. Diversos factores se combinan
paraofrecer unatoleranciaalasfallas, entre los que se
incluyen:

—El Monitoreo Auténomo de laIntegridad del Receptor

(RAIM) detecta satélites GPSy GLONASS
defectuososy los eliminadel cdlculo delaposicion.

—-El sistema WAAS (Wide Area Augmentation System
0 Sistema de correccién de sefiales GPS) creay
transmite mensajes de correccion DGPS.

—Cinco 0 més satélites visibles solo para GPS o solo
para GLONASS,; seis 0 més satélites en €l caso de para
escenarios mixtos.

—Efemérides y almanagues actuales.

—Varios algoritmos paradetectar y corregir informacion
defectuosa

Conclusion

L os topografos pueden utilizar receptores GPS+ de Topcon
para colectar datos de unared de satélites y estaciones de
control paratriangular puntos precisos en cualquier lugar
delatierra

Esta descripcion genera explica, de manera sencilla, los
conceptos basicos del posicionamiento GPSy GLONASS.
Para obtener informacidn més detallada, visite €l sitio web
de TPS (www.topconps.com/gpstutorial/).

Topcon
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Descripcion General del Receptor

Unavez encendido €l receptor y que se ha completado la
prueba automética, los 20 canales del receptor seinicializany
empiezan arastrear satélites GPSy GLONASS visibles. Cada
uno de los canales del receptor puede utilizarse para rastrear
seflales C/A-L 1, P-L2 o P-L2. El nimero de canales
disponibles permite al receptor rastrear simultdneamente todos
los satélites GPS visibles en cualquier momento 'y ubicacion.
La antena GPS recibe las diferentes sefiales que procesara.

Unaantena GPS+ interna equipada con un amplificador de bajo
ruido (LNA) y € dispositivo de radio frecuencia (RF) del
receptor se conectan mediante un cable coaxial. La sefial de
banda ancha recibida es convertida, filtrada, digitalizaday
asignada a canales diferentes. El procesador del receptor
controla el proceso de rastreo de la sefial.

Unavez que € canal captala sefial, ésta se demodulay se
miden |os parametros de sefial necesarios (portadoray fases de
c6digo). Asimismo, los datos de navegacion transmitidos son
recuperados desde la pagina de navegacion.

Unavez que €l receptor capta cuatro o més satélites, es posible
resolver € problema denominado “problemade
posicionamiento absoluto” y calcular las coordenadas del
receptor (en WGS-84) y el tiempo. Toda esta informacion se
almacena en lamemoriadel receptor, lacual puede descargarse
después a una computadoray procesarse utilizando un pagquete
de software de post-procesamiento. Cuando el receptor
funciona en e modo RTK, las mediciones de datos sin procesar
también pueden registrarse en lamemoriainterna del receptor.
Esto le permite a operador verificar doblemente | os resultados
en tiempo real obtenidos en el campo.
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Dependiendo de sus opciones, las capacidades del receptor
incluyen:

* Rastreo Cooperativo
» Mitigacién del efecto multipath
* Sistema de correccion de sefiales GPS (WAAS)

 Parametros gjustables de bucle enganchado enfase (PLL) y
bucle enganchado con retardo (DLL).

» Modos de levantamiento estético de doble frecuencia,
cinemético, cinemético en tiempo real (RTK) y GPS
diferencia (DGPS).

* Registro automético de datos

« Establecimiento de diferentes angulos de méscara

* Establecimiento de diferentes parametros de levantamiento
» Modo estético y dinamico

Contenido del Paquete Estandar

El HiPer Lite o el HiPer Lite+ vienen en un paguete cinemético en
tiempo real (RTK) con dos receptores, uno como Estacién Basey €
otro como Estacion Rover (consulte también las instrucciones de
re-embalgje). El paguete incluye:

» Dos receptores HiPer Lite o dos receptores HiPer Litet+
* LitePole

* Tripode, base nivelante, y adaptador

 Software Topcon Tools™ (opcional)

 Cables, conectoresy adaptadores

» Documentacion
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Cables

Los cables del paguete estandar incluyen:
» Cable serial RS232 receptor a computadora
» Cable de energiadel receptor a SAE
» Extensién del cable SAE aSAE

Cable delas pinzas de cocodrilo a SAE

Cable de la fuente de suministro a tomacorriente

« Conector entre fuente de suministroy SAE
Cable USB de TPS (sblo para el HiPer Litet)

Software
El software estandar del receptor incluye:

» PC-CDU - software controlador que puede correr en una
computadora bajo Windows®. Por favor consulte el
Manual del Usuario PC-CDU para obtener informacion
detallada sobre este software.

» FLoader — Cargador de firmware de Topcon; disponible en
el sitio web de Topcon.

» BTCONF — Programa de configuracion del médulo de
tecnol ogia inal&mbrica Bluetooth® de Topcon; disponible
en el sitio web de Topcon.

* Modem-TPS — Software de configuracion del radio/médem
de Espectro Amplio de Topcon.

 Topcon Tools— opcional, software de post-procesamiento
de Topcon.

Puede encontrar el software e informacion sobre el software en
el sitio web de Topcon (www.topcongps.com/software/
index.html o http://www.topcongps.com/software/
3rdparty.html).
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L os siguientes software también serén (tiles para operar, cuidar
y utilizar su receptor, y podrian requerirse para algunas
aplicaciones.

* Survey Pro GPS— Software opcional deterceros Gtil parala
coleccion y visualizacion de datos; contactese con su
distribuidor TPS.

 Carlson SurvCE — Software opcional de terceros para
recoleccién de datos, contactese con su distribuidor TPS.

Documentacion
Documentacion incluida con el receptor:
* Tarjetade garantia de un afio

» Manual de Operacionesdel HiPer® Litey del
HiPer® Litet+

* Especificaciones funcionales

En el sitio web de Topcon puede encontrar |os manuales asi
como otro tipo de informacion con respecto alos productos.

* www.topcongps.com/support/manual s.html

» www.topcongps.com/hardware/index.html (después haga
clic en el producto apropiado)

L os siguientes manual es también podrian ser (tiles para operar
y cuidar su receptor. Estos manual es estan disponiblesen el
sitio web de Topcon (www.topcongps.com/support/
manuals.html).

* Manual de Usuario del PC-CDU
» Manual de Usuario del FLoader
* Manual de Usuario dela MINTER
* Manual de Usuario de BTCONF

1-10
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Conozca su Receptor

El receptor HiPer Lite/HiPer Litet+ tiene 159mm de ancho, 172 de
espesor, 88mm de alto y pesa aproximadamente 1.74 Kg. El disefio
avanzado del receptor permite alos usuarios reducir, de manera
significativa, € nimero de cables requeridos para la operacién del
receptor, permitiendo al usuario efectuar trabajos con méas
confiabilidad y eficiencia, especialmente cuando €l receptor se
encuentra en movimiento.

L os receptores también son versétiles y pueden configurarse de
diversas formas. La carcasa puede alojar ados baterias de Litio-lon
no removibles incorporadas, un médulo de tecnologiainalambrica
Bluetooth y dostarjetas Euro. Una de estas tarjetas es |a del
receptor GPS'y la otra se utiliza para comunicaciones (modem,
espectro amplio, GSM, o DGPS).

El HiPer Lite/HiPer Lite+ presentalos mismos componentes
estandar interiores de cualquier receptor y dos paneles parainterfaz
con el usuario, comunicacién y alimentacion. Si desea conocer las
especificaciones del receptor, consulte el Apéndice A. Veala
Tabla 1-1 donde se presenta la comparacion entre ambos
receptores.

Tabla 1-1. Comparacién entre HiPer Lite e HiPer Lite+

Componentes y Opciones HiPer Lite HiPer Lite+
Interfaz con €l usuario MINTER de 4 luces MINTER de 4 luces
Puertos A,B,C,Dyde A,B,C,D,USByde
Energia Energia

Tarjetadel receptor Euro 80 Euro 112

GPS L1, L1L2 L1, L1212

GLONASS L1, LYL2

Memoria Estandar: 0 MB Estandar: 0 MB
Opcional: 1 MB hasta | Opcional: 1 MB hasta
512 MB 1GB

Veala Tabla 1-3 en la pagina 1-15 para obtener una descripcion de
|os tiempos operativos de los receptores HiPer Lite e HiPer Lite+.
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Componentes Internos

L as siguientes secciones describen |as caracteristicas que se
encuentran dentro de la carcasa del receptor

Topcon

Antena GPS+

Antena de microstrip interna capaz de recibir sefiales GPS
L1/L2y sefidlesGLONASSL1/L2.

Modulo Bluetooth

Una combinacion de tecnologia de software y hardware
gue hace del HiPer Litey del HiPer Litet+ receptores GPS+
inaldmbricos y méviles que soportan un perfil serial punto
apunto. Como tal, el HiPer Lite/HiPer Litet puede
transferir y sincronizar archivos entre el receptor y
cualquier otro dispositivo de tecnologia inalambrica
Bluetooth que soporta el perfil serial, incluyendo
dispositivos handheld portétilesy controladores externos,
adaptadores PC-USB/RS, computadoras y tel éfonos
moviles, IPAQs, adaptadores PCMA a Bluetooth, etc.

Con latecnologiainal&mbrica Bluetooth, larecepcion'y
distancia de transmision es de 10 metros (32 pies) para

proyectos en interiores y 30 a 50 metros (98 a 164 pies)
para proyectos en exteriores.

El procesador y firmware del médul o Bluetooth son
independientes de latarjeta del receptor y tablero de
energia.

Radio Méodem

El receptor incorporaun modem interno de espectro amplio
de 915 MHz pararecibir datos desde una estacion Base o
paratransmitir datos a una estacion Rover. El médem de la
estacion base transmite la fase de portadoray mediciones
de cddigo junto con lainformacion de la estacion de
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referencia (es decir, ubicacién) a médem de la estacion
rover.

El radio médem interno incluye una serie de canales
preconfigurados que han sido programados en Topcon.
También es posible encontrar informacion completa con
respecto a su sistema de radio en la documentacion del
radio médem.

Tablero de Energia

El tablero interno de energia gestiona la energia del
receptor y la cargade bateriasy se conectaalatarjetadel
receptor y alas baterias. El tablero de energiarecibe
energia de las baterias internas, incluso si el receptor se
encuentra apagado. Esta caracteristica permite que las
baterias internas se carguen, independientemente del estado
del receptor (encendido o apagado). Para evitar que las
baterias se descarguen cuando €l receptor permanece
guardado, ponga el receptor en el Modo Energia Cero (vea
“Modo Energia Cero” en la pagina 4-24 para obtener méas
informacion). Las baterias no se cargaran en este modo.

El procesador y €l firmware de la tarjeta de energia son
independientes de latarjeta del receptor. Para asegurar la
compatibilidad del firmware, seré necesario cargar la
tarjeta del receptor GPSy latarjeta de energia con €l
firmware del mismo paguete.
Tarjeta del receptor GPS+
El receptor incluye una de las siguientes tarjetas:

* Tarjeta Euro-80 parareceptores HiPer Lite

* Tarjeta Euro-112 parareceptores HiPer Litet+

Dependiendo de las opciones adquiridas, estas tarjetas son
capaces de procesar las siguientes sefiales:

« GPSL10GPSL1L2 113
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* GPS/GLONASSL10GPS/GLONASSLY/L?2

La Tabla 1-2 enumeralas opciones disponibles para estas
tarjetas.

Tabla 1-2. Opciones de la Tarjeta Euro para el HiPer Lite y para HiPer Lite+

Modelo de la Tarjeta Euro Opciones Disponibles

Euro-80 GD (HE_GD) G:GPSL1

GD: GPSLVL2

Euro-112 (HE_GGD) G:GPSL1

GD: GPSL1L2
GG: GPS/GLONASS L1
GGD: GPS/GLONASSL1/L2

Topcon

Un receptor TPS con WAAS permite e rastreo simultaneo
de dos satélites WAAS. Cada uno de los satélites WAAS se
ubica en su propio canal.

Bateria

El receptor incluye dos paguetes de baterias incorporadas
no removibles recargables de Litio-lon conectadas al
tablero de energia del receptor. Cada uno de estos paquetes
de bateriasde Litio-lontiene 7.4 V y 4 Ah, ofreciéndole
una potenciatotal de 7.4 V nomina y 8 Ah si se encuentra
totalmente cargada.

LaTabla 1-3 en la pagina 1-15 describe los tiempos
operatives paralosreceptores HiPer Lite e HiPer Lite+, con
las baterias internas totalmente cargadas y dependiendo del
modo del modem.
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Tabla 1-3. Tiempos Operativos

Conozca su Receptor

Modo del Médem HiPer Lite HiPer Lite+
Apagado 23.5 horas 19 horas
Encendido y 19 horas 16 horas
Unicamente en modo de
Recepcion
Encendido en modo de 15 horas 13 horas
Transmision de 0.25
Vatios
Encendido en modo de 14 horas 10 horas

Transmision de 1 Vatios

Las baterias de Litio-lon que utiliza HiPer Lite deben

funcionar a no menos del 98% de su capacidad después de
500 ciclos de carga. Estas baterias no necesitan descargarse
antes de ser recargadas.

El paquete estdndar incluye un cargador de baterias
(Adaptador AC). Vea el Apéndice A para obtener las
especificaciones técnicas con respecto ala bateria.

Componentes Externos

Lacarcasadel HiPer Lite/HiPer Litet+ incluye tableros para
colocar laantena del mdédem, unainterfaz de usuario, un puerto

de energiay puertos para configuracion.

Panel Inferior
» NUmero de serie del receptor
» NUmero de parte del receptor

* Punto de ReferenciadelaAntena (ARP)
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Radomo

LaFigura 1-2 muestra los componentes del radomo, que
son igual es para ambos receptores, €l HiPer Litey el HiPer
Litet.

Figura 1-2. Radomo (HiPer Lite+)

» Antenainterna— Ubicacion de la antena interna GPS/
GLONASS.

» Conector de la antena del médem — El conector de la
antena del médem se utiliza parala conexién RF del
modem interno. Este es un conector hembra invertido
TNC paramoédems de espectro amplio.

1-16
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Panel Frontal

LaFigural-3y Figura1-4 en la pagina 1-18 muestralos
componentes del panel frontal de los receptores HiPer Lite
e HiPer Lite+.

MINTER

Tecla de Reseteo Encendido

Marca de Medida de Altura Inclinada
Figura 1-3. HiPer Lite Panel Frontal

* MINTER — INTERfaz Minima para el receptor. La
MINTER estaformada por tresteclasy cuatro LEDsde
tres colores. Vea“Uso delaMINTER” en lapégina 4-2
para obtener informacion sobre las descripcionesy
usos de los componentes de laMINTER.

 Teclade Reseteo — Al presionar estatecla se efectiaun
reinicio completo tanto paralatarjetadel receptor
como para €l tablero de energia. Unavez que se
presiona esta tecla, |os controladores que regulan la
tarjetadel receptor y €l tablero de energiasereiniciany
el dispositivo vuelve a arrancar.

Esta tecla puede utilizarse para salir del Modo Cero
Energiao si € receptor no responde alos comandos.
Vea“Uso delaMINTER” enlapégina 4-2 paraobtener
mayor informacion.
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 Cuatro puertos seriales:

—El puerto A se utiliza parala comunicacion entre el
receptor y un controlador u otro dispositivo externo.

—El puerto B se utiliza internamente para conectar la
tarjeta del receptor con € médulo Bluetooth.

—El Puerto C se utiliza internamente para conectar las
tarjetas del médem'y del receptor.

—El Puerto D se utiliza parala comunicacion entre el
receptor y un dispositivo externo

» USB — Disponible tnicamente en el receptor HiPer
Lite+; se utiliza paralatransferencia de datos de alta
velocidad y la comunicacion entre el receptor y un
dispositivo externo.

MINTER

Tecla de Reseteo Encendido

Marca de Medida de Altura Inclinada
Figura 1-4. HiPer Lite+ Panel Frontal

* PWR — Es €l puerto de entrada de energia al cual se
encuentra conectada la fuente externa de energia (+6 A
+28'V DC) y donde se cargala unidad.

1-18 » Marcade Medida de Altura Inclinada (SHMM)
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Panel Posterior

LaFigura 1-5 muestra el panel posterior del HiPer Litey
del HiPer Lite+; los componentes son |0s mismos para
ambos receptores.

Tapon de ventilacién

Marca de Medida de Altura Inclinada
Figura 1-5. Panel Posterior del HiPer Lite y HiPer Lite+

 Tapbn de ventilacion — Equilibrala presion entre la
parte interna del receptor y el medio exterior.

» Marcade Medida de Altura Inclinada (SHMM)

Archivo de Autorizacion de Opciones
(OAF)

Topcon Positioning Systems emite un Archivo de Autorizacion de
Opciones (OAF, por sus siglas en inglés) para habilitar |as opciones
especificas adquiridas por €l cliente. Un Archivo de Autorizacién

de Opciones permite alos clientes personalizar y configurar el

receptor de acuerdo con sus necesidades particulares, por o tanto,

estos Unicamente adquiriran las opciones que necesiten. 1-19
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Generalmente, todos los receptores incluyen un OAF temporal que
permite utilizar €l receptor durante un periodo determinado de
tiempo. Al comprar € receptor, un OAF nuevo activa las opciones
deseadas y compradas de manera permanente. L as opciones del
receptor permanecen intactas al clearing laNVRAM o resetear €l
receptor.

El OAF habilitalos siguientes tipos de funciones. Para unalista
completa de opciones y detalles disponibles, visite el sitio web de
TPS (www.topcongps.com/tech/index) o consulte con su
distribuidor TPS.

* Tipo de sefial (estandar L1; opcional L2)

* Memoria (estandar OMB; para el HiPer Lite, IMB hasta
512MB, para el HiPer Litet+, opcional 1IMB hasta 1GB

 Tasade actualizacion 1 Hz (opcional 5, 10 0 20 Hz)

* RTK alHz, 5Hz, 10Hz y 20Hz

 Entrada/Salida RTCM/CMR

» Marcador de Eventos

* Rastreo Cooperativo

» Mitigacién avanzada del efecto multipath

+ Sistema de correccion de sefides GPS (WAAS)

» Monitoreo Auténomo de la Integridad del Receptor (RAIM)

1 PPS (Pul so-por-Segundo, sefial de sincronizacion)

1-20
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El presente capitulo describe:
* Suministro de energiadel receptor
» Conexion del receptor y una computadora
 Configuracion del receptor
 Configuracion delaINTERfaz Minima (MINTER)
 Configuracion del radio
 Configuracién del modulo Bluetooth
* Coleccion de amanaques

Antes de comenzar a utilizar el receptor HiPer Lite o HiPer Lite+,
hagalo siguiente:

1. Cargue las baterias. Vea “Alimentacion del Receptor” en
lapéagina 2-2.
2. Configure las diversas partes de su receptor. Vea:

 “Conexion del Receptor y una Computadora’ en la
pagina 2-12,

 “Configuracion del Receptor” en la pagina 2-19,
 “Configuracion delaMINTER” en lapagina 2-24,

» “Configuracion del Radio” en lapagina 2-33 (en caso de
ser aplicable) y

* “Configuracion del Modulo Bluetooth” en la pagina 2-41.

3. Coleccién de ailmanagues. Vea “ Coleccion de Almanagues’ en
la pagina 2-47.
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Alimentacion del Receptor

Es posible alimentar el receptor con baterias internas, externaso a
través de un cargador de baterias.

Baterias Internas

Con una carga completay dependiendo del modo del radio
modem, las bateriasinternas deben alimentar al receptor GPSy
al radio modem de acuerdo con los tiempos descritos en la
Tabla2-1.

Tabla 2-1. Tiempos de Operacioén

Modo del Médem HiPer Lite HiPer Lite+
Apagado 23.5 horas 19 horas
Encendido y en modo de 19 horas 16 horas
sblo recepcion
Encendido y en modo de 15 horas 13 horas

Transmision de 0.25 Vatios

Encendido y en modo de 14 horas 10 horas
Transmision de 1 Vatio

1. Paracargar las baterias internas:

» Conecte el cable de energia del receptor a SAE en €
puerto de entrada de energia del receptor.

» Conecte el cable de energiaddl receptor aSAE Yy €
cable del suministro de energiaal tomacorrientes a
adaptador CA.

* Conecte el cable de suministro de energiaal cable del
tomacorriente en un tomacorriente disponible.

2. Presionelatecladereseteo en el receptor. Al hacerlo se
asegurard que €l receptor se encuentre en modo Normal
paracargar. El receptor no se cargaraen el Modo Energia
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Cero (vea“Modo Energia Cero” en la pagina4-24 para
obtener més informacion).

3. Dejecargar todalanoche. Una carga de nueve horas
cargara las baterias en aproximadamente un 90%. Una
carga de diez horas cargara totalmente el receptor. Las
baterias internas no pueden sobrecargarse.

Lavelocidad de la carga depende de | as configuraciones de
Energiay Carga de la pantalla de Configuracion del Receptor y
desi € receptor se encuentra apagado o encendido. Vea
“Gestion de la Energia” en la pagina 2-6.

Las bateriasde Litio-lon que utilizael receptor deben funcionar
ano menos del 98% de su capacidad después de 500 ciclos de
carga. Estas baterias no necesitan descargarse antes de ser
recargadas.

Baterias Externas

Ademas de |as baterias internas, es posible utilizar su receptor
con baterias externas (Figura 2-1 en la pagina 2-4). El uso de
baterias externas le permite continuar utilizando €l receptor en
caso que las baterias internas se descarguen. Para utilizar las
baterias externas, usted debe tener:

* unabateriade 12V, 2.3 A*h
* unapinza para baterias 2.3 A*h conectada al conector SAE
« un cable de SAE al enchufe de energia

@ AVISO

Cuando el receptor utiliza baterias externas, ponga el
modo del cargador en Off (Apagado). De lo contrario, las
baterias externas también cargaran las baterias
externas, haciendo que el tiempo operativo disminuya.
Vea “Gestion de la Energia” en la pagina 2-6 para
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obtener mayor informacion con respecto a la
configuracion del modo del cargador.

1. Conectelos dos cables utilizando conectores SAE.

2. Enchufe el cable de alimentacion en el puerto de
alimentacion del receptor.

3. Conecte lapinzaparabaterias alabateria. Una sola bateria
externade 12V, 2.3 A*h debe alimentar a receptor durante
aproximadamente 7 horasy a receptor y médem durante
no menos de 5 horas.

Figura 2-1. Bateria Externas

RECOMMENDACION

También puede utilizar un cable de extension SAE a SAE
y una pinza tipo cocodrilo al cable SAE, y cargue su
receptor directamente desde una bateria, como por
ejemplo la bateria utilizada para alimentar el radio de la
Base o0 una bateria similar.

2-4
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Cargador de Bateria

El mismo cargador utilizado para cargar las baterias internas
puede utilizarse como suministro externo de alimentacion para
el receptor. El cargador seincluye en el paquete del receptor.

1. Conecteel cabledel receptor a SAE en el puerto de entrada
de energia del receptor.

2. Conecte el extremo del cable SAE a cargador de baterias.

3. Enchufe e cable de energia del cargador de baterias en €l
adaptador CA.

4. Conecte el cable de energia en un tomacorriente conectado
atierradisponible. La entrada de energia para su cargador
de bateriadebe ser CA entre 90y 264V 1A (110V CA) y
entre 47 Hz y 63 Hz. El cargador de baterias genera CC 12
V 25A (30W).

Encendido/Apagado del Receptor

Para encender el receptor, presione y mantenga presionada la
tecla verde de encendido durante aproximadamente 0.5
segundosy suéltela.

@ AVISO

Si el receptor no enciende, podria estar en el Modo
Energia Cero. Vea “Modo Energia Cero” en la pagina 4-
24 para obtener mas informacion.

Paraapagar el receptor, presioney mantenga presionadalatecla
verde de encendido durante mas de uno y menos de cuatro
segundos (hasta que ambos LEDSs, €l de ESTADOYy € de
REGISTRO estén apagados). Este retardo (de
aproximadamente 1 segundo) evitara que el usuario apague el
receptor por error.
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Gestion de la Energia

Utilice el software PC-CDU para gestionar la energia de su
receptor. La descripcion completa del software PC-CDU se
encuentra fuera del alcance del presente manual, pero puede
encontrarlaen e Manual del Usuario del PC-CDU. Puede
descargar |a copia més reciente de este software y €l manual en
el sitioweb de TPS.

Para acceder ala pestafia que controlalos valores de energia de
Su receptor, sigalos siguientes pasos.

1. Conecte su receptor y unacomputadora. Vea“ Conexion del
Receptor y una Computadora’ en lapagina 2-12 para
obtener informacién con respecto a este procedimiento.

2. Unavez conectados, hagaclic en Configuration »
Receiver (Figura2-2).

Configuration

Site i i Chrl+I

Target position Chrl+T
Radio 3

Figura 2-2. Configuration » Receiver

3. Seleccione lalista desplegable Power Mode (Modo de
Energia) para configurar lafuente de energia deseada
(Figura 2-3enlapégina 2-7). Current Mode (Modo Actual)
muestra el suministro de energia actual.

» Auto — € receptor automaticamente seleccionarala
fuente de energia.

* Mix — €l receptor autométicamente detectardy
empezara a consumir energia de la fuente con mayor
voltaje.

 Battery A — €l receptor consumira energia de la bateria
A.

2-8  Battery B — el receptor consumira energia de la bateria
B.
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Alimentacién del Receptor

 External — el receptor utilizara unafuente de
alimentacion externa.

D x|
Gonesod | MINTER | Pestunng | Bave | Hoven | Puts | Events | Advered |

s Power 5085 [volts}
Trmrrwrial £ bervadior Mask. 5 Miodae: ma hd nal -
Aninnna “Anberea Stans (read onk) Cusiert Mode [ it
2
Cumend Input e
£ Fslpn e g Fiatten:
- Ext O Status  [o!f (1 |
Bamer:
Tempesatun (Colius dogeeest e 2
B irampessnre 14 || Cusent Mode : Current Mode :
Fiwer iUl modes Tum
Foita: [ - g 4
Skt =

7 Engtle Low Powar Mode

Rehiesh Py ‘

OF. I Lt Save Gualnnlnmﬂuﬂodefml

Figura 2-3. Select Power Mode (Seleccionar Modo de Energia)

4. Seleccione lalista desplegable Charger Mode (Modo del
Cargador) para definir el modo de carga deseado
(Figura 2-4 en la pagina 2-8). Current Mode muestrala
bateria que se esta cargando: a, b 0 ninguna (apagado).

Off — El receptor no cargara las baterias.

Charge A — €l receptor solo cargara labateria A.

Charge B — €l receptor solo cargarala bateria B.

Auto — el receptor automati camente detectardy cargara
ambas baterias.
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Gonesod | MINTER | Pestunng | Bave | Hoven | Puts | Events | Advered |

Ebevalions sk [dayoes] P"‘""‘r,"“““"’"""' Charge
Trmrrwrial £ bervadior Mask. 5 Moda: m e g
Anipoon Aevere St oot oo} Cuerebode: [ | oo | MO0 o
it -
£ Frtr A Chasgee e | Speed: Charge &
o £t DC Staus : [ Mods: b Charas B
Eiamer: ° d
—tar— S | Curent Mode : |yt
B iempossture : ] Cussert Mads [
Foaver nulpul moder Turm ondolt Siots
Ptz O - Skt 2
- : = F Sked
Shets 00 7] | | & s
7 Engtle Low Powar Mode
Fslissh oy

OF. I Lt Save Gualnﬂunumhdefml

Topcon

Figura 2-4. Seleccione Charger Mode (Modo del Cargador)

Seleccione lalista desplegabl e Ports de Power output
modes (Modos de salida de energia) (Figura2-5enla
pagina 2-9).

* On-dl tablero de energiaalimentaraalaespigauno de
todos los conectores de los puertos seriales cuando €
receptor se encuentre encendido. Si €l receptor se
encuentra apagado, no habra energia en ninguno de los
puertos.

» Off —no habra energiaincluso si el receptor se
encuentra encendido.

» Always— €l tablero de energia alimentara con voltaje a
la espiga uno de todos | os conectores de |os puertos de
serieincluso si el receptor se encuentra apagado.

Seleccione los Power output modes (Modos de salida de
energia) de lalista desplegable Sots para configurar la
salida de energia en los slots internos (Figura 2-5 en la
pagina 2-9).

» On —todos los slots seran alimentados si €l receptor se
encuentra encendido.

» Off —los dlots internos no serédn alimentados incluso si
€l receptor se encuentra encendido.
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Alimentacién del Receptor

» Always—losdotsinternos seran alimentadosincluso si
el receptor se encuentra apagado.

D

Gonesod | MINTER | Pestunng | Bave | Hove | Purte | Evens | Ardvarse |

Eberiiors sk [chegmns]
Tl Eberealiors Miask:

ry— Arteres Stonas (read onk)
It Cumert Input - |-

3

Temperahan [Crbsus degens}
Bl dnmpesature

- " Ext DC Status : |0/

Pss managemert
Fower
Mode: s =] || Bt Power output mode:
Cunerk Mede s [
- OBl | Parts :
Chasger: -
Mo : s

e
|| Cueer Mo :
Foaver nulpul moder Turm ondolt Siots
Ptz n - gsn?

Skl
Skas on 2 || & s
5
Relesh

OF. I Lt Save Gualnﬂunueuhdefml

ol Opiaducl |

Power output mode:

Parts :

Slats :

Figura 2-5. Seleccione Power output modes (Modos de salida de energia) —

Ports y Slots

7. Ver Informacion sobre Voltajes (Figura 2-6 en

la pagina 2-10).

« Externa — muestra el voltgje de la fuente de
alimentacion externa.

* On Board —muestrael voltaje consumido por el tablero

del receptor.

* Battery A —muestra el voltaje de labateria A.
* Battery B —muestra el voltgje de la bateria B.

» Charger — despliega el voltgje de salida del cargador
durante la carga de la bateria.
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sf| 1 votages ol
Gonesod | MINTER | Pestunng | Bave | Hoven | Puts | Events | Ardvaree | el - |12_1
Elerwialior ik [chegrmnz] ot v prrrr .
Tl E oo Mack: 5 o e =] || Exenat: o7 OnBoard: I?-B
[ Aeberen Stahs ead o] comertode: [5 || oo [T Batterys: [7.64
Sl Cumert Input = = h -
£ Exdpmngd haeger Ratbeny & 4
o £t DC Staus : [ Mods: a7 o Battery B : I?_51
BameyB: 75
~Temporstun (Cokius doges} x
Bt drampessnre ] || Cusere Meds « Chasger: [755 Charger : I?.BS
Froaver nulpul moder 1 1 Tum ondolt Siots
; - W Skt
Ptz O =
Shoas: O
¥ Enstle Low Power Mode
Fslissh Pundy

OF. I Lt Save Gnlalnnlmﬂodefml

Figura 2-6. Ver Informacién con respecto al Voltaje

8. Seleccioney habilite cada unadelas casillas de
verificacion de Turn on/off Sots para habilitar 1os slots
internos correspondientes (Figura 2-7).

9. Seleccioney habilite la casilla de verificacion Enable Low
Power Mode para que el procesador del receptor pase a
modo de bajo consumo de energia (Figura 2-7).

10. Hagaclic en Apply.

o
Gonesod | MINTER | Pestunng | Bave | Hoven | Puts | Events | Advered |
Elevaliors mk [dagrnns) L N, A0 FroRTY Tum ondoff Slat
Tonmransl Ebvalion Mask 5 Mode: m Extaimal: ,_ p Slat 2
?‘ml.:::nd Arverras Stanss fread o) Cunert Mode : [ On Booed: [ ¥ Slot 3
Cumert Input - o
" Exmnal hawger Baseyi: [T4 [+ Slat 4
& Ao Bt OC Status [/ Mode - s o=
Bamay: [750
~Temperatur (Cobiss dogorsl = '
e 1 Conhode: [ || Chemer: [E
P putput modey 101 Tum ondolt Siots
Foita: [ N
7 Skt3
¥ Enable Low Power Maode it - o =1 [l s
|5 Enstie Low Poner ods |
Relesh fosk

OF. I Lt Save Gnlalnnlmﬂodefml
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Figura 2-7. Habilitar y Aplicar Valores de Energia
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Carga de las Baterias Internas

Utilice una de las siguientes condiciones para obtener la
velocidad maxima de carga de bateria.

« El receptor se encuentra apagado. Power Mode (Modo
de Energia) se configura en External y Charger Mode
(Modo del Cargador) en Auto. Vea“Gestiéon dela
Energia’ en la pégina 2-6 para configurar estos
parametros.

* El receptor se encuentra encendido. El Power Mode se
configuraen External y el Charger Maode en Auto.

1. Paracargaer las baterias internas:

 Conecte €l cable de energia del receptor a SAE en
el puerto de entrada de energia del receptor.

» Conecte el cable de energiadel receptor aSAEYy el
cabledel suministro de energiaal tomacorrientesal
adaptador CA.

* Conecte €l cable de suministro de energiaa cable
del tomacorriente en un tomacorriente disponible.

2. Presionelatecladereseteo en el receptor. Al hacerlo se
asegurard que el receptor se encuentre en modo Normal
para cargar. El receptor no se cargard en el Modo
Energia Cero (vea“Modo Energia Cero” en la
pagina 4-24 para obtener mas informacion).

3. Deje cargar todala noche. Una carga de nueve horas
cargara la bateria en aproximadamente un 90%. Una
carga de diez horas cargara totalmente el receptor. Las
baterias internas no pueden sobrecargarse.

4. Al terminar de cargar, defina Power Mode a Auto.

@ AVISO

Si retira un cable de alimentacion antes de poner Power
Mode en Auto, el receptor se apagara. Para encenderlo,

P/N 7010-0557-SP www.topconpositioning.com
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tendra que conectar otra vez un suministro de energia
externo.
Verificacion del Estado de la Bateria Interna
Para verificar el estado de |as baterias internas:

1. Verifique el estado delabateriaen el LED dela
BATERIA.

» Unaluz verde indica una carga de mas del 85%.
» Unaluz naranjaindica unacargaintermedia.

» Unaluz rojaindica una carga de menos del 15%.
2. Efectte uno de los siguientes procedi mientos:

» Hagaclic en Configuration » Receiver y verifique los
voltajes de la bateria en la pantalla de Configuracion
del Receptor (Receiver Configuration).

» Hagaclicen Help » About y verifique los voltajes de
labateriaen la pantalla About PC-CDU.

Conexion del Receptor y una
Computadora

Para configurar, gestionar archivos o darle mantenimiento al
receptor, conecte e receptor y una computadoraeinicie PC-CDU.

* utilice un dispositivo externo con Bluetooth habilitado
(computadora)

« utilice un cable RS232

* parael HiPer Lite+ tnicamente, utilice un cable USB y una
computadora con € driver USB de TPS instalado (disponible
en http://www.topcongps.com/software/updates.html)

212
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Unavez que ha establecido una conexion entre el receptor y la
computadora (ya sea através de latecnologia inalambrica
Bluetooth, el cable RS232, o € cable USB), usted podra:

« configurar el receptor y sus componentes
* enviar comandos a receptor
* descargar archivos desde |la memoria del receptor

« cargar un nuevo firmware, OAFsy archivos de configuracion al
receptor

Establecimiento de una Conexion
Inalambrica

Los receptores HiPer Lite e HiPer Litet+ estén dotados de la
tecnologia inal&mbrica Bluetooth que permite la transferencia
de archivosy la sincronizacion entre el receptor y cualquier
otro dispositivo externo que soporte la tecnologia inaldmbrica
Bluetooth; por gjemplo, un IPAQ, 0 una computadora con un
adaptador USB a Bluetooth o un adaptador PCMA a Bluetooth
instalados.

@ AVISO

Si cambia las configuraciones por defecto del Puerto B
del receptor el enlace Bluetooth se vera afectado. Los
valores por defecto para el Puerto B son: 115200 tasa de
transferencia en baudios, 8 bits de datos, 1 bit de
parada, sin paridad y sin negociacion.

El receptor y el procedimiento de conexiédn de dispositivos
externos varian ligeramente dependiendo del tipo de dispositivo
externo utilizado. De manera general, e procedimiento de
conexion es el siguiente.

P/N 7010-0557-SP www.topconpositioning.com
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@ AVISO

Consulte la documentacion del dispositivo externo en el
que ha configurado el Bluetooth si desea obtener
informacion de conexion detallada.

1

Encienda el dispositivo externo habilitado con e Bluetooth
y su receptor. EI modo del dispositivo externo por defecto
es Master; el modo el modulo Bluetooth es Slave.

Hagaque el dispositivo externo (Master) busgue €l receptor
(Slave).
Unavez que € dispositivo Master detecte al receptor,

utilice el procedimiento descrito en la documentacion del
dispositivo externo para conectarlo con €l receptor.

Una vez conectado, continlie con el Paso 1 en
Establecimiento de una Conexién PC-CDU

Si no puede establecer una conexion verifique que €l slot 3 del
receptor se encuentre habilitado.

1

Conecte su receptor y una computadora con un cable
RS232 o un cable USB y PC-CDU tal como seindicaa
continuacion.

Haga clic en Configuration » Receiver » General.

En el &rea Encender/Apagar Sots, asegurese que la casilla
de verificacion del Slot 3 (B) se encuentre habilitada.

Establecimiento de una Conexion con una
Cable RS232

1

Topcon

Con el cable RS232, conecte el puerto de serie de su
computadora (generalmente COM1) en el puerto de serie A
del receptor.

Presione |os botones de encendido en el receptor y en la
computadora para encenderlos.
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3. Continde con el Paso 1 en Establecimiento de una
Conexién PC-CDU.

Establecimiento de una Conexion
Inalambrica

Asegurese que lacomputadoratengainstalado e driver USB de
TPS.

1. Conéd cable USB y el HiPer Lite+, conecte el puerto USB
de su computadora al puerto USB del receptor.

2. Presionelos botones de encendido en € receptor y enla
computadora para encenderlos.

3. Continde con €l Paso 1 en Establecimiento de una
Conexién PC-CDU.

Establecimiento de una Conexion PC-CDU

PC-CDU es un software de Unidad de Pantalla de Control para
Computadoras Personales que se utiliza para gestionar las
diversas funciones de su receptor. La gama completa de
configuracionesy funciones del software PC-CDU se encuentra
fueradel acance de este manual. Para obtener masinformacion
sobre los procedimientos alos que se hace mencidn en esta
seccién o en e PC-CDU, consulte el Manual de Usuario del
PC-CDU disponible en €l sitio web de TPS.

2-15
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1. Unavez que € receptor y la computadora se encuentren
conectados, inicial PC-CDU en su computadora. Verala
pantalla principal de PC-CDU (Figura 2-8).

-5l
File Configuration Taools Plots  Help
GPS Satellites Geo |xvz | Taiget| GLONASS Satellites
# [ EL[ az{cal P Pel 1C] s8] kat: SnlFn| EL| sz[cal P pPe] TC] s8]
Lug}

Al

Vel

FMS Pos:
RMS Vel
FDOP:

Receiver time:
Receiver date:
Clock offset:
Osc. offset
Tracking time:

Disconnected ‘ 4

Figura 2-8. Pantalla Principal PC-CDU

Observe que laesguinainferior izquierda muestra el estado
del receptor como “Disconnected” (Desconectado).

2. Hagaclic en File » Connect (Figura 2-9).

Fil=
Disconnect ! [Ctrl 0
File fManager il +F

Freal-Time Logging  CirlH
I aruial Made [Etrl+hd

Exit Cirl+

Figura 2-9. File » Connect

3. En el cuadro de didogo Connection Parameters,
seleccione los siguientes pardmetros y haga clic en
Connect:

» Enlo que respecta alas conexiones Bluetooth 0 RS232
(Figura2-10 en lapégina 2-17):

—Defina el modo de Conexion (Directo).

—Defina el puerto para su computadora (por lo genera

218 COM1, COM2 paralaconexion RS232 y COM3,
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COMA4, etc. paralaconexién Bluetooth) en lalista
desplegable Port.

—Definalavelocidad de conexion entre el receptor y la
computadora (generalmente 115200) en lalista
desplegable de velocidad de transferencia en baudios.

Eﬂ Connection Parameters il

Connection mode

" Internet Client " Internet Server

—Port zetting:

Port: IEDM‘I 'l Baud rate: |1152DD 'l [~ Infrared part

[~ RTS/CTS handshaking

—Program setting:
[~ Passivermode [~ Manual mode only

[~ Restore the receiver's onginal baud rate on Disconnect

Internet setting

Hist riame: |Iocalhost TIER port: IBDDD

Fazsword: I

I~ | Dizplay data on server, | Log servernevents [~ DHS lookup

coce |

Figura 2-10. Parametros de Conexion del Bluetooth y de RS232

* Paralas conexiones USB (Figura2-11 en
la p4gina 2-18):

—Defina el modo de Conexién (Directo).

—Defina el puerto para su computadora (USB) de la
lista desplegable Port.

—Seleccione laidentificacion (1D) del receptor de la
listadesplegable Rec ID.

2-17
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Eﬂ Connection Parameters B3

Connection mode
’V(:' Direct " Internet Client " Internet Server ‘

—Port zetting:

Port: IUSB 'l Fec [D: IHCV_1 'l I~ | Infrared port

—Program setting:
I~ Passivermode [T Manual mode anly

[™ | Restare the receiver's arginal baud rate on Discornest

Internet [ Client - Server | setting

Hust riame: |Iocalhost TICR port: IBDDD

Fazsyword: I

I™ | Dizplay data onserver. W Log servern events [~ DHS [aakum

Cancel |

Figura 2-11. Parametros de Conexién USB

Unavez establecidala conexién PC-CDU con €l receptor, 10s
val ores actuales de comunicacion, tales como nombre del
puerto, tasa de transferencia en baudios (en caso de ser
aplicable) y control de flujo apareceran en la esguinainferior
izquiera de la ventana principal del PC-CDU. Asimismo, un
crondmetro empezard aregistrar el tiempo en laesguina
inferior derecha (Figura 2-12).

I E]

File Corfiguration Taools Plots  Help
GPS Satellites [0]) Geo IM I Talgell GLONASS Satellites [0]
# | EL| az[calpi[ P2 1Cf S5 bt SnlFn| EL[ az[calPira] 1o] 55]
or:
Alt:
ek
RS Pos:

RS Vel
FDOF:

Receiver time: 08:06:07
Receiver date: 24.09.2002
Clack affset:

Osc. offset

Tracking time: 00:00:00

CoMz, 115200 | 00012

Figura 2-12. Conexion PC-CDU Establecida
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Configuracion del Receptor

Utilice el software PC-CDU para configurar las diversas partes del
receptor HiPer+. Todos los valores que establezca utilizando €l
software PC-CDI se guardarén en lamemoria del receptor y estos
cambios seran evidentes al usar laMINTER. La gama completade
configuraciones y funciones del software PC-CDU se encuentra
fueradel alcance de este manual.

RECOMMENDACION

Consulte el Manual del Usuario del software PC-CDU
para conocer todas las configuraciones posibles del
receptor.

La siguiente configuracion se recomienda parala mayoriade
aplicaciones comunes. Sin embargo, podra seleccionar los
parametros que necesite para su trabgjo.

@ AVISO

Haga clic en Apply después de hacer cualquier cambio
en la configuracion, en caso contrario su receptor no
aceptara el cambio.

1. Conecte su receptor y computadora. Vea “ Conexion del
Receptor y una Computadora” en la pagina 2-12 para obtener
informacion sobre este procedimiento.

2. Unavez conectado, hagaclic en Configuration » Receiver
(Figura 2-13).

Configuration

Site i i Chrl+I

Target position Chrl+T
Radio 3

Figura 2-13. Configuration » Receiver
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Verael cuadro de didogo Receiver Configuration
(Figura2-14).

[ Receiver Configuration x|
i Pawer
Fower Valtages [valisk—

"Elevalmr\ mask [degrees)

Teiminal Elevation Mazk : 5 ‘ Mode lm Bzl lﬁ

ntenna Artenna Status [read only}—— Current Made : [=+t OnBoard: [76
€ Intemal Conertinput: [-1
put: Jest e —
) External e Battery & : |7 54
T i Ext DE Status : ol Made Auto ¥
Battery B : |7 51
T [Ceksius degress} Speed =
lrﬁnald temperature 26.7 ‘ CurrentMade : [off Charger: |7 59

Power output modes———— [~ Tum on/off Slots—
Forts an - Iv' Slot2

[V Slot3
Slats: On ] | | % shote

[ Enahle Low Pavier Mode

Refiesh | apely |J

[ok | s Save | Set all parameters ta defauits |
[ |

Figura 2-14. Configuracion del Receptor
3. Hagaclic enlapestafiaMINTER, configure |os siguientes
valoresy después hagaclic en Apply (Figura2-15enla
pagina 2-21).
» Defina e intervalo de Registro en segundos.

* Definalamascara de Elevacion para el archivo de Registro
en grados.

* Ingrese el prefijo del nombre de Archivo. Utilice los tres
ultimos digitos del nimero de serie del receptor. Usted
encontrara el nimero de seriey el nimero de parte del
receptor en el panel posterior del mismo.

2-20

Topcon Manual de Operaciones del HiPer Lite y del HiPer Lite+



[l Receiver Configuration x|

General MINTER: | Posioning | Base | Rover | Parts | Events | Advanced |

Configuracién del Receptor

Recording interval

100 | (seconds) FN key mode
[f | ldegess) ’7

Elesvation mask for Log file :

& LED biink mode switch ¢ Decupation mode switch

File name prefis log
’7(-‘ Static

Initial data collection dynamic: mod

£ Kinematic

—

Always append to th fis -

Files Creation mad Data recording autorstar
’7(-‘ Loa file  AFRM ’7(-‘ O C On  Blways

Automatic File Fatation Mods [AFRM) parameters———

Perind (s=0] - [3600 Files (total ] [0
Phiase (s=c) [0 Files (remain] {0

™| Automatically remove old files

Refiesh | dpfu |

0k | Edt | Save | Setal parameters to defaults |
\

Figura 2-15. Receiver Configuration — Pestaiia MINTER

Si su obra se encuentra en un area gue presenta obstrucciones
(edificios, &boles etc.), y/o la ubicacién de la antena se encuentra
cerca de objetos reflexivos, configure el receptor parareducir 10s

errores de estas fuentes.

ADVERTENCIA

No realice otros cambios sin consultar el Manual del

Usuario del software PC-CDU.
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4. Hagaclic en lapestafia Advance en la pantallade
Configuracion del Receptor (Figura 2-16).

[ Receiver Configuration ]

General | MINTER | Positioning | Base | Raver | Parts | Events [Advanced ]

Antinterference | Mukipath Reduction | Loop Management | Extemal Frequency | Fiaw Data Management | Options |

Antidnterference———
 Off

GRS L1/L2

) GLONASS (12
 GRS/GLONASS L1
 GRS/GLONASS L2
Ao

Refresh Epply

OK_| Est | Save | Setal parameters to defauls |
[

Figura 2-16. Configuracion del Receptor — Pestaiia Advanced
5. Hagaclic en la pestaiia M ultipath Reduction, habilite las
siguientes casillas y haga clic en Apply (Figura 2-17).
 Code multipath reduction (Mitigacion del efecto multipath
del codigo)
 Carrier multipath reduction (Mitigacién del efecto
multipath de la portadora)

[d receiver Configuration x|

General | MINTER | Positoning | Base | Fiover | Patts | Events Advanced |

Antinterference  Multipath Reduction | Loop Management | External Frequency | Raw Data Management | Options |

[¥ Code multipath reduction

I (Cairier muitipath reductiors

Rsfresh ply

Exit Save | Setal parameters to defaults
2-22 |

Figura 2-17. Configuracion Avanzada — Mitigacién del Efecto Multipath
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6. Hagaclic enlapestafial oop Management (Gestién de Bucle),
habilite las siguientes casillas y haga clic en Apply
(Figura 2-18).

» Enable Co-Op tracking (Hahilite el rastreo cooperativo)
* Static Mode (Modo Estético)

[l Receiver Configuration x|

General| MINTER: | Postioning | Base | Rover | Ports | Events Advanced |

AntiInterference | Mulipath Reduction ~ Leop Management |Exlernal Frequency | Fiaw Data Management | Optians |

PLL handuwidth 25.0 [Hz) ¥ Enable CoOptacking————— |
PLL order: 3 I Stalic Mode
. | Bandunidth of individual PLL 5.0 [Hz)
uided [oop banduwi H:
5 B andwidth of common PLL B Ha)
/4 cods guided loop bandwidth: |% [Hz)
¥ Enable Adaptive Giided Loops ¥ Enable Common Lagp for L2

¥ Enable P/L1 and PALZ tiacking

Fefiesh AW‘F

0k | Edt | Save | Setal parameters to defaults |
\

Figura 2-18. Configuracion Avanzada — Gestién de Bucles

7. Hagaclic en OK paracerrar |la pantalla de Configuracion del
Receptor.

8. Hagaclic en File » Disconnect, después en File » Exit para
salir del PC-CDU (Figura 2-19).

Conmech Chrl+C

File Manager Chrl+F |

Real-Time Loggi| File 1+R

Manual Maode Connect Chil+C

Exit Disconnect [Ctrl+ 0
File fanager LCirl+F

Freal-Time Logging  CilH
I arual Mode [Ctrl+hd

Figura 2-19. Haga clic en Disconnect y después en Exit
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@ AVISO

Si desconecta el receptor desde la computadora antes
de salir eliminara cualquier posible conflicto en la
gestion de sus puertos seriales.

Unavez que ha configurado el receptor, la configuracion seravélida
hasta que la cambie nuevamente utilizando el software PC-CDU o
borrando laNVRAM.

Configuracion de la MINTER

LaINTERFAZ Minima (MINTER) esta formada por dos teclas
(Encendido y FN) y cuatro LEDs (ESTADO, REGISTRO,
BATERIA y MODEM) (Figura2-20). LaMINTER esigual para
ambos receptores: HiPer Lite e HiPer Lite+.

Tecla de Encendido Tecla de Reseteo LED de la
LED de Estado Bateria

LED de Registro LED de Médem
FN (tecla de funcion/grabacion

Figura 2-20. MINTER (HiPer Lite+)

LaMINTER efectlia numerosas funciones:

» Encender o apagar € receptor, ponerlo en Modo Slegp o en
Modo Energia Cero.

* Activar o desactivar €l registro de datos (tecla de funcion).
e Cambiar el modo de informacion del receptor.
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» Mostrar el nimero de satélites GPS (verde) rastreados (LED de
ESTADO).

* Mostrar el estado de registro de datos (LED de REGISTRO).

» Mostrar cada vez que los datos se registren en lamemoria
interna (LED de REGISTRO).

» Mostrar el estado del modo de post-procesamiento (estatico o
dindmico) a g ecutar un levantamiento Cinematico de Post-
Procesamiento con la ayuda de latecla de funcion (LED de
REGISTRO).

* Mostrar el estado (cargaalta, cargaintermedia, o carga baja) de
la bateria (LED de la BATERIA).

» Mostrar lafuente de energia para el receptor (LED dela
BATERIA).

» Mostrar el estado del médemy si recibe sefidles (LED del
MODEM).
Utilice el software PC-CDU paradefinir losvaloresdelaMINTER.

Consulte el Manual del Usuario del PC-CDU para obtener
informacion sobre otras posibles configuraciones de laMINTER.

1. Conecte su receptor y computadora. Vea “ Conexién del
Receptor y una Computadora’ en la pagina 2-12 para obtener
informacién sobre este procedimiento.

2. Ené€l cuadro de didogo Connection Parameters (Parametros
de Conexion), habilite la negociacion (handshaking) RTS/CTS
(Figura 2-21 en la pagina 2-26).
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Eﬂ[ﬁonneclion Parameters x|
Connection mode
’V(:' Direct " Internet Client " Internet Server ‘
—Port zetting:
Port: IEDM‘I j Baud rate: |115200 j [~ Infrared part

¥ RTS/CTS handshaking

—Program setting:
I~ Passivemode [ Manual mode only  Timeout [ms]: ISDD 'l

I Restore the receiver's onginal baud rate on Disconnect

Internet [ Client - Server | setting

Hust riame: |Iocalhost TICR port: IBDDD

Fazsyword: I

I™ | Dizplay data onserver. W Log servern events [~ DHS [aakum

Cancel |

Figura 2-21. Parametros de Conexion — Valores de la MINTER

3. Hagaclic en Configuration » Receiver (Figura 2-22).
Configuration

Site i i Chrl+I

Target position Chrl+T
Radio 3

Figura 2-22. Configuration » Receiver

4. Hagaclic enlapestafiaMINTER, configure los siguientes
valoresy después hagaclic en Apply (Figura2-23 enla
pagina 2-27). Enlas péginas siguientes encontraralas
descripciones de estos parametros:

 “Parametro del Intervalo de Registro” en la pagina 2-27

* “Parametro Mascarade Elevacion para Archivo de Registro
" en lapégina2-28

* “Parametro de Prefijo de Nombre de Archivo” en la
pagina 2-28

-  “Pardmetro Siempre Anexar a Archivo” en la pagina 2-28
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* “Parametro Modo de Creacion de Archivos’ en
la pagina 2-28

» “Pardmetros del Modo Automético de Rotacién de
Archivos (AFRM)” en lapagina 2-29

» “Parametro Modo delaTeclaFN " en la pagina 2-30
* “Parametro del Modo Dindmico de Coleccion Inicia de
Datos’ en lapégina 2-31
* “Parametro de inicio automatico de Registro de Datos’ en
lapégina2-31
xl

General MINTER | Postioning | Base | Fover | Ports | Events | Advanced |

Fecording interval : 1.00 (seconds] "FN kep mode

Elevation mask for Logfile:  [5 | (degress) & LED blink mode switch ¢~ Occupation mode switch
File name prefis log Iritial data collection dynamic madk
Awaps append 1o the fil - (“‘ Slalic € Kinzmatic

Files Creation mods Data recording auto-start
’76‘ Log file " AFRM ’7(? 0ff © 0On  Always

Automatic File Rotation Mode [AFRM) parameters

Perind(sec) 3500 Fies ftatal | [0
Phase (secl: [0 Files (ematr 0

I™ | futomatically remove ofd Fies

Refiesh | Appy |

Exit Save | Setall parameters to defaults
I

Figura 2-23. Receiver Configuration — Pestaiia MINTER

Pardmetro del Intervalo de Registro

Este pardmetro especifica el intervalo de salida de mensajes en
el archivo de registro cuando latecla de funcion (FN)
MINTER (presionada de 1 a 5 segundos) activa el registro de
datos. Este valor se utilizano solo cuando se registraun solo
archivo de registro sino cuando se registran datos del receptor
en el modo AFRM. Los valores son 1-86400 segundos.

El valor por defecto es un segundo.
2-27
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Pardmetro Mascara de Elevacién para Archivo de Registro

Este pardmetro especifica el angulo de elevacion minimos para
los satélites cuyos datos quedaran registrados en los archivos
del receptor al presionar latecla FN.

El valor por defecto es cinco grados.
Pardmetro de Prefijo de Nombre de Archivo

Este pardmetro especifica qué prefijo se afadira alos nombres
delos archivos del receptor creados al presionar FN. El prefijo
puede tener hasta 20 caracteres de extension.

El valor por defecto es log (registro).

L os nombres de archivo de registro presentan la siguiente
estructura:

<prefix><month><day><sequential alphabet |etter>

El nombre del archivo depende tanto del momento en que se
cred e archivo (mesy dia) como de sufijos adicionales de | etras
paraevitar confusion entre los archivos creados en € mismo
dia

Pardmetro Siempre Anexar al Archivo

Si desea que los datos nuevos del receptor sean anexados a un
archivo de registro existente, ingrese el nombre de archivo
deseado en este parametro. El valor puede tener hasta 20
caracteres.

Parédmetro Modo de Creacion de Archivos
Este pardmetro tiene dos modos posibles de operacién:

 Archivo deregistro — Si se ha seleccionado el botén de
radio de archivo de registro, presionando lateclaFN, se
cerrarael archivo de registro actual. Si €l registro de datos
se encuentra deshabilitado, al presionar lateclaFN se
abrird un nuevo archivo de registro.
2-28
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* AFRM —Si se ha seleccionado el boton deradio AFRM, al
presionar FN este modo quedard habilitado. Si AFRM se
encuentra habilitado, al presionar FN quedara
deshabilitado.

Parédmetros del Modo Automético de Rotacién de Archivos
(AFRM)

L os receptores TPS pueden rotar automaticamente archivos de
registro. Durante un evento de “rotacién de archivos, el receptor
cierrael archivo en uso y abre un nuevo archivo de acuerdo al
cronogramadefinido por el usuario. Los parametros de Periodo
y Fase se especifican en este cronograma. Larotacion de
archivos comienza cuando el Periodo del médulo de tiempo del
receptor esigual aFase. Es decir, un archivo de registro nuevo
se abre inmediatamente antes de |a época programada haciendo
gue los datos identificados con esta época se registren en el
archivo de registro nuevo.

Al abrir un archivo de registro nuevo, €l receptor habilita el
grupo de mensajes por defecto generados con el periodo de
salida por defecto. Tanto el grupo de mensajes por defecto y el
periodo de salida por defecto son programables.

* Period — especificaladuracion de tiempo de cada archivo de
registro creado en el modo AFRM.

Los valores varian de 60 a 864000 segundos. El valor por
defecto es 3600 segundos.

 Phase — especificala“fase” (cambio de tiempo constante) de
crear archivos de registro multiples en el modo AFRM.

Los valores son de 0 a 86400 segundos. El valor por defecto es
cero segundos.

* Files (total) — contador que especifica cuantos archivos de
registro multiple deben ser creados en AFRM hasta que este
modo se apague autométicamente. Este contador disminuye en
cada rotacion de archivo hasta que su valor llega a cero, 2-29
entonces |a rotacion de archivos autométi camente se detiene.
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Observe que un archivo de registro se abre inmediatamente
después de activar AFRM. Este archivo deinicio no se
considera un evento de rotacién de archivos; el contador AFRM
no disminuira

Losvaloresson 0 [231-1] . El valor por defecto es 0 (cero). Cero
significa que es posible crear un nimero ilimitado de archivos
de registro.

@ AVISO

La memoria del receptor tiene capacidad para hasta 256
archivos.

* Files (remain) — especifica el nUmero de archivos que €l
receptor aun puede crear en AFRM.

Los valores son 0 a[23-1]. El valor por defecto es cero.

» Automatically remove old files (eliminar autométicamente
archivos antiguos) — si ho existe memoria libre para registrar
datos, autométicamente se borrarael primer archivo deregistro.
Si se habilita este pardmetro, su receptor eliminard el archivo
con la hora/fecha de creacion més antigua. AFRM debe estar
habilitado para utilizar esta caracteristica FIFO (Primero en
Entrar, Primero en Salir, por sus siglas en inglés).

El valor por defecto es Off (desactivado).
Parédmetro Modo de la TeclaFN

Utilice estos dos botones de radio para programar cOmo
reaccionara €l receptor al presionar latecla FN.

 Control del modo de parpadeo del LED —al presionar la
tecla FN alternara entre los modos de informacion normal/
extendidade laMINTER e iniciaré/detendra el registro de
datos del levantamiento Estético.
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— Si presionalatecla FN durante menos de 1 segundo:
cambia el modo de informacién (Modos Normal o
Informacion Extendida (E)).

—Si presionalateclaFN 1 a5 segundos: inicia/
detiene el registro (modo de post-procesamiento
estético).

* Occupation mode switch (control del modo de ocupacion) —
a presionar latecla FN (durante menos de un segundo) se
insertara en el archivo de registro correspondiente un
mensgj e indicando que €l tipo de levantamiento ha
cambiado de estatico a cinemético, o viceversa. Si el LED
de REGISTRO parpadea verde, e modo actual es
dindmico, si parpadea naranja, el modo actual es estético.
Para obtener més informacion, revisela Tabla4-1 dela
pagina4-4, y consulte el Manual del Usuario dela
MINTERY &l Manual del Usuario del PC-CDU.

Parémetro del Modo Dindmico de Coleccion Inicia de Datos

Estos botones de radio especifican el descriptor de tipo de
ocupacion deinicio insertado a comienzo de los archivos
registrados del receptor. Seleccione Estético o Cinematico para
especificar que el archivo de registro correspondiente se
iniciara con una ocupacion estatica (PARAR) o cinemética
(SEGUIR, Trayectoria), respectivamente.

Pardmetro de inicio automético de Registro de Datos

Estos botones de radio le permiten programar el

comportamiento de su receptor en caso ocurriese un corte de

energia.

LaTabla2-2 en lapégina 2-32 le presenta | os diferentes

escenarios disponiblesy los resultados después de restaurar la
energia en € receptor. “Archivo especificado” hace referencia

al nombre de archivo ingresado en el pardmetro Always append

tofile. 2-31
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Tabla 2-2. Comportamiento del Parametro de Registro de Datos

Antes del Resultados de los Botones de Radio Habilitados
corte de
energia Apagado (Off) Encendido (On) Siempre (Always)
1 El registro de El receptor El receptor
Datos del datos no se reanudara el reanudar el
receptor reanudardaunavez | registro de datos registro de datos
archivados quelaenergiase en el mismo en el mismo
enun haya restaurado. archivo cuando se | archivo cuando se
archivo reestablezcala reestablezcala
especifico. energia. energia.
2 El registro de SeabrirAunnuevo | Seabrirdunnuevo
Datos del datos no se archivoderegistro | archivoderegistro
receptor reanudardcuando | cuando se cuando se
registrados serestablezcala restablezcala restablezcala
enel archivo | energia energiay losdatos | energiay losdatos
por defecto seregistraran en seregistraran en
este archivo. este archivo.
3 Ningun archivose | Ningunarchivose | Un archivo de
Archivo abrird con este abrird con este registro con este
especificado, | nombre. El nombre. El nombreseabrirdy
e registrode | registro de datos registro de datos ¢ registro de
datos del no seiniciara no seiniciaraa datos empezara
receptor no cuando se restablecerse la tan pronto como
seha restablezcala energia. serestablezcala
iniciado. energia. energia.
4 No seiniciara e No seiniciarae Se abriraun
No se registro de datos registro de datos archivederegistro
especifica cuando se cuando se con un nombre
archivo, € restablezcala restablezcala por defectoy se
registro de energia energia iniciarael registro
datos del dedatostan
receptor se pronto como se
encuentra reestablezcala
apagado. energia.
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Asimismo, si Always se encuentra habilitado, su receptor
automaticamente empezara a registrar datos (a un archivo
recientemente creado o a un archivo existente) en lostres casos
siguientes:

 Después de presionar latecla de encendido de laMINTER.

» Despuésdereinicializar el receptor (con PC-CDU o latecla
dereiniciaizacion).

 Después de sacar a receptor del Modo Sleep.

Configuracion del Radio

@ AVISO

Para cumplir con los requerimientos de exposicion a la
RF, es necesario que exista una distancia de 20 cm.
entre el usuario y el receptor.

El radio interno del receptor Rover y del radio de la Base pueden
configurarse de manera diferente de acuerdo con sus necesidades y
condiciones de trabgjo. Para acceder a radio modem, utilice el
software TPS para médems disefiado especificamente para radio
modems de Espectro Amplio con Salto de Frecuencia con una
banda con una frecuencia de 915 MHz para:

* acceder a modem interno
« configurar el médem
« verificar o cambiar la configuracion del médem

En primer lugar, descargue e instale e médem TPS, después
conecte su computadoray €l receptor y corrael programa de
configuracion.

1. Ensucomputadora, hagaclic en Start » Run para abrir €l
cuadro de dialogo Run. Hagacclic en € botén Browse
(Examinar) paraubicar € programa setup.exe de TPSy haga
clicen OK (Figura2-24 en la pagina 2-34).
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Run 2] =]

Type the name of & program, Folder, document, ar
Inkernet resource, and Windows will apen it Far you.

Open: | Cilinstallertdisks!\SETUP EXE =l

Ok [ Cancel I Browse.,. |

Figura 2-24. Run Modem-TPS (Ejecutar Médem de TPS)

2. Sigalasinstrucciones de la pantalla para completar la
instalacion.

Paradesinstalar el Médem de TPS, vaya al menu de Inicio de su

computadora: Haga clic en Inicio » Programas » Modem-TPS »

Uninstall Modem-TPSy hagaclic en Yes en la notificacion.

Después haga clic en OK cuando termine la desinstal acién.

Unavez que hayainstalado el Médem de TPS, sigalos siguientes
pasos para configurar €l radio modem. El Modem-TPS conecta
automaticamente el receptor y el modem parafines de
configuracion. Al configurar su radio, primero configure €l radio de
laBasey después € radio del Rover.

1. Cone cable RS232, conecte el puerto serial de su computadora
(generalmente COM 1) en el puerto serial A del receptor.

2. Presionelos botones de encendido en e receptor y en la
computadora para encender|os.

3. Inicied Mddem de TPS. En € cuadro de didlogo Connection,
seleccione el puerto serial de su computadora al que se
conectara el receptor y hagaclic en Connect (Figura2-25enla
pagina 2-35).

2-34
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[zAModem-TPS = E |

File Help

Fort's setting

COM1 hd
Cancel

| Digconnected ” |

Figura 2-25. Cuadro de dialogo Connection del Modem-TPS

Unavez establecidala conexion, € puerto COM y latasade
transferencia en baudios apareceran en la esquinainferior
izquierda de la ventana principal del Médem de TPS. Un
temporizador iniciarael conteo de tiempo en laesquinainferior
derecha e indicard por cuanto tiempo se encuentra activado €l
Md&dem de TPS. La barra de estado junto a temporizado
muestra los mensajes de error.

4. Hagaclic en lapestafia Radio Link, ingrese lasiguiente
informacion y hagaclic en Apply (Figura2-26 en
la pagina 2-38).
» Operation mode — seleccione €l Receptor para estaciones

Rover; seleccione Off si e radio se encuentra apagado y
Transmitter en el caso de estaciones Base.

* Output power — habilitado Unicamente si Transmitter se
encuentra seleccionado, este campo gjusta la potenciade
transmision del radio modem de la estacion Base.

« Link Rate — seleccionalatasa de transmision de datos para
el enlace de RF; ya sea 9600, 12000, 17000,24000 o 51000

bps. 2-35
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Contrariamente a una tasa de transferencia en baudios (la
velocidad de transferencia de datos a través de unainterfaz
de cable seridl), lavelocidad del enlace (link rate) esla
cantidad de datos (medida en bits) que el radio médem
puede transmitir/recibir en el aire en un periodo especifico
de tiempo (medida en segundos). La Tabla 2-3 muestrala
relacion entre las vel ocidades de enlace de lainterfaz de
radio y las tasas de transferencia en baudios de lainterfaz
seria en los extremos del transmisor y del (10s)
receptor(es).

Tabla 2-3. Comparacién entre la Velocidad del Enlace y la Tasa de
Transferencia en Baudios

Si el tamaiio

Utilice los siguientes valores para...

del paquete
de datos (en Tasa de Tasa de
bits) esta transferencia Velocidad del enlace transferencia
entre en baudios del (bps) en baudios
transmisor del receptor
0-9600 9600 9600 (recomendada) 9600

19200 12000 19200

38400

57600

9600-12000 19200 12000 (recomendada) 19200

38400 24000 38400

57600

12000-17000 19200 17000 (recomendada) 19200

38400 24000 38400

57600

17000-24000 38400 24000 38400

57600 57600

24000-51000 57600 51000 57600

— Con unavelocidad de enlace de 9600, cada paquete
de datos se repetira tres veces. Adicionalmente, con €l
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fin de reducir los efectos de lainterferencia, los
paguetes de datos han sido codificados. La velocidad
de enlace proporciona una confiabilidad de
comunicacion de datos méxima (y alavez reduce el
caudal de datos).

— Con unavelocidad de enlace de 12000, cada paquete
de datos se repetira cinco veces. No se aplica ninguna
codificacion.

— Con unavelocidad de enlace de 17000, cada paquete
de datos se repetira tres veces. No se aplica ninguna
codificacion.

—Con unavelocidad de enlace de 24000, sblo se utiliza
la codificacion.

—Con unavelocidad de enlace de 51000, no se utilizani
repeticion ni codificacion. Lavelocidad de enlace
proporciona un caudal de datos méximo (y alavez
reduce la confiabilidad de la comunicacion de datos).

Para una eficiencia maxima, el tamafio del paguete de datos
transferido al radio médem en un tiempo determinado debe
ser equivalente 0 menor a enlace de datos.

» Channel —asigna un canal operativo a radio médem. Cada
canal utiliza unafrecuencia de comunicacion Unica, y
permite hasta cinco radio médems transmitiendo
simultaneamente, sin interferencia, en el lugar de laobra.

Unared inalambrica simple, o unared punto a punto, esta
formada por tan solo dos dispositivos (transmisor y
receptor). En el caso de los médems FH, es posible utilizar
unared punto a multipunto, en la que un sblo transmisor
transmite datos a una serie de radios remotos. Al establecer
comunicaciones radial es, aseglrese que:

—€l transmisor y el(los) receptor(es) remotos que se
encuentren en lamismared utilicen el mismo nimero 2-37
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de canal. Delo contrario, no sera posible establecer una
conexion radial.

—las redes en la misma ubicacion sean asignadas a
canales con nimeros diferentes. De lo contrario, las
redes cercanas interferiran entre si y la comunicacion
radial podriafallar.

Eﬁplead Spectrum Radio Modem 915 MHz _ O] x] |
File Help
Radio Link | Serial Interface | |dentification |
Apaly
Cperation mode: lm
Qutput powet: IWW;I
Link Rate: lm
Channel: |1—;|
Exit |
[com, 115200 | 00014

Figura 2-26. Pestaiia del Radio Enlace del Médem de TPS

5. Hagaclic en la pestafia Serial | nterface, configure los
siguientes valoresy después hagaclic en Apply (Figura2-27 en
la pagina 2-39):

» Baud Rate — sel eccione unatasa de transferencia en baudios
parael puerto serial del médem. Debe utilizar lamismatasa
detransferenciatanto parael receptor como para el médem.

» RTS/ICTS - controlael flujo de datos entre el receptor y €l
madem. Seleccione ON para habilitar el control de flujo de
negociacion/hardware; seleccione Off para deshabilitar la
negociacion.

@ AVISO

Si la tasa de transferencia en baudios del puerto serial
excede la velocidad del enlace, habilite la negociacion
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del hardware para evitar que el radio enlace se

sobrecargue de datos con lo cual se produciria la
pérdida de éstos.

[
ﬁSpmad Spectrum Radio Modem 915 MHz _ 5] x|
File Help

Radio Link  Serial Interface | Identification |

Apply

Baud Rate: 38400 =2
RTS/ATS: OM hd

Exit |

|comz, 115200 | D.00.08|

Figura 2-27. Pestaiia de la Interfaz Serial del Médem de TPS

6. Hagaclic enlapestafial dentification paraver informacion con
respecto a tipo de moédem, version del firmware, revision de
tablero y nimero de serie (Figura 2-28).

[
Eﬁplead Spectrum Radio Modem 915 MHz _ O x|
File Help

Radio Link | Setial Interface  |dentification |

Moderm FH315 Topcon Positioning Systems M
Firrnweare version: 1.1 [February 04.2003]
Board Revision: 2.2

Serial Number. FH31120200007

Exit |

|com, 115200 |

0.05:17

Figura 2-28. Pestaia de Identificacion del Médem de TPS

2-39

P/N 7010-0557-SP www.topconpositioning.com



Configuracién

7. Hagaclicen Help » About paraver laversion del Modem de
TPS e informacion sobre derechos de autor en el cuadro de
didlogo del Médem de TPS (Figura 2-29).

[zdAbout Modem-TPS

# TOPCON

FOSITIDNING SYSTEMS

Modem-TPS
for Windows 98, 2000
“ersion 1.4 (build February 18, 2003)
Copyright @ Topcon Positioning Systems, 2002

hitp: Mansna topcongps.com

Figura 2-29. About Modem-TPS (Acerca del Médem de TPS)

8. Hagaclic en File » Disconnect (Figura 2-30), y después haga
clic en File » Exit. ContinGe con otras configuraciones o
funciones de operacion segin sea necesario.

Carinect [+
Disconnect  Chil+D
o, EA

Connect Cirl+C

Disconnect  Eildl

Figura 2-30. Haga clic en Disconnect y después en Exit

2-40
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Configuracion del Médulo Bluetooth

Utilice &l programa de configuracion del modulo Bluetooth y su
computadora para:

» acceder a modulo de tecnologia inalambrica Bluetooth
« configurar el médulo Bluetooth
« verificar o cambiar la configuracién del médulo

Para acceder a mddulo de tecnol ogia inalambrica Bluetooth,
primero descargue e instale BTCONF, después conecte su
computadoray €l receptor y € ecute el programa de configuracion.

1. Cree o ubique lasiguiente carpeta:

C:\Program Files\TPS\BTCONF

2. Descargue btconf.zip del sitio web de TPSy descomprimalo en
la carpeta BTCONF. Este archivo contiene Btconf.exe, €l
archivo g ecutable para el programa de configuracién del
maodulo Bluetooth.

Cada vez que gjecute BTCONF y configure el médulo Bluetooth,
BTCONF guarda sus configuraciones en un archivo (btconf.ini).
BTCONF actualiza autométicamente el archivo cada vez que haga
cambios en las configuraciones del médulo Bluetooth.

RECOMMENDACION

Si desea mantener configuraciones unicas del moédulo
Bluetooth para fines diferentes, copie el BTCONF en
carpetas diferentes.

Para desinstalar o eliminar, BTCONF, borre cualquiera de los
directorios o carpetas BTCONF aplicablesy los accesos directos a
BTCONF.

Unavez que tenga disponible BTCONF, siga | os siguientes pasos
para configurar el médulo Bluetooth.
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1. Cone cable RS232, conecte el puerto serial de su computadora
(generalmente COM 1) en e puerto serial A del receptor.

2. Presionelos botones de encendido en el receptor y en la
computadora para encenderlos.

3. Ejecute el programa de configuracion del médulo Bluetooth
(Btconf.exe) (Figura 2-31).

1
BTCONF 19 1
IEDM‘I 'l Identification | Parametersl Sefial Interfacel
Bluetoath Information:
About | ;I
Connect |
Appli |
Disconnect |
Exit |
|Disc:0nnec:ted |

Figura 2-31. Pantalla Principal de Configuracion del Médulo Bluetooth

Observe que la esquinainferior izquierda muestra el estado
“Desconectado” paralacomputadoray € médulo Bluetooth.

Para conocer laversion BTCONF einformacién de derechos de
autor, hagaclic en e botén About (Acerca de).

4. Enlalistadesplegable de laesquina superior derecha,
seleccione el puerto de serie de la computadora (generalmente
COM1) que se utiliza parala comunicacién (Figura2-32 en la
pagina 2-43).

2-42
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1
BTCONF 19 1
IEDM‘I 'l Identification | Parametersl Sefial Interfacel

Bluetoath Information:

About ;I

Connect

Appli

Disconnect

[l

|

Exit

|Disc:0nnec:ted

Figura 2-32. Seleccione el puerto de la comunicacion y clic Connect

5. Hagaclic en Connect para conectar lacomputadoray el
maodulo Bluetooth (Figura 2-32).

Unavez que € receptor y la computadora se encuentren
conectados através de BTCONF, |a pestafia | dentification
(Figura 2-33 en la pagina 2-44) muestrala siguiente
informacion:
* Bluetooth name— nombre del médulo Bluetooth, definido
en la pestafia Parameters.

* Bluetooth address — direccion electrénica exclusiva para su
maodulo Bluetooth.

* Firmware version —version actual del firmware del médulo
Bluetooth.

2-43
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BTCONF = 3

IEDM‘I 'l Identification | Parametersl Sefial Interfacel
Bluetoath Information:

Bluetoath name: TopconPS ;I
Lonnect

Bluetooth address: 0015 B210 00CE 0010
Firmware version: BCO2%1.2 12-20-2002

Appli

L]

Disconnect

|

Exit

[Eom1, 115200 |

Figura 2-33. Pestaiia de Identificacion de BTCONF

Observe que € puerto de comunicacion y latasade
transferencia en baudios aparecen en la esquinainferior
izquierda de la pantalla.

6. Hagaclic en la pestaiia Parameter s (Figura 2-34). La pestaiia
Parameters define lainformacion de identificacion y seguridad
de su médulo Bluetooth. La seccién de seguridad le permite
definir los datos de seguridad y |os parametros de acceso no
autorizado para el médulo Bluetooth.

7. Ingrese hasta 14 caracteres paradefinir un nombre Unico parael
madul o Bluetooth (Figura 2-34), y hagaclic en Apply.

BTCONF = 3

|EDM1 'l Identification :
About | Bluetooth Mame: ITopconF’S

Serial Interface I

Security
Lonnect

[ s
Apply %l
==

Blugtaath PIN: |

Encrpption: [
Suthertication: [

Disconnect

Exit |

[Eom1, 115200 |

Figura 2-34. Pestaia de Parametros de Configuracion de BTCONF
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Configuraciéon del Médulo Bluetooth

8. Paradefinir los pardmetros de seguridad (Figura 2-35), ingrese
y habilite las siguientes opciones, después haga clic en Apply:
 Bluetooth PIN—ingrese hasta 16 caracteres para especificar

un nimero de identificacion personal parael modulo
Bluetooth.

* Encryption — habilitela para que el médulo Bluetooth
encripte datos enviados inaldmbricamente. Para leer datos
encriptados, €l usuario debe tener el mismo PIN utilizado
en el dispositivo que envio los datos.

 Autenticacion — habilitela para solicitar un PIN antes que
dos dispositivos habilitados con el Bluetooth (como por
gjemplo, € receptor y una computadora) puedan establecer
un enlace de comunicacion. Los dos dispositivos deben
utilizar el mismo PIN.

@ AVISO

Si no necesita configuraciones de seguridad, deje estos
parametros deshabilitados.

BTCONF = 3

IEDM‘I 'l Identification PafamEtETS|Serial|nterface|

About | Bluetooth Mame: ITopconF’S

Security
Lonnect |
Blugtaath PIN: [ 123456789
Apply %l
Encryption: v
Disconnect |
Authentication: v

Exit |

[Eom1, 115200 |

Figura 2-35. Parametros de Seguridad de BTCONF
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9. HagaclicenlapestafiaSerial I nterface (Figura 2-36). Habilite
Echo para mostrar las respuestas del médulo Bluetooth y los
comandos correspondientes en el terminal de la computadora.
En caso de ser necesario, hagaclic en Apply.

BTCONF 19 1
IEDM‘I 'l Identificationl Parameters :

About | Eche: ™

Lonnect

Appli

il

Disconnect

Exit |

[Eom1, 115200 |

Figura 2-36. Pestaiia de la Interfaz Serial de BTCONF

10. Hagaclic en Disconnect y después en Exit (Figura 2-37) para
salir de BTCONF.

BTCONF = 3

IEDM‘I 'l Identification | Parametersl Sefial Interfacel

Bluetoath Information:
About | Bluetoath name: TopconPS A|
1
Edl BTCONF (O[]
Cannest | -
IEDM‘I 'l Identification | Parametersl Sefial Interfacel

Bluetoath Information:

About ;I

Connect

_ oo
| G |
|
[ Shssanesr]

COM1, 115200 Aeply

Disconnect

|Disc:0nnec:ted |

Figura 2-37. Haga clic en Disconnect y después en Exit

2-46
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Coleccion de Almanaques

Cada satélite transmite un mensaje (almanaque) que dala érbita
aproximada de si mismo y de todos los demés satélites. Si el
receptor tiene un almanaque, usted puede reducir
considerablemente el tiempo requerido para buscar y capturar las
sefidl es satelitales.

El receptor actualiza regularmente e amanaque y guarda el
almanagque més reciente en su Memoria de Acceso Aleatorio No
Volétil (NVRAM).

1. Instale € receptor (conecte la antena externa en caso de ser
necesario) en una ubicacion con una vision despejada del
horizonte. Encienda el receptor.

2. Espere aproximadamente 15 minutos mientras el receptor
colecta datos de almanaque a partir de los satélites.

@ AVISO

Si después de transcurridos 15 minutos el receptor no ha
capturado satélites, tal vez necesite borrar la NVRAM.
Vea “Borrado de la NVRAM” en la pagina 4-21 para
obtener informacion sobre este procedimiento.
Necesitara colectar 0 actualizar € amanaque:
 Si el receptor ha estado apagado durante un tiempo prol ongado.

+ Si laUltima posicidn conocida del receptor, guardada en la
NVRAM sediferenciade laposicién actual en varios cientosde
kilometros.

» Después de cargar un nuevo OAF.

» Después de cargar un firmware nuevo.
» Despuésde borrar laNVRAM.

» Antesdeiniciar €l levantamiento.

P/N 7010-0557-SP www.topconpositioning.com
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Notas:

2-48
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Capitulo 3

nstalacion y
Levantamiento

El presente capitulo describe:
* Instalacién del receptor
* Instalacion de la estacion Base RTK
* Instalacion del Rover RTK
« Levantamiento basico con el receptor HiPer Lite o HiPer Litet+

L os paquetes HiPer Lite e HiPer Lite+ utilizan un receptor como
estacion Base 'y €l otro como estacién Rover.

Instalacion del Receptor

Parainstalar |os receptores, usted debe:

1. Configurar los receptorestal como se detalla en el Capitulo 2.

2. Instalar las estaciones Base y Rover. Vea“Paso 1: Instale e
Receptor” en la pagina 3-2.

3. Medir laalturadelaantena. Vea“Paso 2: MidalaAlturadela
Antena’ en lapégina 3-2 en el caso de las antenas internas.

4. Inicielacoleccion de datos. Vea“Paso 3: Colecte Datos’ en la
pagina 3-5.

Todos | os receptores incluyen una antenainternatipo microstrip
capaz de capturar sefiales L1/L 2 de satélites GPSy GLONASS.
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Paso 1: Instale el Receptor

Esta seccién asume que el receptor ha sido configurado
utilizando el PC-CDU.

1. Cologue €l receptor en €l tripode o bipode apropiado.

2. Centre €l receptor en e punto en € que se colectaran los
datos. En la mayoria de aplicaciones, deber ser una
ubicacion con una vista despejada del horizonte.

Paso 2: Mida la Altura de la Antena

Laubicacion delaantenaen relacion con el punto a ser medido
€s sumamente importante tanto para levantamientos en los que
la elevacion de los puntos es importante como en
levantamientos en |os que o Unicamente se requiere la
ubicacién horizontal. Los levantamientos horizontales son
frecuentemente mayores en términos de areay pueden encajar
de manera segura en una superficie nivelada, por lo que €l
guste de la antena debe ser tridimensional para luego
proyectarse en un plano bidimensional.

El receptor calculalas coordenadas del centro de fase de la
antena. Para determinar las coordenadas del marcador de
estacion, el usuario debe especificar lo siguiente:

¢ Alturamedida de la antena por encima del marcador de
estacion
» Método utilizado para medir laaltura de la antena
* Modelo de laantena utilizada
L as antenas realizan dos tipos de mediciones:

* Vertica — medida desde el marcador a punto de referencia
de laantena (ARP) ubicado en &l extremo inferior del
receptor en la base de las roscas de montaje.

* Inclinada — medida desde marcador a bordeinferior dela
marca de medicién de alturainclinada (SHMM) ubicada en
los paneles posteriores del receptor.
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1. Medir laalturade laantena sobre el punto o marcador.

LaFigura 3-1 muestra los desplazamientos de antena. (Vea
laFigural-3enlapaginal-17y laFigural-5en

la pagina 1-19 para obtener una ubicacion exactade
SHMM.)

—_— i

yy

30.50mm SHMM I
\ 4 |

77.75mm |

Figura 3-1. Desplazamientos de las Antenas del HiPer Lite y del HiPer Lite+
» Desplazamiento vertical SHMM a ARP = 30.50mm
» Desplazamiento horizontal SHMM a ARP = 77.75mm

La Tabla 3-1 muestra los valores de desplazamiento para
los receptores.

Tabla 3-1. Valores de Desplazamiento de las Antenas de acuerdo con las
Opciones del Receptor

Al Centro de Fase L1 Al Centro de Fase L2

Arriba 106.1mm 95.7mm

El punto medido a efectuar un levantamiento con GPSY
GLONASS se denomina Centro de Fase de la antena. Es
similar a punto medido por el distanciémetro en un prisma.
El usuario debe ingresar €l desplazamiento del prisma para
compensar gue este punto no se encuentre en una superficie
fisicadel prisma. En e caso de una antena GPS/
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Topcon

GLONASS, seingresa el desplazamiento dependiendo del
tipo de medicion realizada. Paralamedicion vertical,
simplemente se afiade el desplazamiento alaalturavertical
medida para producir una altura vertical “correcta’. En el
caso de laalturainclinada, primero es necesario calcular la
alturavertical utilizando €l radio de la antenay después se
afnade el desplazamiento. L os desplazamientos no tienen €l
mismo numero debido aladiferencia en la ubicacion entre
e punto de medicion inclinado y el punto de medicion
vertical

Registre la dtura de laantena, el nombre del punto, y la
hora de inicio en las notas de campo.

Presione la tecla de encendido y suéltela para encender €
receptor. Laluz (LED) de ESTADO parpadeararojo a
principio.

Unavez que €l receptor haya capturado uno o més satélites,
laluz de ESTADO parpadeara verde paralos satélites GPS,
naranjaparalos satélites GLONASS, y emitiraun parpadeo
rojo corto en caso que no haya determinado una posicion.
Cuatro o més satélites ofrecen un posicionamiento 6ptimo.

Unavez que &l parpadeo rojo corto desaparece, esto indica
gue el receptor tiene una posicion y es posible comenzar el

levantamiento. Debe esperar que aparezcan las luces verde
y haranja antes deiniciar la coleccion de datos. Al hacerlo

se asegura que el receptor tiene lafechay hora correctasy

ha captado suficientes satélites, garantizando asi, 1a buena

calidad de los datos.

El proceso de captar satélites normal mente demora menos
de un minuto. En un &rea nueva, con follgje espeso, o
despuésdereinicializar €l receptor, podriademorar algunos
minutos.
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Paso 3: Colecte Datos

1. Paraempezar acolectar datos presione y mantenga
presionadalateclade funcion durante méas de uno y menos
de cinco segundos.

2. Dejede presionar lateclade funcién cuando €l LED de
REGISTRO esté verde. Esto indica que un archivo hasido
abierto y que se hainiciado la coleccion de datos. El LED
de REGISTRO parpadea cada vez que se guardan datos en
lamemoriainterna.

RECOMMENDACION

Utilice el PC-CDU para configurar el registro de datos.
Vea “Configuracion de la MINTER” en la pagina 2-24 o
consulte el Manual del Usuario del PC-CDU para obtener
mayor informacion al respecto.

3. Cuando termine, presione y mantenga presionada latecla
de funcién hasta que se apague laluz del LED de
REGISTRO.

4. Paraapagar €l receptor, presione y mantenga presionada la
tecla de encendido hasta que se apaguen todas las luces,
después suéltela.
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Levantamiento con el Receptor

Puede utilizar su receptor pararealizar levantamiento Estético,
levantamiento Cinemético, o levantamiento Cinemético en tiempo
rea (RTK).

Levantamiento Estatico

El levantamiento estético es e modo de levantamiento clésico,
adecuado paratodas las lineas de base (cortas, medianas y
largas). Al menos dos antenas del receptor, perpendiculares a
las marcas de |evantamiento, colectan simultaneamente datos
sin procesar en cada extremo de unalinea de base durante
cierto periodo de tiempo. Estos dos receptores rastrean cuatro o
més satélites comunes, tienen una tasa comun de registro de
datos (5-30 segundos) y los mismos angulos de error de
elevacion. Laduracion de las sesiones de observacion puede
variar entre algunos minutosy varias horas. Laduracion optima
de la sesién de observacion depende de la experiencia del
topdgrafo asi como de los siguientes factores:

 Lalongitud de lalinea de base medida
* El nimero de satélites visibles

» Lageometria satelital (DOP)

* Laubicacion de laantena

El nivel de actividad ionosférica

L os tipos de receptores utilizados
* Losrequerimientos de precision

» Lanecesidad de despejar |as ambigtiedades de lafase de
portadora

Por lo general, los receptores de una frecuencia se utilizan para
lineas de base con longitudes de menos de 15 kilémetros (9.32
millas). Paralineas de 15 kilémetros o més, utilice receptores
de doble frecuencia
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L os receptores de dobl e frecuencia ofrecen dos ventajas
importantes. En primer lugar, |os receptores de doble
frecuencia pueden estimar y eliminar casi por completo €l
efecto ionosférico de las mediciones de codigo y de fase de
portadora, ofreciendo mayor precision que los receptores de
una frecuencia en lineas de base largas o durante tormentas
ionosféricas. En segundo lugar, los receptores de doble
frecuenciarequieren un menor tiempo de observacion para
alcanzar el requerimiento de precision deseado.

Después de completar el levantamiento, |os datos col ectados
por los receptores pueden ser descargados a una computadoray
procesados utilizando un software de post-procesamiento
(Topcon Tools, por gjemplo).

El siguiente procedimiento describe los pasos que debe seguir
el operador pararealizar un Levantamiento Estético con
MINTER.

1. Conecte su receptor y computadora. Vea“ Conexion del
Receptor y una Computadora’ en la pagina 2-12 para
obtener informacion con respecto a este procedimiento.

2. Abrael PC-CDU, hagaclic en Configuration » Receiver
» MINTER vy especifique |os siguientes parametros,
después haga clic en Apply (Figura 3-2 en la pagina 3-8):
» Recording Interval (Intervalo de registro) — 15
segundos

* Elevation Mask Angle (Angulo delaMéscaradela
Elevacion) — 15 grados

* File Name Prefix (Prefijo del Nombre de Archivo) —
ultimos 3 digitos del nimero de serie del receptor

« LED blink mode switch (Control del modo de parpadeo
del LED) — habilitadl inicioy fin del proceso de
registro de datos a través de latecla de funcion
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[d receiver Configuration x|

General MINTER | Positoning | Base | Fover | Parts | Events | Advanced|

Recording interval 1.00

Elevation mask for Log file 5 [degrees]
File: name prefi = log Initial data collection dynamic mods
l— [C Gtatic: € Kinematic

Always append to the file

Files Creation made Diata recording auto-star
[F Loafie  AFRM | [F off Con C Always

Automatic Fils Rotation Mads [5FAM) parameters——

Pesind [sec] [ 3600 Files [totaf ] [0

[seconds) FM key mode
[ﬁ LED blink mode switch ¢ Occupation mode switch

Phase [sec]; [0 Files [remain] o0

™| Automaticallyremove ofd files

Refiesh | #pty |J
[ok | s Save | Set all parameters ta defauits |
|

Figura 3-2. Configuration » Receiver » MINTER
3. Hagaclic en lapestafia Advanced y después en la pestafia
Multipath, definalos siguientes parametros, después haga
clicen Apply (Figura3-3):
» Code Multipath Reduction (Mitigacién del Efecto
Multipath en el Codigo) — habilitar

* Carrier Multipath Reduction (Mitigacion del Efecto
Multipath en |a portadora) — habilitar

[Ed Receiver Configuration x|

General | MINTER | Positioning | Base | Riaver | Poris | Events Advanced |

Anlidnterference  Multipath Feduction |L00p Management | Estemal Frequency | Raw Data Management | Options |

[ Code multipath reduction

Refresh ply

0K | Est | Save | Setal parameters to defauls |
[

38
Figura 3-3. Advanced » Multipath
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4. Hagaclic en lapestafia L oop M anagement (Gestion de
Bucle) y definalos siguientes parametras, después haga
clicen Apply (Figura 3-4):

» Enable Co-Op tracking — habilitar
» Static mode — habilitar
x|

General | MINTER | Postioning | Base | Fover | Ports | Events Advanced |

ArtiInterference | Mulipath Reduction  Loop Managsment | Estemal Frequency | Flaw Data Management | Options |

PLL bandwidth, 250 Hz) v E__" Opuacking
PLL order 3 [ Btatic Mods

Bandunidth of individual PLL 5.0 [Hz)
Guided loop bandwidth 05 [Hz)

Bandunidth of camman PLL 250 [Ha)
/4 cods guided loop bandwidth: |% [Hz)
¥ Enable Adaptive Guided Loops ¥ Enable Common Loop for L2

¥ Enable P/L1 and PALZ tiacking

Fefiesh AW‘F

0k | Edt | Save | Setal parameters to defaults |
\

Figura 3-4. Advanced » Loop Management

5. Instale cada antenay receptor tal como se describe en
“Instalacién del Receptor” en la pagina 3-1.

6. Inicied levantamiento.

Levantamiento Cinematico (Parar y
Seguir)

En el levantamiento cinematico (parar y seguir), se coloca el
receptor fijo (estacion base) sobre un punto, por gemplo un
hito. El receptor rastrea continuamente satélitesy registra datos
sin procesar en su memoria. El receptor Rover seinstalaen un
punto desconocido y colecta datos en € modo estético durante
2 a10 minutos.

1. Conéd PC-CDU, configure einstale labase tal como se
describe en “Levantamiento Estético” en la pagina 3-6.
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2. Cone PC-CDU, hagaclic en Configuration » Receiver »
MINTER y configure el Rover con los siguientes
pardmetros, después haga clic en Apply (Figura 3-5):

* FN Key Mode, Occupation Maode Switch (Modo de la
Tecla de Funcién, Control del Modo de Ocupacion) —
habilitar

* Initial data collection dynamic mode, Static (Modo
dindmico inicial de coleccion de datos, Estético) —
habilitar

Si desea obtener informacion con respecto alas teclas de
funciény alos estados del LED de REGISTRO, vea
Tabla4-1 en lapagina 4-5.

[Ed Receiver Configuration x|

General  MINTER | Positoning | Base | Fiaver | Parts | Events | Advanced|

Riecarding interval 700 [seconds] FN key marde
Elevsion sk forLogfie: 5 Idegress] [F LED blik mode swich % Occupstion mads switch
File rame prefis - o3 Iniil ta collaction dyamic mod

Alovays append to the fie [” Staic " Kinematic

Files Creation made Diata recording auto-star
[F Loafie  AFRM | [F off Con C Always

Automatic Fils Rotation Mads [5FAM) parameters——

Pesind [sec] [ 3600 Files [totaf ] [0

Phase [sec]; [0 Files [remain] o0

™| Automaticallyremove ofd files

Refiesh | #pty |J

[ok | s Save | Set all parameters ta defauits |
[ |

Figura 3-5. Configuracién de la MINTER del Rover

@ AVISO

Recuerde, los receptors tanto Base como Rover deben
colectar datos de los mismos satélites con la misma tasa
de registro de datos y con angulos de la mascara de
elevacion idénticos.

3-10

Topcon Manual de Operaciones del HiPer Lite y del HiPer Lite+



3.

4.
5.

Levantamiento con el Receptor

Instale el Rover en un punto desconocido y presione la
teclade encendido. Deje que el Rover colecte datos
estadisitcos de dos a diez minutos. El LED de REGISTRO
estara naranja.

Verifique laluz de ESTADO de |os satélites rastreados.

Al terminar, presione latecla de funcion durante menos de
un segundo paraindicarle al Rover que pase a modo
cinemético.

/
RECOMMENDACION

Recuerde, si el LED REC parpadea verde, el modo
actual es dinamico, si parpadea naranja, el modo actual
es estatico.

6.

Mueva el Rover ala ubicacion siguiente (punto de
levantamiento), y presione lateclade funcion durante
menos de un segundo para colectar datos en modo estético
de dos adiez minutos.

Repitalos pasos cinco y seis hasta que todos |os puntos
hayan sido levantados. El tiempo de ocupacion paralos
puntos depende de los mismos factores de |os que depende
el método de levantamiento estatico.

Al terminar, presione y mantenga presionada latecla de
funcion durante uno a cinco segundos paradejar de
registrar datos. Apague el Rover en caso de ser necesario.

Este método de levantamiento GPS le permite a operador
reducir el tiempo de ocupacion del punto, permitiendo asi, alas
brigadas de trabajo en campo, levantar muchos méas puntos en
comparacion con los otros métodos disponibles.

P/N 7010-0557-SP www.topconpositioning.com

N



Instalacién y Levantamiento

Levantamiento Cinematico en Tiempo
Real

El levantamiento cinemético en tiempo real (RTK) esun
proceso GPS diferencial donde lainformacion, tal como las
correcciones diferenciales, se transmite en tiempo real desde
una estacion Base a una 0 més estaciones Rover.

Instalacion de una Estacion Base RTK

Para configurar una estacion Base RTK usando €l
PC-CDU, sigalos siguientes pasos:

1. Instalelaantenadel receptor de la estaciéon Base tal
como se describe en “Instalacion del Receptor” en la
pagina 3-1.

2. Presionelateclade encendido en el receptor.

3. Veifiquelaluz de ESTADO paradeterminar si se han
rastreado satélites.

4. Conecte su receptor y computadora. Vea“ Conexion del
Receptor y una Computadora” en la pagina 2-12 para
obtener informacion con respecto a este procedi miento.

5. Hagaclic en Configuration » Receiver.

6. Hagaclic en Set all parametersto defaults
(Restablecer todos |os pardmetros a sus valores por
defecto) que se encuentra ubicado en el extremo
inferior del cuadro de didogo (Figura3-6 enla
pagina 3-13).
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[l Receiver Configuration x|
General | MINTER: | Postioning | Base | Rover | Parts | Events | Advanced |

~Power management
Elevation mask [dearees E “ahages [valis
Terminal Elevation Mask. 5 Mode - m Buiingll: IF
Aitenn Antenna Status (1ead only}—— Current Mode ; [=+ OnBoard: [7 6
£ Intenal i
Current Input int e —
€ Extemal = Batterp &u: |7 54
& Ao Est D Status : [off Mode - fue T
Battew B; [751
Temperature [Celsius degrees] Speed: =
lrEnard femperture - Cutentbtode: [- || Chageri |75
~Power output modes - Tuin on/off Slets—
Paits : On - I Slot2

¥ Slot3
Slots o = || % Sore
[ Enable Low Powsr Mode:
Fiefiesh | Apply

0k | Edt | Save | Setal parameteqo defaults |
\

Figura 3-6. Set All Parameters to Defaults (Restablecer Todos los Parametros a
sus Valores por Defecto)

7. Enlapantallade Configuracion del Receptor,
seleccionelapestafiaMINTER. Especifique los valores
deseados. Si desea obtener mayor informacion,
consulte e Manual del Usuario de PC-CDU.

8. SeleccionelapestafiaPositioningy definael parametro
de lamascara de Elevacion (Elevation mask) como 15
(Figura 3-7), después haga clic en Apply.

x|

General| MINTER: | Postioning| Base | Rover | Pants | Events | Advanced |

Paositioning Mode—— ~Enable Solutions—— —Satelite
& Standaions ¥ Standalone Satelites tracked Satelites used in pos
" DGR [Code Differential) ¥ DGR3 J#| GPS J= GLONASS ||| = GPS ™| GLONASS
 RTK Float ¥ FTK Flost
 RTK Fired ¥ FTK Fired GPS | cLonass | waas|
o — pinllock|use| prn{lockuse| prnliock|use| pm{lockuse
e [ | |pes || M E SEE R ar e
degres) 5 2 F R ¥ 1BF ¥ %R W
FDOP mask:  [3000 I GLONASS IF R NF R 19F F ZF
T A Eebe——— el || @ @l PdE Al g gl -
tlam: [Nonpresion =] | & Gt ME|E BEIE 2EE 2
" o I R Tl =S N Tl o
lar [t ] [ ez R O
8v v 1BV ¥ uN ¥ 32 V¥
Cunent Datum |4 | (=l b Camei Alltolock | Wone talosk|  Alltouss | Mo to uss|
Diatum Parameters 2 Ursreton
Adyanced Pastoring Settings | Reesh | apoly |
Exit Save | Setall parameters to defaults

Figura 3-7. Configuracion del Receptor — Pestaia Positioning
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9. Seleccione la pestafia Base, definalos siguientes
pardmetros (Figura 3-8 en la pagina 3-15), y hagaclic
en Apply:

* GPS/GLO at onetime (GPSGLO alavez) —
habilitar
* Posicién de laantena— ingrese los valores de

Latitud, Longitud y Altitud de laantena. Efectte
uno de los siguientes procedi mientos:

—Si lo sabe, ingrese los valores.

—Habilite Averaged (Promediado) y Averaged Span
(Intervalo Promediado) en segundos, después haga
clicen Apply. Hagaclic en Tools » Reset receiver
y espere hasta que se complete e intervalo (Iapso)
de tiempo especificado. Verifique las coordenadas
delaBase en |la pestafia Base, lainformacion debe
corresponder a las coordenadas obtenidas del
promedio. Hagaclic en Refresh (Actualizar) si las
coordenadas son ceros.

—Hagaclic en Get from receiver (Obtener
Informacion desde el receptor).

@ AVISO

Las coordenadas geodésicas referenciales que se
especifican en esta pestafia corresponden al centro de
fase L1 de la antena.

Topcon
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[l Receiver Configuration x|

General| MINTER | Postioning £Ease | Rover | Pans | Events | Advanced |

—Base Station Coordinates [ Artenna Phass Center | ~RTCM Settings

Measuements Sen
- : Averaged
& GPS/GLO at one fime B ot StationID: [0 7 el - P PAZ
£ GPS/GLO separately |7 7
M'ES* F'ﬁfl"he' lD_ System uSea—‘
of Satelitss
6PS/6LO | Gt fiom recsiver ’7 G 1 GRS

Heath:[Gond =]~ Peeudorange smoothing

Reference Geodetic Coordinates |

2 9 ! "Tn - - [CMR Seti
Lat[a0 *[a0 ‘[oo00o00 *[n =] [wes eltings ——
Lonf000 W no.ooo00 e - Station 1D: [0 & 0l € P ¥ PA2
Al [«0ooo0 Ditum Parameters | || | Motion: [Unknown =] GLONASS message: [T 2]
Antenna Offsets [Landmark to ARP, meters] Short D2 | COGO: |
’;asl'UUUUU North [0.0000  Height [0.0000 Long 0|

Configuration of Recsiver Ports |

Advanced Base Sellings Riefiesh Aogly |

0k | Edt | Save | Setal parameters to defaults |
\

Figura 3-8. Configuracién de la Pestana Base

10. Seleccione la pestafia Portsy definalos siguientes
pardmetros de puerto (Figura 3-9 en la pagina 3-16).
Utilice el puerto serial C en el caso de un modem
interno de Espectro Ampli MHz de 915.

» Exportar lista desplegable — seleccione € tipo y €
formato de las correcciones diferenciales.

* Periodo (segundos) —ingrese €l intervalo en el que
€l receptor generard correcciones diferenciales.

« Listadesplegable de tasa de transferenciaen
baudios — seleccione unatasa de transferencia en
baudios (es decir, lavelocidad alacua se
transmitiran mensajes diferenciales desde el
receptor al médem).

» RTS/CTS - seleccione habilitacion de negociacion.

RECOMMENDACION

Use una tasa de transferencia en baudios de 38400. Si
desea obtener mayor informacién con respecto a la
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configuracion de tasas de transferencia en baudios, vea
la Tabla 2-3 en la pagina 2-36.

[ Receiver Configuration ]
General | MINTER | Positoning | Base | Fiaver Foris | Events | Advanced|
Seial | Patslel| Modem | USB | Ethemet| TCP |
) Input: | Command 2 Baudrate: | 115200 |~
Serial &
Dutput: [Hore | Period (sec): I~ ATS/ETS
) Input: | Command - Baudrate: |115200 ¥
Seiial B
Output: |Mone > | Period [sec): [~ RTS/CTS
Input: | Command = Baudrate: 38400 =
Serial C
Output: [RTK CMA =] Period [sec): [1.00 ¥ RTSATS
SeiAl Dl nput; = Baud rate ; =
T Infrared Gyt 7| Period fsec - = RTS/CTS
Refiesh L
0K Ext | Save | Setal parameters to defauits

Figura 3-9. Configuracion Base — Puertos

11. Hagaclic en Apply. El receptor empezard a enviar
datos a puerto seleccionado.

Para més detalles sobre |os valores disponibles para
configurar la estacion Base, consulte e Manual de Usuario
del PC-CDU.

Instalacion de un Rover RTK

Siga los siguientes pasos parainstalar una estacion Rover
RTK. Usted ya debe haber programado el médem. La
Figura 3-10 en la pagina 3-17 le muestra la configuracion
del hardware para una estacién Rover con un controlador
externo.

3-16
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U

?

: b |

Figura 3-10. Instalacion de la Estacion Rover
1. Instalelaantenadel receptor Rover tal como se
describe en “Instalacion del Receptor” en lapagina 3-1.

2. Conecte su receptor y computadora. Vea“ Conexion del
Receptor y una Computadora” en la pagina 2-12.

3. Hagaclic en Configuration » Receiver.

4. SeleccionelapestaiiaPositioningy definael parametro
Position Masks, Elevation mask (degrees) (Méascarasde
Posicion, mascara de Elevacion (grados) a 15
(Figura 3-7 en lapagina 3-13).

P/N 7010-0557-SP www.topconpositioning.com
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5. Seleccione la pestafia Rover y defina el Positioning
Mode (Modo de Posicionamiento) deseado

(Figura3-11).

Topcon

E# Receiver Configuration x|
General | MINTER | Fositoning | Base  Rover | Ports | Events | Advanced |
~Positioning Mode ~Enable Salution:
" Standalone  ATK Float ¥ Standalone | BT Float
¢ DGPS [Code Differential] ¢ RTK Fixed ¥ DGRS ¥ | BT Fired
DGPS Parameter RTK Parameter
W Iulti-base . RTK muadk Dwnamics— —Ambiguity fixing level
[0 Earections
Conestions usag=— | man, age (s=0]: El © Extiapolation | | Static £ Low
¥ Hearest X @ Medium
oo Carrections 30y &+ Delay & Kinematic | High
i max. age [sec]:
f# Bonestions I~ Use lono Conections Measuemans s Base Corections
3 1.00
€ Positions Al el P el P period [sec]
™ Best Saurce Jany - [ Useoldref coordinates  Source® |dny -
CMR Settings
GLOMASS message - [3 '¢] Reset ATK Engine |
Configuration of eceiver Ports |
Advanced Fover Settings | Refresh | Apply |\|
[ok | et | Save | Set all parameters to defau\tsl

Figura 3-11. Configuracién de la Pestafia Rover

Ajuste los siguientes valores de Parametros RTK:

En el modo RTK en laseccion de Parametros RTK,
dlija Extrapolacion paraflotante RTK (cinemético)
0 Retardo para RTK fijo (estético).

—L a extrapolacidn es para aplicaciones de latencia
baja, salidade altafrecuencia (>= 5 Hz) RTK. El
rover extrapolaralas correcciones de la medicion
de lafase de portadora de la estacion base al
calcular laposicion RTK actual del rover.

—Retardo es para aplicaciones RTK de alta
precision de 1 Hz. El motor RTK del Rover
caculardlaposicion RTK con retardo (parala
época ala que corresponde € mensge RTCM/

CMR recientemente recibido) o la posicion
auténoma actual (mientras espera nuevos mensajes
RTCM/CMR desde la base).
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» Seleccione el estatus de la antena durante RTK, ya
sea en Estético o Cinemético.

 Especifique e nivel defijacion de Ambigliedad (no
aplicableaRTK Flotante). Los botones de Nivel de
Fijacion de Ambiguedad regulan el proceso del
motor RTK, fijando ambigtiedades de entero. El
motor RTK utiliza el indicador fijo de ambigliedad
cuando se toman decisiones con respecto asi fijar o
no ambigledades. Bgjo, Medio, y Alto
corresponde a los estados de 95%, 99.5% y 99.9%
del indicador. Mientras mayor sea el nivel de
confianza especificada, mayor sera el tiempo de
busgueda de ambigliedad de entero.
6. Seleccione la pestafia Portsy definalos siguientes
parametros para el Puerto Serial C (Figura3-12 enla
pagina 3-20):

 Importe lalista desplegable- seleccione el formato
de correccién diferencial deseado.

* Periodo (segundo) —dejarlo tal como esta.

« Listadesplegable de tasa de transferenciaen
baudios — seleccione unatasa de transferencia en
baudios (es decir, lavelocidad ala cual se
trasmitiran los mensgjes diferenciales desde el
maodem al receptor).

» RTS/CTS - seleccione habilitacion de negociacion.

RECOMMENDACION

Utilice una tasa de transferencia en baudios de 38400. Si
desea obtener mayor informacién con respecto a la
configuracion de las tasas de transferencia, vea la
Tabla 2-3 en la pagina 2-36.
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[ Receiver Configuration ]
General | MINTER | Positoning | Base | Fiaver Foris | Events | Advanced|
Seial | Patslel| Modem | USB | Ethemet| TCP |
) Input: | Command 2 Baudrate: | 115200 |~
Serial &
Output: [More ~| Period [sec) : [~ RTS/CTS
) Input: | Command - Baudrate: |115200 ¥
Seiial B
Dutput: [None | Period (sec): I~ ATS/ALTS
Input: |CMFR d Baudrate: |38400 ¥
Serial C
Dutput: [None ~| Period sec): ™ RTSATS
SeiAl Dl nput; = Baud rate ; =
T Infrared Gyt 7| Period fsec - = RTS/CTS
Refiesh L
0K Ext | Save | Setal parameters to defauits

Figura 3-12. Configuracion del Rover — Puertos

7. Hagaclicen Apply.
8. Hagaclicen OK para cerrar |a pantalla Receiver
Configuration (Configuracion del Receptor).

9. Enlapantallaprincipal del PC-CDU (Figura3-13enla
pagina 3-21), habilite el campo LQ paraasegurarse que
€l receptor obtenga las correcciones diferenciales. Por
lo general, €l receptor iniciarala exportacion de
coordenadas del centro de fase de laantenajunto con €l
tipo de solucién en un lapzo de 10-30 segundos. Sin
embargo, la sincronizacién de los radios de espectro
amplio podrian tarda hasta 60 segundos.

3-20
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[ PC-CDU (rover)
File Corfiguration Tools Plots Help

Levantamiento con el Receptor

(O] %]

GPS Satellites (11]

Gea |wvz | Target] GLONASS Satellites

sz|cal P pra] 7o) 55]

Lat 55" 41'56.9637" N [5n[Fn | EL[ sz[calri]rz] 1C] 55

02 |12 44
03 20+ BB
08 | Bo+ 244
10% | 46+ 280
13 35 128
17 7+ 382
23 18+ 324
27 Th 92
280 21+ 192
29* 14+ 300
1%+ 96

Lon: 37" 33' 53.9545" £
Alt: 2178161 m

Wel: 0.0106 m/s

RMS Pos: 0.0032 m
RMS Vel 0.0730 m/s
FPOOP: 1.0970

3717 17 145 BB
3 A BB BB+
53 45 45 144 55+
43 37 37 134 55+
4523 30 145 5O+
3514013 18 30+
38 A 20 33 BB+

52| 45 45 145 55+ 107
B 1919 38 55 Fleceiver time: 11:27:46

Receiver date: 18.03.02
A Clockofset 01833 pem
Oz, offset:  +0.0285 ppm
Tracking time: 02:25:33

[RTE fixed)
L@: 1002 (000,7501,0042]

COM1, 115200

[ 00:00.07

Figura 3-13. Pantalla Principal del PC-CDU

L as coordenadas geodésicas mostradas en |a pestafia Geo
siempre se calculan en WGS84 y tienen cuatro tipos de
solucioén.

P/N 7010-0557-SP

Independiente (Standalone) — donde el receptor calcula
|as coordenadas 3D en & modo auténomo sin utilizar
correcciones diferenciaes.

Diferencia de cédigo (Code differential) — donde €l
receptor Rover calculala coordenada relativa actual en
el modo diferencial utilizando sblo pseudo-rangos.

RTK flotante (RTK float) — donde el receptor Rover
calculalas coordenadas relativas actuales en el modo
diferencial utilizando tanto pseudo rangos como fases;
sin embargo, con una solucion flotante, la ambiguedad
de fase no es un nimero entero fijo y en su lugar se
utilizael estimado “flotante”.

RTK fijo (RTK fixed) —donde el receptor Rover calcula
las coordenadas rel ativas actuales, con fijacion de
ambigledad, en modo diferencial.

www.topconpositioning.com
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El campo LQ reflejadl estado de los mensgjes diferenciales
recibidos y contiene la siguiente informacion:

» Cdlidad del Datalink en porcentaje

 Tiempo (en segundos) transcurrido desde el Gltimo
mensaje recibido

» NUmero total de mensajes correctos recibidos
(dependiendo del tipo de mensaje recibido)

» NuUmero total de mensajes corruptos recibidos
(dependiendo del tipo de mensaje recibido)

Si por algin motivo, €l receptor no esta recibiendo
correcciones diferenciales, o si ho se ha configurado
ninguno de los puertos pararecibir correcciones
diferenciales, el campo LQ estara vacio o tendra esta
apariencia: 100%(999,0000,0000).

3-22
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Capitulo 4
m 7
peracion

El presente capitulo describe los procedimientos operativos
estandar del receptor:

* UsodelaMINTER

» Descarga de archivos del receptor a una computadora
« Eliminacion de archivos en el receptor

* Verificacion y cargade OAFs

» Gestion de lamemoria del receptor

» Borrado delaNVRAM

» Cambio de los modos del receptor

* Verificacion y cargadel firmware

L os receptores Topcon han sido fabricados para operar
independientemente del tipo de receptor. Se aprecian excepciones
menores.
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Operacion

Uso de la MINTER

LaMINTER (Figura4-1) eslaINTERfaz MiNima de Topcon se
utiliza paramostrar y controlar laentraday salida de datos, y es
igual paratodalafamilia de receptores HiPer.

Tecla de Encendido Tecla de Reseteo LED de la
LED de Estado Bateria

LED de Registro LED de Médem
FN (tecla de funcion/grabacion

Figura 4-1. MINTER (HiPer Lite+)

Tecla de Encendido

Al presionar lateclade encendido € receptor se enciendey
apaga.

LED de Estado

 Cuando € receptor se encuentra encendido y no rastrea
satélites, el LED de ESTADO parpadeara rojo.

 Cuando € receptor rastrea satélites, el LED de ESTADO
parpadeard una vez por cada satélite rastreado (verde para
GPS, naranja para GLONASS).

Tecla de Reseteo

Al presionar y mantener presionada la tecla de reseteo durante
un segundo, generara:

» Un reseteo manual del receptor.
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* Que € receptor salgadel Modo Energia Cero y regrese a
Modo Normal.

@ AVISO

Utilice este procedimiento unicamente si el receptor no
responde a los comandos o no carga las baterias
internas (se encuentra en el Modo Energia Cero).

Tecla FN y LED de Registro

LaTabla4-1 en la pagina 4-5 resumen las funciones clave de
lasteclas de funcidny los estados del LED de REGISTRO. Vea
“Parametro Modo delaTeclaFN ” en la pagina 2-30 para
obtener informacion con respecto ala configuracion de los
modos claves de funcién FN.

Al presionar latecla FN (Funcién) durante menos de un
segundo el receptor alternard entre los diferentes modos de
informacion (informacion normal y extendida), o entre los
modos de post-procesamiento estatico y dinamico
dependiendo de la configuracion del receptor.

Durante el primer segundo de presionar lateclaFN, el LED
de Registro estara naranja:

« Al presionar y mantener presionada latecla FN durante
mas de un segundo y menos de cinco seiniciard/detendrala
grabacion de datos.

Durante €l registro de datos, el LED de REGISTRO esta
verde.

Si el LED REC estarojo, el receptor ha agotado la
memoria, tiene un problema de hardware o contiene un
OAF incorrecto (vea“Archivo de Autorizacion de Opciones
(OAF)” enlapégina 1-19 para obtener mayor informacion
sobre los OAFsS).

P/N 7010-0557-SP www.topconpositioning.com
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» El LED de Registro parpadea verde cada vez que los datos
son transferidos ala memoriainterna del receptor.

Configure el interval o de tiempo de registro de datos con su
PC-CDU. Vea “Parametro del Intervalo de Registro” en la
pagina 2-27 para obtener informacion sobre la
configuracion de esta funcion.

Cada vez que apague o encienda € registro de datos, se
abrira un nuevo archivo o se anexara datos a un archivo
particular. Vea“Pardmetro Siempre Anexar a Archivo” en
la pagina 2-28 y “Parametro Modo de Creacion de
Archivos’ en la pagina 2-28 para obtener informacion
sobre como configurar esta funcion.

Al presionar y mantener presionadalatecla FN durante
més de cinco y menos de ocho segundos hara que la
velocidad de transferencia en baudios del puerto serial A
sea 9600. (Después de mantener presionada latecla FN €l
LED de Registro se vuelve rojo). Suelte lateclaFN
mientras el LED de Registro se encuentrarojo (por los
préximos tres segundos).

Si presionay mantiene presionada latecla FN durante més
de ocho segundos no sucede nada.

 Después de cargar un firmware nuevo o borrar laNVRAM
del receptor, el receptor verificara su sistema de archivos
internos.

Durante esta operacién, el LED de Registro parpadeara
naranjay no sera posible acceder al sistema de archivos
para aplicaciones CDU (Unidad de Pantalla de Control) o
para el registro de datos. Esta operacion podria requerir
desde fracciones de segundo hasta varios minutos,
dependiendo de las circunstancias y de lamemoriainterna.
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Tabla 4-1. Funciones de las Teclas FN y Estado del LED de Registro

Tecla FN

LED REC

Estado

Si lagrabacion de

datos se encuentra desactivada, y lateclaFN esta. ..

Luz apagada No se graban datos.
Sin presionar Parpadeo Prueba del sistema interno de archivos
naranja en progreso.
Rojo Sin memorialibre, problemadel
hardware con €l registro de datos.
Si el modo de lateclaFN se encuentraen “control del
maodo de parpadeo del LED”
Presionada Naranja Dejar de presionar paracambiar €l
durante < de 1 modo de informacion.
segundo Si el modo de lateclaFN se encuentraen “control del
modo de Ocupacion”
Naranja Ninguna funcién.
Si el modo de lateclaFN se encuentraen “control del
modo de parpadeo del LED”
Verde Soltar parainiciar registro (modo de
Presionada ocupacion de post-procesamiento
durante 1-5 Cinemdtico o Estético)
segundos Si el modo de latecla FN se encuentraen “ Control del
modo de ocupacién”
Verde Dejar de presionar parainiciar registro
(modo de ocupaci6n de post-
procesamiento cinemético o estético)
Presionada Rojo Dejar de presionar para hacer quela
durante 5-8 tasa de transferencia en baudios del
segundos puerto serial A sea 9600.
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Tabla 4-1. Funciones de las Teclas FN y Estado del LED de Registro

Tecla FN LED REC Estado
Presionada Luz apagada Ninguna funcioén.
durante > 8
segundos

Cuando la grabacién de datos se encuentra activada, y lateclaFN esta...

Rojo Sin memorialibre, problema del
hardware con €l registro de datos.

Si e modo de latecla FN se encuentra en “control del
modo de parpadeo del LED”

! . Verde Registro de datos iniciado (modo de
Sin presionar .. .
ocupaci6n de post-procesamiento
indefinido)

Si el modo de lateclaFN se encuentraen el control de

modo de Ocupacion

Verde Registro de datos iniciado (modo de
ocupacion de post-procesamiento
cinemético)

Naranja Registro de datos iniciado (modo de
ocupacion de post-procesamiento
estético)

Si el modo de lateclaFN se encuentra en “control del

modo de parpadeo del LED”

Presionada - - - -
durante < de 1 Naranja Dejar de presionar para cambiar el
segundo modo de informacién.

Si el modo de lateclaFN se encuentraen “Control del
modo de ocupacién”

Naranja Dejar de presionar para desplazarse
entre los modos de post-procesamiento
Estético y Cinemético.
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Tabla 4-1. Funciones de las Teclas FN y Estado del LED de Registro

Tecla FN LED REC Estado
Presionada Luz apagada Dejar de presionar para detener la
durante 1-5 grabacion de datos.
segundos
Presionada Rojo Dejar de presionar para hacer quela
durante 5-8 tasa de transferencia en baudios del
segundos puerto serial A sea 9600.
Presionada Luz apagada Sin funcion (grabacion de datos alin en
durante > 8 estado activo).
segundos

LED de la Bateria

El color del LED delabateriaindicael nivel de cargadela

bateriainternadel HiPer Lite:

 Verde — indica una carga de mas del 85%.

» Naranja—indica una cargaintermedia.

» Rojo—indica una carga de menos del 15%.

El patrén de parpadeos del LED de la bateriatambiénindicala
fuente de energia.

» Luzfija— Se esta utilizando alimentacion externay las
baterias no se estan cargando.

* Parpadeo unavez por segundo — | as baterias se estén
cargando.

* Parpadeo cada cinco segundos - €l HiPer Lite se esta
alimentando através de las baterias internas.

* Sin parpadeo — €l receptor se encuentraen el Modo Energia
Cero o las baterias internas se han descargado
completamente y ninguna fuente externa se encuentra
conectada.

P/N 7010-0557-SP
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@ AVISO

Si las baterias internas se han descargado totalmente y
si no se ha conectado ninguna fuente externa de
energia, el receptor pasara al Modo Energia Cero para
evitar que las baterias continien descargandose.

LED del Médem

El color del LED del Médem UHF indicasi el modem esta
encendido, esta recibiendo sefiales o esta apagado.

Topcon

L uz apagada— € modem esté apagado.

Verde oscila— el médem se encuentra en e modo del
receptor.

Verde Fijo — se ha establecido un radio enlace; el médem
esta listo pararecibir datos.

Verde Fijo més Rojo oscilando — el médem esta recibiendo
datos.

Rojo Fijo — el mddem se encuentraen el modo del
transmisor.

Rojo oscila— se ha detectado una condicion de falla; vea
“Problemas con el Radio Mddem” en la pagina 5-14 para
obtener informacion con respecto ala deteccion y solucion
defallas.

Rojo oscilay Verde oscila— el mddem estaen el modo de
comando.
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Modos de Informacion

El receptor presenta dos modos de informacion: Modo de

Informacion Normal y Maodo de Informacion Extendida (EIM).
Normal
En el modo normal, el LED de ESTADO indica el nimero
de satélites rastreados y €l estado de calculo de la posicion.
Modo de Informacion Extendida (EIM)

El Modo de Informacién Extendida se utiliza para probar el
receptor. En este modo, €l receptor continda funcionando
de manera habitual, pero el LED de ESTADO indicala
siguiente informacion “extendida’:

 Delimitador — un doble parpadeo fécilmente
distinguible que muestra el estado total de las pruebas
realizadas en EIM. El color del LED de ESTADO para
el delimitador se calculaa partir de los colores de otros
parpadeos del LED de ESTADO.

—Naranja: a menos un parpadeo es naranja.

—Rojo: Sin parpadeos color naranjay a menos un
parpadeo rojo.

—Verde: todos |os demés casos.
 Datos suficientes para el calculo de posicion.

 Lasrelaciones S/N del GPS son buenas (Tabla4-2 enla
pagina 4-10).

* Lasrelaciones S/N de GLONASS son buenas
(Tabla4-2 en la pagina 4-10).

» Ladesviacion delafrecuenciadel oscilador es de
menos de tres ppm.

» LaVarianza Allan del Oscilador es de més de 2.7e-10.
* El tiempo de rastreo continuo es de més de 15 minutos.

P/N 7010-0557-SP www.topconpositioning.com
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Tabla 4-2. Relaciones “Buenas” Seinal a Ruido (S/N)

CA/L1 P/L1 P/L2
GPS 51 39 39
GLONASS 51 49 40

En EIM, e LED de ESTADO parpadea varias veces por
ciclo. Cada parpadeo puede ser naranja, rojo o verde.

1

4-10

Topcon

* Naranja— informacién para prueba no disponible.

* Verde — €l receptor ha pasado la prueba.
* Rojo— € receptor hafalado la prueba

Para cambiar aEIM, presione y suelte répidamente (un
segundo o menos) lateclaFN enlaMINTER.

Espere hasta que e delimitador parpadee dos veces.
Con un receptor, antenay condiciones de observacion
buenos, todos |os parpadeos deben ser verdes antes de
haber transcurrido 15 minutos del encendido.

* Verde—ok

» Naranja— esperar
» Rojo—algunas pruebas falaron

Para volver al modo normal, presione latecla FN.
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Descarga de archivos a una
Computadora

Unavez concluido su levantamiento, puede descargar los archivos
de levantamiento a una computadora para guardarlos, post-
procesarlos 0 hacer una copia de seguridad. Asimismo, lamemoria
del receptor guarda un nimero definido de archivos e informacion
por lo que descargar |os archivos evita que éstos se pierdan.

Usted deberia descargar archivos tan pronto como sea posible
después de colectar datos en el lugar de la obra. EI PC-CDU le
ofrece un Administrador de Archivos para descargar archivos a su
computadoray eliminar archivos del receptor.

1. Conecte su receptor y computadora. Vea “ Conexién del
Receptor y una Computadora’ en la pagina 2-12 para obtener
informacién sobre este procedimiento.

2. Ené€l cuadro de didlogo Connection Parameters, habilite la
negociacion RTS/CTS (Figura 4-2).

ﬁ Connection Parameters x|
Connection mode
’76‘ Direct " Intemet Client " Intemnet Server ‘

—Part setting:

Poit: ICDM1 'I Baud rate; |115200 vl ™ Infrared port

¥ RTS/CTS handshaking

—Program setting:
[T Passivemode [~ Manual mode only  Timeout [ms]: ISDD ‘I

I~ Restare the receiver's orginal baud rate on Disconnect

—Internet [ Client - Server | setting:

Hust e [localhost TIGF port: [3000

Fassyard: I

[T Display data onsever W Log server events I~ DKE lookup

Cancel |

Figura 4-2. Parametros de Conexién — Negociacion RTS/CTS

P/N 7010-0557-SP www.topconpositioning.com
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3. HagaclicenFile» File Manager (Figura4-3).

File:
Conmech Chrl+C
Disconneck Chrl+D
Real-Time Logging Ctrlﬁ
Manual Mode Chrl+M
Exit Chrl+

Figura 4-3. File » File Manager

4. Hagaclic en lapestafia Download path (Ruta de descarga) en
el cuadro de didlogo File Manager (Administrador de Archivos)

(Figura4-4).
x
Download files | Current lag filel Downlot& pathl
Total memary: 47348784 bytes Free memory: 47164824 bytes
I Mame | Sizel Datel TimeI
log03923a 78196 23.09.2002 84352
log0323b 7E795  23.09.2002 8:51:53
log0324a 5EE1  24.09.2002 95251
log0324b 4701 24.09.2002 9:52:59
log0324c 4333 24.09.2002 95344
log0324d 5190 24.09.2002 95355
log0324e 4B76  24.09.2002 9:54:06
log0324f 4162 24.09.2002 9:54:16

Save to: EATESTINGADATA

| [~ Exclusive mode

Using: IEurrent port [CORZ] 'l Block size: |512 bytes 'l

Downloadl Delete | Eefreshl Exit |

Figura 4-4. Ubicar Archivos para Descargar

5. Efectle uno de los siguientes procedimientos:

» Ubiquey abralacarpeta en laque va adescargar y guardar
sus archivos.

* Ingrese un nombre de carpeta nuevo y hagaclic en Create
paracrear una carpeta nueva en la que descargaray
guardara archivos. Abra esta nueva carpeta.

412 © Seleccione la pestaria Download files.
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7. Seleccione €l (los) archivo(s) que descargara (Figura 4-5).

Para seleccionar varios archivos ala vez, mantenga presionada
latecla Shift y después haga clic en los archivos deseados para
seleccionar varios archivos en desorden alavez; o mantenga
presionadalatecla Ctrl y haga clic en archivosindividuales.

x

Download files | Current log filel Download pathl

Total memary: 47348784 bytes Free memory: 47164824 bytes
Date Time

5651
4701 24.09.2002 %:62:53
4333 24

3

Save to: EATESTINGADATA

| [~ Exclusive mode
Using: IEurrent port [CORZ] j Block size: |51 2 bytes j
Qownloadl Delete | Befresh | Exit |

Figura 4-5. Descarga de Archivos

8. Hagaclic en € botén Download (Descargar). Durante la
descarga, observaraindicadores de estado junto a cada archivo
(Figura 4-6 en lapagina 4-14).

* Indicador azul — archivo en cola esperando ser descargado.
* Indicador rojo — el archivo esta siendo descargado.

* Indicador verde — el archivo ha sido descargado
satisfactoriamente.

P/N 7010-0557-SP www.topconpositioning.com
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x
Download files | Current log filel D ownload pathl
Total memary: 47348784 bytes Free memory: 47164824 bytes
I Mame | Sizel Datel TimeI
® |og0gz3a 78196 23.09.2002 84352
® |og09z3b 7E795  23.09.2002 8:51:53
® |og0g24a 5EE1  24.09.2002 95251
® |og0gz4b 4701 24.09.2002 9:52:59
log0324c 4333 24.09.2002 95344
log0324d 5190 24.09.2002 95355
log0324e 4B76  24.09.2002 9:54:06
log0324f 4162 24.09.2002 9:54:16

Save to: EATESTINGADATA

| Blocks: 28 I~ | Exclusive mode
Using: IEurrent port [CORZ] 'l Block size: |512 bytes 'l
Stop | [elete | Eefresh | Enit |

| 19% | Dowrlaading logo9z3a. .

Figura 4-6. Descargar Archivos — Indicadores de Estado

9. Hagaclic en Exit en el cuadro de didlogo del Administrador de
Archivos.

10. ContinGe con otras operacioens o hagaclic en File »
Disconnect y después en File » Exit parasalir del PC-CDU

(Figura 4-7).
File:

Conmech Chrl+C

File Manager Chrl+F |

Real-Time Loggi| File 1+R

Manual Mode Connect Chil+C

Exit Disconnect [Ctrl+ 0
File fanager LCirl+F

Freal-Time Logging  CilH
I arual Mode [Ctrl+hd

Figura 4-7. Haga clic en Disconnect y después en Exit

4-14
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Eliminacion de Archivos

Sigalos siguientes pasos para eliminar archivos de su receptor.
1.

Conecte su receptor y computadora. Vea “ Conexion del
Receptor y una Computadora’ en la pagina 2-12 para obtener
informacién sobre este procedimiento.

En el cuadro de didlogo Connection Parameters, habilite la
negociacion RTS/CTS (Figura 4-8).

Eﬂ[ﬁonneclion Parameters x|
Connection mode

’V(:' Direct " Internet Client " Internet Server ‘

r—Part sefting:

Port: IEDM‘I 'l Baud rate: |1152DD 'l [~ Infrared part

¥ RTS/CTS handshaking

—Program setting:
I~ Passivemode [ Manual mode only  Timeout [ms]: ISDD 'l

I Restore the receiver's onginal baud rate on Disconnect

Internet [ Client - Server | setting

Hust riame: |Iocalhost TICR port: IBDDD

Fazsyword: I

I™ | Dizplay data onserver. W Log servern events [~ DHS [aakum

Cancel |

Figura 4-8. Connection Parameters — Negociacion RTS/CTS

3. HagaclicenFile» File Manager (Figura4-9).

P/N 7010-0557-SP

File:
Conmech Chrl+C
Disconneck Chrl+D
Real-Time Logging Ctrlﬁ
Manual Mode Chrl+M
Exit Chrl+

Figura 4-9. File » Manager
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4. Enlapestafia Download files, seleccione el(los) archivos que
desea eliminar (Figura4-10).

Si desea seleccionar varios archivos ala vez, mantenga
presionadalatecla Shift y hagaclic en archivos no secuenciales
para seleccionar varios archivos alavez; o0 mantenga
presionadalatecla Ctrl y hagaclic en los archivos uno por uno.

x

Download files | Current log filel D ownload pathl

Total memary: 47348784 bytes Free memory: 47164824 bytes
Size Date Time

4701 24.09.2002
4933 24.09.2002

logl924t 4162 24.09.2002

Save to: EATESTINGADATA

| [~ Exclusive mode

Using: IEurrent port [CORZ] 'l Block size: |512 bytes 'l

Qownloadl Dele;eml Eefreshl Exit |
s

Figura 4-10. Eliminar Archivos

5. Hagaclic en Delete (Figura 4-10).

6. Hagaclic en Yesen d cuadro de didlogos de confirmacion de
eliminacion de archivos. PC-CDU borrara los archivos
seleccionados.

7. Hagaclic en Exit enlapantaladel File Manager
(Administrador de Archivos).

8. Continle con otras operaciones o hagaclic en File »
Disconnect y después en File » Exit para salir de PC-CDU.

4-16
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Verificacion de las Opciones del
Receptor

RECOMMENDACION

Para obtener una lista completa de opciones y sus
detalles, visite el sitio web de Topcon.

Usted puede verificar el estado de |as opciones de su receptor y
cargar un nuevo OAF, utilizando un cable RS232, una computadora
y un PC-CDU. Consulte el Manual del Usuario del PC-CDU para
obtener una descripcion mas completa del software del PC-CDU.

1. Conecte su receptor y computadora. Vea “ Conexion del
Receptor y una Computadora” en la pagina 2-12 para obtener
informacion sobre este procedimiento.

2. Hagaclic en Tools » Receiver Options (Figura4-11).

Initialize file system
Clear NYRAM
Reset receiver

Receiver options

Figura 4-11. Tools » Receiver Options

Apareceralapantalla de Options Manager (Figura4-12 en
la p4gina 4-18), la cual contiene la siguiente informacion:

» Nombre de la opcion — nombre/descripcién de laopcién
 Actual — €l estado actual delaopcién

» Adquirida—si laopcién ha sido adquiridao no

* Alquilada—si la opcion ha sido alquilada o no.

 Fecha de expiracion — lafechaen lague laopcion sera
deshabilitada, de ser aplicable

P/N 7010-0557-SP www.topconpositioning.com
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Debido a que las opciones pueden ser adquiridas y alquiladas,
e estado “Actua” delaopcién muestra el valor efectivo en ese
momento. L os valores de la opcion pueden ser:

e -10“-----" —laversion del firmware no soporta esta opcién
» 0—laopcidon del receptor se encuentra deshabilitada
 Entero positivo — la opcién se encuentra habilitada

* s 0 no—laopcién se encuentra habilitada o deshabilitada

ﬁ, Option Manager - IEI Iil
Option name Current | Purchased |  Leased | Exp. date ||
GPS yes yes no
GLOMASS yes yes no
L1 yes yes no
L2 yes yes no
Cinderella yes yes no
Position update rate [Hz] 20 20 1]

Fiaw data update rate [Hz] 20 20 1]
Code differential Baze yes yes no
Code differential Rover yes yes no
RTK Base yes yes no
RTK Rover [Hz] 20 20 1]
Memory [Mb] 7B 7B 1]
Co-0p Tracking yes yes no
1-PPS Timing Signal 2 2 1]
Ewvent Markers 2 2 1]
In-Band Int. Rejection 1 1 1]
Multipath Reduction yes yes no
Frequency [nput yes yes no
Freq. Lock and Output yes yes no
Serial Port A [Kbps] 460 460 1]
Serial Port B [Kbpsg] 460 460 1]
Serial Port C [Kbps] 460 460 1]
Serial Port D [Kbps] 460 460 1]
Infrared Part ho ho ho
Parallel Port e ho ho
Sp.Sp. Freq. Hop. no no no
Sp.Sp. Direct no no no
Falk yes yes no
[ratumsz support yes yes no
Magnetic azimuth yes yes no
Geoid height yes yes no —

‘Way Point Mavigation e yes no
WAKS yes yes yes 8/1/2001
OMMISTAR s yes no
RTCH Output 3 2 a
RTCH Input 2 2 a
ChA Dutput 1 1 1]

CA Input 1 2 1]
JPS Output 1 1] 1]
JPS Input 2 0 0 LI
Fiefrezh | Load | Stop | Exit |
| y
418 Figura 4-12. Administrador de Opciones (Option Manager)
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3. Cuando termine, hagaclic en Exit en la pantalla del
Administrador de Opcionesy después hagaclic en File »
Disconnect paraevitar conflictos con la gestion del puerto
serial.

Carga un OAF

L os distribuidores de Topcon Positioning System entregan archivos
OAF alos clientes. En caso tuviese alguna pregunta en relacion a
un OAF, envie un correo electronico aTPS
(options@topconps.com). Por favor, tenga a mano €l nimero de
identificacion de su receptor (vea“ Verificacion de la Version del
Firmware” en la pagina 4-25).

1. Paracargar un OAF nuevo, sigalos pasos unoy dos en
“Verificacion de las Opciones del Receptor” en la pagina4-17.

2. Hagaclicen Load en laparte inferior de la pantalla del
Administrador de Opciones (vea Figura4-12 en
lapagina4-18).

3. Busque e nuevo OAF (Archivo de Autorizacion de Opcion).
Los OAFstienen extensiones .jpo 0 .tpo y son Unicos para cada
receptor (Figura 4-13).

4. Seleccione @l archivo correcto y hagaclic en Open
(Figura4-13).

Select options file 2%

Lok in: I :__*fj Desktop

r-A My Documents
= My Computer
K= My Metwork Places

File name: 4 F20 08N 1415 Open
Filez of type: IJPS Options files j Cancel

Figura 4-13. Carga de un OAF

P/N 7010-0557-SP www.topconpositioning.com
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Se cargarala nueva opcién del receptor en el receptor y se
actualizaralatabla del Administrador de Opciones.

5. Al terminar, hagaclic en Exit en la pantalladel Administrador
de Opciones, después haga clic en File » Disconnect para
evitar conflictos con el puerto serial.

Gestion de la Memoria del Receptor

Al usar €l receptor en aplicaciones estéticas o dinamicas, es posible
gue necesite conocer el nivel de memoriague el archivo de registro
del receptor ocupa. Este tamario especifico de memoriadepende del
tipo de datos que estén siendo grabados. Utilice las siguientes
formulas para calcular el tamafio aproximado de los archivos de
registro del receptor. Estas ecuaciones se basan en el conjunto de
mensajes por defecto.

» SS— el tamafio estimado de una época de datos sin procesar en
el archivo de registro del receptor (expresado en bytes).

* N —¢l nimero de satélites observados por época.
Al registrar Unicamente datosen L1:
SS =183 +22*N
Al grabar datosenL1y L2:
SS=230+44*N

4-20
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Borrado de la NVRAM

LaMemoriade Acceso Aleatorio No Volatil (NVRAM) del
receptor conserva los datos requeridos para rastrear satélites, tales
como efemérides de datos y posicion del receptor. LaNVRAM
también mantiene las configuraciones actuales del receptor, como
informacién de la antena activa, méascaras de el evacion e intervalo
de registro, e informacion sobre el sistema de archivos internos del
receptor.

AUn cuando borrar laNVRAM no es constituye una operacion
comun (ni tampoco se recomienda), algunas veces al borrar la
NVRAM es posible eliminar problemas de comunicacion o rastreo.
Borrar laNVRAM en su receptor es equivalente a“ arranque suave’
en su computadora.

Después de borrar laNVRAM, su receptor requeriraalgo de tiempo
para colectar nuevos efemérides y almanagues (aproximadamente
15 minutos).

Al borrar laNVRAM de su receptor no eliminar& ninglin archivo
gue se encuentre guardado en la memoria de su HiPer Lite. Sin
embargo, su receptor volvera atener |os val ores establecidos en
fébrica.

Ademés, laNVRAM mantiene lainformacion sobre € sistema de
archivos del receptor. Tenga presente que después de borrar la
NVRAM, el LED de ESTADO del receptor parpadeara naranja
durante algunos segundosindicando que el receptor estd analizando
y verificando el sistemade archivos. Las versiones 2.2pl del
firmware o superiores mantienen el moédem de espectro amplio
encendido después de borrar laNVRAM.

Uso de la MINTER para Borrar la NVRAM

1. Presionelateclade encendido para apagar € receptor.
2. Presioney mantenga presionada lateclade funcién (FN).

3. Presioney mantenga presionada latecla de encendido
durante aproximadamente un segundo. Deje de presionar la

P/N 7010-0557-SP www.topconpositioning.com
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tecla de encendido y siga presionando latecla de funcién
(FN).

Espere hasta que los LEDS de ESTADO y REGISTRO
estén verdes.

Espere hasta que los LEDs de ESTADO y REGISTRO
parpadeen naranja.

Suelte latecla de funcién (FN) mientras que los LEDS de
ESTADO y REGISTRO parpadean naranja.

Uso del PC-CDU para Borrar la NVRAM

1

Conecte su receptor y computadora. Vea “ Conexién del
Receptor y una Computadora’ en lapagina 2-12 para
obtener informacién sobre este procedi miento.

Hagaclic en Tools » Clear NVRAM (Figura4-14). El
LED de REGISTRO parpadea verde y rojo mientras que el
LED de ESTADO parpadea rojo.

Tools

Initialize file system

Reset receiver

Receiver options

Figura 4-14. Tools » Clear NVRAM

El receptor automati camente se desconecta una vez borradala
NVRAM.

Topcon
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Cambio de los Modos del Receptor

Cambio de los Modos del Receptor

El HiPer Lite presenta cuatro modos, dos modos de informacion y
dos modos de energia:

e Modo Normal

» Modo de Informacion Extendida
* Modo Sleep

» Modo Energia Cero

Vea “Modos de Informacion” en la pagina 4-9 para obtener una
descripcion del Modo de Informacion Normal y del Modo de
Informacion Extendida.

Modo Sleep (En Espera)

En el modo sleep, el tablero de energiay el médulo Bluetooth
continuarédn consumiendo energia de las baterias, debido alo
cual, alalarga, las baterias se descargarén. Para evitarlo,
coloque el receptor en e modo de Energia Cero (vea“Modo
Energia Cero” en la pagina 4-24). Siga estos pasos para poner
el receptor en el modo sleep.

1. Enciendad receptor.

2. Presioney mantenga presionadalatecla de encendido del
receptor durante mas de cuatro y menos de ocho segundos.

3. Dejede presionar lateclade encendido cuando los LEDs
tanto de REGISTRO como de ESTADO estén naranja. El
receptor entraen el Modo Sleep.

4. Cuaquier actividad en el puerto RS232 hard que el receptor
se encienda.

@ AVISO

Si presiona y mantiene presionada la tecla de encendido
durante mas de 14 segundos, no ocurrira cambio
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Operacion

alguno. Esto protege al receptor en caso de teclas
trabadas.

Modo Energia Cero

Si su receptor se encuentra apagado, o incluso en el Modo
Sleep,  tablero de energia continuara consumiendo energia de
las baterias. Esto significa que si carga total mente su receptor,
lo apagay |o guarda, el receptor consumiralaenergiadela
bateria en menos de dos meses. Para evitar que el tablero de
energia consuma las baterias, ponga €l receptor en el Modo
Energia Cero.

1. Enciendasu receptor.

2. Presioney mantenga presionadalatecla de encendido
durante 8 segundos, pero por menos de 14 segundos.

3. Degjede presionar latecla de encendido cuando ambos
LEDs estén rojos. Cuando se apaguen los LEDS, su
receptor estard en e Modo Energia Cero.

4. Presione lateclade Reseteo durante un segundo para
regresar a modo Normal.

@ AVISO

Cuando las baterias internas se hayan descargado
completamente y no se haya conectado energia externa,
el receptor ira automaticamente al Modo Energia Cero
para evitar que las baterias continden descargandose.

4-24
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Verificacion de la Version del Firmware

Verificacion de la Version del
Firmware

Use el PC-CDU paraverificar laversion del firmware de su
receptor.

@ AVISO

El receptor debe cargarse con la version 2.3p2 o mas
reciente de firmware para el HiPer Lite y 2.303 0 mas
reciente para el HiPer Lite+.

b PRECAUCION

No utilice versiones de firmware 2.3p1 o anteriores
para el HiPer Lite o 2.3p2 o anteriores para el HiPer
Lite+.

1. Conecte € receptor y una computadora. Vea “ Conexién del
Receptor y una Computadora” en la pagina 2-12 para obtener
informacion con respecto a este procedimiento. Hagaclic en
Help » About (Figura4-15).

Help

Figura 4-15. Help » About

Se abre el cuadro de did ogo About PC-CDU (Figura4-16 enla
pagina 4-26).

El cuadro de didlogo About PC-CDU muestrainformacion
importante con respecto a los accesorios del hardwarey alas
propiedades del software. Estalistaincluye la siguiente
informacion (que usted debera tener amano si se contacta con
TPS 0 con su proveedor):

* Modelo de receptor

e 4-25
* ldentificacion del receptor
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* Version de firmware

[ About PC-CDU x|

PC-COU for ‘Windows 95/98/ME/MNT/2000/P
Version 2.1.12 M5 [Built: June 25, 2003] g
Expiration Date : Mewver Expires [ Authorized |
Copyright € Topcon Pogitioning Systems , 2000 - 2003 PC-cDLU
http: /dva topconaps. com

Feceiver model:
Feceiver ID:
Firrmware wersion:
RTE support:
Mainboard wersion:
FAM size:

Fower Board:
Fower supply (v):
Antenna input:

Ext. Ant. DC status:

HIFEF_LITE
BPZXISKZ908

2.3 Aug,01,2003 p2
WES

HE_GDL_3
1024KE

=4, fuy=34

0.0

int

off

]

Savetofilel Fepart | Fiefrezh | QK |

Figura 4-16. About PC-CDU

2. Al terminar, haga clic en OK, después hagaclicen File »
Disconnect para evitar conflictos con la gestion del puerto
serial.

Carga de un Firmware Nuevo

L os receptores Base y Rover deben ser cargados con la misma
version de firmware. Utilice la version de firmware mas reciente
(puede descargarla en €l sitio web de TPS), asi se asegurara que su
receptor tenga acceso a las actualizaciones mas recientes.

Latarjetadel receptor y € tablero de energia deben cargarse con el
firmware del mismo paguete. El firmware del médulo Bluetooth es
independiente de latarjeta del receptor y del tablero de energiay
tiene un paguete de firmware diferente.

El receptor FLoader, un utilitario basado en Windows®, para cargar
d firmware en los tableros del receptor y de energia. Usted puede
descargar FLoader a su computadoraen € sitio web de TPS. Para
obtener més informacioén, consulte e Manual del Usuario del
FLoader, también disponible en el sitio web de TPS.
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Carga de un Firmware Nuevo

1. Descargue einstale FLoader, en caso de ser aplicable.
2. Descargue € paguete de firmware nuevo a su computadora.

3. Conecte su receptor y computadora. Vea “ Conexion del
Receptor y una Computadora” en la pagina 2-12 para obtener
informacion sobre este procedimiento.

4, Active e FLoader (Figura4-17).

TPS Firmware Loader: Device = Receiver i =l

File Options Help

Cannection | Device | Program |

Connection Type: Serial Cable

Connection Setting:

PLC Part: IEDM‘I 'l ‘wiord Length: IS 'l
Baud rate: |1152DD 'l Parity: INone 'l
Handzhaking: INone 'l Stop Bits: I‘I 'l

|25 il 200z [16:08.11

Figura 4-17. Pantalla Principal del FLoader

5. Enlapestafia Connection, seleccione el puerto de
comunicacion en su computadora que se conecta con su
receptor y seleccione su velocidad (por |o general, 115200)
(Figura4-17).

Revise | as siguientes secciones para cargar € firmware apropiado.

Receptor y Firmware del Tablero de
Energia

El firmware del receptor y del tablero de energia viene como un
archivo comprimido que usted descargay descomprime. Este
archivo contiene los siguientes tres archivos:

« ramimage.ldr — el archivo RMA de |latarjeta del receptor
* main.ldp — €l archivo Flash de la tarjeta del receptor 4-27
» powbrd.ldr — el archivo RAM del tablero de energia
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@ AVISO

Usted debe cargar los tres archivos al cargar su
firmware nuevo. Estos archivos deben venir en el mismo
paquete de firmware.

1. En FLoader, seleccione la pestafia Device y defina el
Device Type (Tipo de Dispositivo) como (Figura 4-18).

& 1PS Fimware Loader: Device = Receiver [_[C]
File Options Help
Connection  Device | F'ruglaml
Device Type: Receiver 'I
Dievice Information
hodel
10:
Firmware:
Hardware
FAM Size, KB
Tashfiom Jauics Save tofile Cancel |
|31 Mar 2003 [17:53.44

Figura 4-18. Definir Device Type

2. Hagaclic en Get from Device para obtener informacion
con respecto al dispositivo (Figura 4-18).

4-28
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3. SeleccionelapestaiaProgram y definael Capture Method
(Método de Capture) a Soft Break Capture (Captura de
Interrupcion Suave) (recomendado) (Figura4-19).

TPS Firmware Loader: Device = Receiver
File Optionz Help

Carga de un Firmware Nuevo

Connection | Device FIUQHml

Capture Method: | Soft Break Capture 'I

=
Firmnwar

@ P file: IE %.Shod_2_3p3vamimage. ldr

j Browse B

@ Flash file: |E ... Firmware and loadershgd|_2_3p3imain.ldp

LCancel I

j Browse F

|Ready

|31 Mar 2003 [17:54.54

Figura 4-19. Pestafia Program

4. Busquey seleccione € archivo RAM y el archivo Flash del

tablero del receptor (Figura 4-19).

5. Hagaclic en Load y espere hasta que el 100% de los

archivos hayan sido cargados en el receptor.

@ AVISO

Si selecciond un RAM o archivo Flash incorrecto, vera un
mensaje de error en el extremo inferior del cuadro de

dialogo. Seleccione el archivo correcto.

P/N 7010-0557-SP
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6. Seleccione la pestafia Device (Dispositivo) y defina el
Device Type (Tipo de Dispositivo) como Receiver’s Power
Board (Tarjeta de Energia del Receptor) (Figura 4-20).

ETPS Firmware Loader: Device = Receiver's Power Board [_[C]
File Options Help

Connection  Device | F'ruglaml
Device Type: Receiver's Power Board 'I
Dievice Information
Firmware
Hardware
Tk bron Deuics Save tofile Cancel |
|Ready |31 Mar 2003 [17:55.40

Figura 4-20. Definir Tipo de Dispositivo

7. Hagaclic en Get from Device para obtener informacion
con respecto al dispositivo (Figura 4-20).

8. Seleccione lapestaria Program y definael Capture Method
(Método de Captura) a Soft Break Capture (Captura de
Interrupcion Suave) (recomendado) (Figura 4-21).

B3 TPS Firmware Loader: Device = Receiver's Power Board O] x|
File Options Help

Connection | Device  Pragiam I

Capture kethod. ISDII Break Capture i
TIEIE

1 RAM fle: [E*\Fimware snd losderthgd_2_3p3hpowbrd e =] Browse B

-
Firr

LCancel

[ [31 Mar 2003 [17-56.41

Figura 4-21. Valores de la Pestafia Program

9. Busquey seleccione € archivo ram del tablero de Energia
(Figura 4-21).

4-30
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Carga de un Firmware Nuevo

10. Hagaclic en Load y espere hasta que el 100% de los
archivos del tablero de energia hayan sido cargados en su
receptor.

@ AVISO

Si selecciond un archivo RAM incorrecto, vera un
mensaje en el extremo inferior del cuadro de didlogo.
Seleccione el archivo correcto.

11. Hagaclic en File » Exit.

12. BorrelaNVRAM del receptor (vea“Borrado de la
NVRAM” enlapégina4-21) y actualice el almanaque (vea
“Coleccion de Almanagues’ en la pagina 2-47) después de
cargar un firmware nuevo.

Firmware del Médulo Bluetooth

El firmware del médulo Bluetooth viene como un archivo
comprimido que usted descargay descomprime. Este archivo
contiene dos archivos;

« btloader.ldr — &l archivo RAM del médul o Bluetooth
 btmain.ldp — €l archivo Flash del médulo Bluetooth

@ AVISO

Usted debe cargar ambos archivos al cargar el firmware
nuevo. Estos archivos deben venir en el mismo paquete
de firmware.

4-31
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1. En FLoader, seleccione la pestafia Device (Dispositivo) y
defina el Device Type (Tipo de Receptor) como Receiver
(Figura4-22).

ETPS Firmware Loader: Device = Receiver =10] =]
File Options Help

Connhection  Diewice | Prnglaml

Device Type: lm
Device Infarmation

Modlel: HIFER

1D: B0AWOGIFVGG
Firrnware: 2.3 5ep.20.2002 b3
Hardware HE_GD_1

RAM Size. KB 1024

Get from Devicel G ave to fie. LCancel |

{
[Ready [05 Dec 2002 [12:4852

Figura 4-22. Obtener Informacién sobre el Tipo de Dispositivo
2. Hagaclic en Get from Device para obtener informacion
con respecto al dispositivo (Figura4-22).
3. Seleccione lapestaria Program y definael Capture Method

(Método de Captura) como Soft Break Capture (Capturade
Interrupcion Suave) (recomendado) (Figura 4-23).

TPS Firmware Loader: Device = Receiver _ o] ]
Fil= Options Help

Eonnectionl Device Program I

Capture Method: ISDII Break Capture hi

-
Firrn

al

5 FIAM file: [E..\bt_hgd 01 3\btioader ldr | Browse ﬁ|
% Flash fil: [E..\Fimware and loadei\bi_hgdl M3bimaintde =] Browse E|

LCancel

| [19Dec 2003 [15:22.43

Figura 4-23. Valores de la Pestafia Program

4. Busquey seleccione el archivo RAM vy el archivo Flash del
maodul o Bluetooth (Figura 4-23).

4-32
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Carga de un Firmware Nuevo

5. Hagaclic en Load y espere hasta que €l 100% de los
archivos hayan sido cargados en su receptor (Figura 4-24).

TPS Firmware Loader: Device = Receiver

File Options Help

Connection | Device Plograml

Capture Method: |Soft Break Capture 'I

=
Fir

N aTE:

5 RAM file: |E % bt_hgdl_01 3\ btoader ldr x| BrowseR
 Flash file: [E...\Firmwvate and loaderbt_hgd_013btmainlde = Browss E
Cancel I
100%
|Loading completed |19 Dec 2003 [15:28.33

Figura 4-24. Carga Completa del Firmware del Médulo Bluetooth

@ AVISO

Si selecciondé un archivo RAM incorrecto, vera un
mensaje en el extremo inferior del cuadro de dialogo.
Seleccione el archivo correcto.

6. Hagaclic en File » Exit.

4-33
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Notas:
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Capitulo 5

eteccion y Solucion
de Fallas

Si sigue las instrucciones de mantenimiento y seguridad
proporcionadas en el presente manual, tendra, por lo general, pocos
problemas con su receptor. Este capitulo |o ayudaraadiagnosticar y
solucionar algunos problemas comunes que pudieran presentarse al
operar su receptor.

Si necesita ayuda con problemas técnicos, vea “ Cémo Obtener
Soporte Técnico” en lapagina 5-17

Antes de comunicarse con € Servicio de Soporte a Cliente de TPS
por cualquier problema con el receptor, intente lo siguiente:

» Vuelvaaconfigurar el receptor utilizando PC-CDU (hagaclic
en Tools » Reset receiver).

* Restablezcalas configuraciones por defecto de fabrica
utilizando PC-CDU (haga clic sobre Configuration »
Receiver, luego en Set all parametersto defaults).

* BorrelaNVRAM (vea“Borrado delaNVRAM” en la
pagina4-21).

« Inicialice el sistemade archivo (hagaclic en Tools » I nitialize
file system; al hacerlo eliminaré todos los archivos dentro del
receptor).

ADVERTENCIA

No trate de reparar el equipo usted mismo. Al hacerlo
invalidara su garantia y podria daiar el hardware.
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Deteccién y Solucién de Fallas

Problemas de Energia

Todos los receptores se preconfiguran en fabrica en “Modo
Automético”, tanto parala energia como para el cargador. Si desea
verificar estas configuraciones,

1. Conecte su receptor y su computadoray ejecute el PC-CDU
(vea“Conexion del Receptor y una Computadora’ en la
pagina 2-12).

2. Unavez conectados, haga clic en Configuration » Receiver.

3. Enlapestaiia General, visualice los campos de Energiay del
Cargador. Estos campos deben estar configurados en el Modo
Automatico. En caso contrario, cdmbielosaAutoy hagaclic en

Apply.

\
RECOMMENDACION

Al borrar la NVRAM hara que el receptor regrese al
Modo Automatico (vea “Borrado de la NVRAM” en la
pagina 4-21).

Problema

El receptor no se enciende.
Causas Soluciones

El receptor puede estar | Presione lateclade I nicializacion.
en e Modo Energia

Cero.

Si no se utilizauna Conecte unafuente externa de energia

fuente externade totalmente cargada e intente de nuevo.

energia, es posible que | Vea“Alimentacién del Receptor” en la
las baterias se pagina 2-2.

descarguen.
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Problemas de Receptor

El receptor tieneuna | Cargue las baterias durante la noche. Vea

fuente externa de “Alimentacion del Receptor” en la
energia, pero las pagina 2-2.

baterias internas estan

descargadas.

El receptor puedetener | Si después de cargar sus bateriasinternas
un cargador defectuoso |todalanoche, alin no es posible encender
0 bateriasinternas €l receptor, comunigquese con el Servicio
defectuosas. de Soporte al Cliente TPS.

Problemas de Receptor

L os siguientes son algunos de | os problemas mas comunes que
puede presentar el receptor.

Problema

El receptor no puede establecer una conexién con una
computadora o con un controlador externo.

Causas Soluciones

El cable no esta4  Verifique que el conector del cable se
enchufado encuentre conectado al puerto serial
correctamente. correcto.

» Desenchufe el cable, luego vuelvaa
conectarlo correctamente al receptor.

* Vea*“Componentes Externos’ en
la pgina 1-15 y “Especificaciones del
Conector” en lapaginaA-11 para
obtener informacién sobre los
conectores del receptor.

El cable estadafiado. | Utilice un cable en buen estado. Péngase
en contacto con su Proveedor para

cambiar € cable.
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Deteccién y Solucién de Fallas

El puerto del receptor |1. Conecte su receptor y una

utilizado parala computadora utilizando un puerto
conexion no estd en el libre (vea“ Conexion del Receptor y
modo Comando. una Computadora” en la pagina 2-

12) einicieel PC-CDU.
2. Hagaclic en Configuration »
Receiver » Ports.

3. CambielaEntrada parael puerto
seria utilizado parala conexion a
Comando.

Problema

El receptor no captura los satélites durante un largo periodo de
tiempo.

Causas Soluciones

El receptor amacena |+ Actuaizar el almanague.

un almanaque antiguo. |« \/ea“Coleccion de Almanaques’ en
lapagina 2-47.

Problema

El receptor también rastrea algunos satélites.

Causas Soluciones

El valor delaméscara |* Disminuyalamascara de elevacion.
de elevacion es » Vealapégina 2-28 para obtener
demasiado alto (por informacién sobre |a configuracion de

ejemplo, porencimade | |3 mascara de elevacion.
15 grados).
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Problemas de Receptor

El levantamiento se
redizacercade
obstécul os (copa de
arboles, edificios altos,
etc.).

* Verifique quelas casillas de Reduccion
Multipath estén habilitadas.

1. Conecte su receptor y una
computadoraeinicie el PC-
CDU. Vea“Conexion del
Receptor y unaComputadora’ en
lapagina 2-12.

2. Hagaclic en Configuration

» Advanced » Multipath
Reduction y habilite las dos
casillas.

» Ubique un &realibre de obstécul os, en
caso de ser posible.

Problema

El receptor no puede obtener el Cédigo Diferencial y/o las

soluciones RTK.

Causas Soluciones
Seingresaron Especifique las coordenadas correctas
coordenadas paralaestacion Base utilizando PC-CDU

incorrectas en laBase

u otro software de coleccién de datos de
campo apropiado.

El receptor no hasido
configurado como
Base 0 como Rover

» Si € receptor debe funcionar como
Base, aseglrese que haya sido
configurado correctamente. Para
mayor informacion, vea
“Levantamiento con el Receptor” enla
pagina 3-6.

* Si el receptor debe funcionar como
Rover, aseglrese que haya sido
configurado correctamente. Para
mayor informacion, vea
“Levantamiento con el Receptor” enla
pagina 3-6.
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Deteccién y Solucién de Fallas

Las opciones
correspondientes del
receptor pueden estar
desactivadas o haber
expirado.

» Vea“Verificacion de las Opciones del
Receptor” en lapégina4-17 para
obtener detalles sobre cémo verificar
las opciones actuales.

 Habilite o prolongue lavalidez de las
opciones correspondientes del receptor
ordenando un OAF nuevo con las
opciones deseadas activadas.

No hay suficientes
satélites comunes. Para
obtener una solucién
fija, Basey Rover
deberéan rastrear por los
menos cinco satélites
Ccomunes.

Asegurese gque los receptores tanto
como Rover como Base utilizan €
mismo almanague actualizado. Vea
“Coleccion de Almanagues” en la
pagina 2-47.

* Verifique que las méscaras de
elevacion de los receptores Rover y
Base; deben ser lasmismas. Veala
pagina 2-28 para obtener informacion
sobre la configuracion de la méascara
de elevacion.

Geometria satelital

Lleve acabo €l |evantamiento cuando los

elevacion esta por
encimadelos 15
grados.

deficiente (los valores | valores PDOP sean bajos.
PDOP/GDOP son

demasiado altos).

Laméscarade  Disminuyalamascarade elevacion.

» Vealapégina 2-28 para obtener
informacion sobre la configuracién de
lamascara de elevacion.

Laconexion del |
receptor y de laantena
es deficiente.

» Aseglrese que €l cable se encuentreen
buenas condiciones.

* Verifique el accesorio del conector del
cable para €l receptor. Retirey cologue
nuevamente el conector del cable para
garantizar una conexion segura.
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Problemas de Receptor

Los médems Basey
Rover estan
configurados paralos
diferentesradio
canales.

» Configure los receptores Base y Rover
parael mismo radio canal.

* Vea“Configuracion del Radio” en
la pagina 2-33.

Existe una
discrepanciaentre los
estdndares
diferenciales utilizados
en los receptores Base
y Rover.

Asegurese que los receptores Base y
Rover utilicen el mismo formato de
correcciones de entrada/salida:

1. Conecte su receptor y una
computadoraeinicie el PC-CDU.
Vea“ Conexion del Receptor y una
Computadora’ en la pagina 2-12.

2. Hagaclic en Configuration »
Receiver » Portsy configure el
mismo formato de entrada/salida
para ambos receptores.

Lavelocidad especifica
deenlaceno es
compatible con las
velocidades de enlace
gue el médem soporta.

Lavelocidad de enlace
eslavelocidad enla
gue se transmiten los
datos sobre € enlace
de RF.

e Cambielavelocidad de enlace por la
velocidad que su médem soporta. Vea
e manua del médem para obtener
informacion sobre la velocidad de
enlace soportada.

Vea“ Configuracion del Radio” en

la pagina 2-33 para verificar la
velocidad actual de enlacey cambiar la
velocidad de enlace.
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Deteccién y Solucién de Fallas

Lavelocidad especifica
de transferenciaen
baudios no es
compatible con las
velocidades en baudios
soportadas por €
moédem.

Lavelocidad de
transferenciaen
baudios eslavelocidad
con laque € receptor
transmite los mensagjes
diferencialesal modem
y viceversa.

» Cambie lavelocidad en baudios por 1a
velocidad que su médem soporta. Vea
€l manua del médem para obtener
informacion la velocidad en baudios
soportada.

» Vea*“Configuracion del Radio” en
la p4gina 2-33 para verificar la
velocidad actual en baudiosy cambiar
la misma.

Labateria del médem
estdbgja

 Conecte unafuente externa de energia
al receptor. Vea“Baterias Externas’ en
lapagina 2-3.

» Vea“Alimentacion del Receptor” enla
pagina 2-2.

Ladistanciaentre Base
y Rover es demasiado
grande.

» Acorteladistancia entre Base y Rover.

« Ultilice repetidoras para aumentar la
cobertura del radio.

Problema

El receptor no inicia el registro de datos.

Causas

Soluciones

El receptor no tiene
espacio libre paralos
archivos.

» Descargue los archivos del receptor a
una computadora (en caso de ser
necesario) y borre los archivos (vea
“Descarga de archivos a una
Computadora’ enlapagina4-11y
“Eliminacion de Archivos’ en la
pagina 4-15).
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Problemas con Bluetooth

» Utilicelacaracteristica AFRM. Vea
“Parametros del Modo Automético de
Rotacion de Archivos (AFRM)” en la
pagina 2-29.

El receptor yaha
registrado 512 archivos
en lamemoriainterna.

Borre los archivos innecesarios (vea
“Eliminacion de Archivos’ enla
pagina 4-15).

» Utilicelacaracteristica AFRM. Vea
“Parametros del Modo Automéatico de
Rotacion de Archivos (AFRM)” en la
pagina 2-29.

Problemas con Bluetooth

L os siguientes son algunos de |os mensajes de error mas frecuentes.
BTCONF reportalos mensajes de error en la barra de estado.

MensajedeError

No puede encontrar a receptor.

Causas Soluciones

El receptor esta4 AsegUrese que €l receptor esté cargado y
apagado. se encuentre encendido.

Si utilizaun cable, los
conectoresdel cableno
han sido conectados
correctamente.

* Verifique que e conector del cable se
encuentre conectado al puerto serial
correcto.

» Desenchufe e cable, luego vuelvaa
conectarlo correctamente a receptor.

Si utilizaun cable, éste
se encuentra dafiado.

» Utilice un cable en buen estado.

» Comuniquese con su Proveedor para
adquirir un cable nuevo.

P/N 7010-0557-SP
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Deteccién y Solucién de Fallas

El puerto COM a que
esta conectado el
receptor es diferente a
seleccionado en
BTCONF.

Aseglrese que el cable RS232 esté
conectado al Puerto COM especificado
en lalista despegable del puerto de
comunicacion BTCONF. Vea
“Configuracion del M6dulo Bluetooth”
en la pagina 2-41 para obtener mayores
detalles.

El puerto del receptor
utilizado parala
conexion no estaen €
modo Comando.

1. Conecte su receptor y una
computadora utilizando un puerto
libre (vea“ Conexion del Receptor y
una Computadora” en la pagina 2-
12) einicie el PC-CDU.

2. Hagaclic en Configuration »
Receiver » Ports.

3. CambielaEntradapara€l puerto

seria utilizado paralaconexion a
Comando.

L as configuraciones

* Lasconfiguraciones para el Puerto B

parael Puerto B son: 115200 tasa en baudios, 8 bits de
pueden haber datos, 1 bit de parada, sin paridad y sin
cambiado. negociacion.
* Intente habilitar lanegociacién RTS
CTS parael Puerto B. No cambie las
demés configuraciones.
Las opciones » Vea*“Verificacion de las Opciones del

correspondientes del
receptor pueden estar
desactivadas o haber
expirado.

Receptor” en lapagina4-17 para
obtener detalles sobre como verificar
las opciones actuales.

 Habilite las opciones correspondientes
del receptor. Péngase en contacto con
su proveedor paraordenar un OAF con
las opciones que desee para su
receptor.

Topcon
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Problemas con Bluetooth

MensajedeError

No es posible encontrar € Bluetooth.

Causas Soluciones

El Slot 3 del receptor | 1. Conecte su receptor y una

Se encuentra computadora utilizando un cable
desactivado. RS232 (vea “ Establecimiento de una

Conexién con una Cable RS232” en
la pagina 2-14).

Haga clic en Configuration »
Receiver » General.

En € &reade Activar/Desactivar
Slots habilite la casillade
verificacion del Slot 3 (B).

El mddulo Bluetooth
se encuentravinculado
aotro dispositivo.

Cierre laconexion con el dispositivo,
luego conéctelo a su receptor.

El procesador del
maodulo Bluetooth se
encuentra
sobrecargado.

Coloque su receptor en el Modo
Energia Cero. Vea“Modo Energia
Cero” enlapégina4-24 para obtener
mayores detalles.

Presione y mantenga presionada la
tecla Reseteo durante
aproximadamente un segundo para
que €l receptor vuelvaa modo
normal.

Vuelva a conectarse a médulo
Bluetooth.

El receptor no tiene un
maodulo Bluetooth.

Comuniquese con su proveedor para
adquirir un receptor con Bluetooth
habilitado.

P/N 7010-0557-SP
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Deteccién y Solucién de Fallas

MensajedeError
No es posible abrir €l Puerto COM#: Acceso denegado
Causas Soluciones

Es posible que otra » Cierrelaaplicacién, intente la
aplicacién seencuentre |  conexion.

utilizando el puerto de |« Conecte e receptor utilizando otro

lacomputadora puerto de |a computadora que no esté
dedicado alaconexion.| en yso.

Problema

Después de buscar dispositivos disponibles, no encuentra ninguno.

Causas Soluciones

El receptor no esta4 « Verifique que el receptor esté

recibiendo energia. recibiendo energiay se encuentre
encendido

* Verifique que el cable de alimentacion
se encuentre conectado al puerto seria
correcto.

» Desenchufe el cable, luego vuelvaa
conectarlo correctamente al receptor.

» Si € cablede alimentacion se
encuentra dafiado, comunigquese con su
Proveedor para adquirir un cable
nuevo.

912
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Problemas con Bluetooth

El Slot 3 del receptor |1. Conecte su receptor y una

se encuentra computadora utilizando un cable

desactivado. RS232 (vea“ Establecimiento de una
Conexion con una Cable RS232” en
lapagina 2-14).

2. Hagaclic en Configuration »
Receiver » General.

3. En € areade Activar/Desactivar

Slots habilite lacasillade
verificacion del Slot 3 (B).

Los dispositivos * Verifique que sus dispositivos se
pueden estar fuera del encuentren dentro del alcance
alcance aceptable del aceptable del radio.

radio. + Coloque los dispositivos dentro del
alcance de radio.

Problema

Puede ver €l icono del madulo Bluetooth del receptor en la
pantalla de la computadora, pero no puede conectarse.

Causas Soluciones

Lasconfiguracionesde |» Asegurese que sus dispositivos
seguridad del habilitados en Bluetooth utilicen las
dispositivo mismas configuraciones de seguridad.
probablemente sean |« \ea “ Configuracion del Médulo
diferentes. Bluetooth” en la pagina 2-41,

especificamente laFigura2-35enla
pagina 2-45 para obtener mayores
detalles sobre cOmo cambiar las
configuraciones de seguridad.

913
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Deteccién y Solucién de Fallas

Lasconfiguraciones |1. Si cambialas configuraciones desu

del médulo Bluetooth modul o Bluetooth, eliminelo de la
pueden haber lista de los dispositivos Bluetooth
cambiado. encontrados con € programa

administrador Bluetooth
(suministrado con e dispositivo
utilizado para administrar el
receptor).

2. Repitalablsqueda

Problemas con el Radio Modem

L os siguientes son algunos de |os problemas mas comunes que
puede presentar el radio médem de espectro amplio.

Problema
El LED del MODEM parpadearojo.
Causas Soluciones

Sehadetectadouna |+ Verifiquelaantenadel radio médem no
fala se encuentre dafiada. Péngase en
contacto con su Distribuidor para
cambiar la antena.

 Verifique que laantenadel radio
mabdem se encuentre firmemente
aseguraday correctamente conectada
al conector de laantenaen € radomo.

» Algjalaantena/receptor de objetos
conductores (objetos metalicos
grandes, por ejempl o).

914
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Problemas con el Radio M6dem

Problema

El Médem TPS muestra €l siguiente mensaje de error:

“Can’t find receiver.” (“No puede encontrar a receptor”.)

Causas Soluciones
El receptor esta Verifique que el receptor esté recibiendo
apagado. energiay esté encendido

El puerto del receptor
utilizado parala
conexion no estaen €
modo Comando.

Reestablezca el modo Comando paraeste
puerto.

1. Conecte su receptor y una
computadora utilizando un puerto
libre, como e puerto D, por ejemplo
(vea“ Conexion del Receptor y una
Computadora’ en lapéagina2-12) e
inicieel PC-CDU.

2. Hagaclic en Configuration »
Receiver » Ports.

3. CambielaEntrada parael puerto
seria utilizado paralaconexion a
Comando.

El puerto dela
computadora que ha
seleccionado parala
conexion no es el
mismo que especifico
en el control del Puerto
Seria C.

Verifique que su receptor se encuentre
conectado asu PC usando el cable RS232
adecuado paralaconexion aunaPCy
asegurese de enchufar correctamente el
cable en e mismo puerto serial delaPC
gue especifico en lalista desplegable de
configuracion del Puerto en €l software
del Médem TPS.

El cable esta dariado.

« Utilice un cable en buen estado.

* Podngase en contacto con su
Distribuidor para cambiar el cable.

P/N 7010-0557-SP
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Deteccién y Solucién de Fallas

Problema
El Médem TPS muestra € siguiente mensaje de error:

“Can’'t find modem.” (“No puede encontrar al médemr” )

Causas Soluciones

Ningln radio médem | PGngase en contacto con su Proveedor
hasido instalado en su | para obtener un radio médem de amplio

receptor. espectro para su receptor.

Se hainstalado un tipo | Péngase en contacto con su Proveedor
de radio médem para obtener €l radio médem de amplio
desconocido. espectro correcto para su receptor.
Problema

El Médem TPS muestra € siguiente mensaje de error:

“Open COM# port failed: Accessisdenied.” (“No esposible abrir
el Puerto COM#: Acceso denegado.”)

Causas Soluciones

Es posible que otra » Cierrelaaplicacion eintente la
aplicacién seencuentre |  conexion.

utilizando el puerto de |« Conecte e receptor utilizando otro

lacomputadora puerto de |a computadora que no esté
dedicado alaconexion.| en yso.

9-16
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Coémo Obtener Soporte Técnico

Como Obtener Soporte Técnico

Si los consgjos de deteccion y solucion de fallas que se ofrecen en
este Manual de Instrucciones no resuelven el problema, contactese
con el Departamento de Soporte al Cliente TPS.

Antes de comunicarse con €l Departamento de Soporte al Clientede
TPS por cualquier problema con €l receptor, intente lo siguiente:

» Reinicialize €l receptor utilizando PC-CDU (hagaclic en

Tools » Reset receiver).

 Restablezcalas configuraciones por defecto de fabrica
utilizando PC-CDU (haga clic sobre Configuration »
Receiver, luego en Set all parametersto defaults).

* BorrelaNVRAM (vea“Borrar laNVRAM” en lapégina4-19).

« Iniciadlice el sistemade archivo (hagaclic en Tools » I nitialize
file system; al hacerlo eliminar& todos los archivos dentro del

receptor).

Teléfono

Para ponerse en contacto con el Departamento de Soporte a
Clientede TPS, llame a 1-866-4TOPCON (1-866-486-7266).

Correo Electréonico

Para contactarse con e Departamento de Soporte a Cliente,
utilice las siguientes direcciones electrénicas.

Tabla 5-1. Correos Electronicos del Departamento de Departamento Técnico

Para Preguntas Relacionadas Con... Comuniquese con...
Hardware (receptores, antenas, firmware) | hardware@topcon.com
GPS+y 3DMC psg@topcon.com
OAF options@topcon.com
RTK rtk@topcon.com
Pinnacle pinnacle@topcon.com
PC-CDU pccdu@topcon.com

P/N 7010-0557-SP
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Deteccién y Solucién de Fallas

Tabla 5-1. Correos Electronicos del Departamento de Departamento Técnico

Para Preguntas Relacionadas Con... Comuniquese con...

FieldFacey OfficeFace face@topcon.com

Si tiene dudas respecto a qué direccion de correo electrénico
debe escribir sobre un problema en particular, por favor envie
Su pregunta a support@topcon.com

Sitio Web

El sitio web de Topcon Positioning Systems ofrece informacion
actualizada sobre la linea de productos de Topcon. El areade
soporte del sitio web ofrece acceso a preguntas més frecuentes,
procedimientos de configuracion, manuales, soporte via correo
electrdnico, etc.

Paraingresar ala paginaweb de TPS, digite:
Www.topconpasitioning.com

Paravisitar €l éreade soporte, digite:
www.topcongps.com/support/

Topcon Manual de Operaciones del HiPer Lite y del HiPer Lite+




Apéndice A

specificaciones

Este producto de TPS es un receptor GPS de 20 canales con un
radio interno de espectro amplio, un médulo con latecnologia
inaldmbrica Bluetooth y una carcasa de aluminio resistente.
Asimismo, incluye laMINTER y conectores para cables.

Especificaciones del Receptor

La Tabla A-1 enumeran los componentes del receptor.

Tabla A-1. Especificaciones del Receptor

Componente

Detalles

Tipo de Receptor (configurado al activar el OAF adecuado)

Euro-80 GD G-GPSL1

GD -GPSL1/L2
Euro-112 (HE_GGD) | G: GPSL1

GD: GPSLYVL2

GG: GPS/IGLONASS L1
GGD: GPS/GLONASS L1/L2

Especificaciones de Rastreo

Canales Estandar Euro-80 GD — 20 canales (G, GD)
Euro-112 GGD - 20 candles (G, GG, GD, GGD)
L1GPS, LUL2GPS, L1GLONASS, L1GPS+ L1
GLONASS, WAAS/EGNOS

Opciona Los dias Cenicienta (Cinderella days) (veala

pagina A-10 para obtener més informacién)

P/N 7010-0557-SP
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Especificaciones

Tabla A-1. Especificaciones del Receptor

Componente

Detalles

Sefiales Rastreadas

GPS/GLONASS, L1/L2 C/A 'y Cbdigo Py Portadora,
WAAS/EGNOS

Modo de L evantamiento

Estético

Cinemético (Parar y Seguir)

RTK (Cinemético en Tiempo Real)
DGPS (GPS Diferencial)

Precision del Levantamiento

Estético, Estatico
Répido

For L1+L2 — H: 3mm + 0.5ppm (x baseline length);
V: 5mm + 0.5ppm (x baseline length)

Cinemético, RTK

For L1+ L2 —H: 10mm + 1.0ppm (x baseline length);
V: 15mm + 1.0ppm (x baseline length)

Arranque Frio < 60 segundos
Arranque Célido < 10 segundos
Readquisicion < 1 segundos
Tecnologia
Rastreo Co-Op
Rastreo de sefia baja
Mitigacion avanzada del efecto multipath
WAAS
Parametros gjustables PLL y DLL
Radio Enlace
Frecuencia 902/-928 MHz).

Estructura de la sefial

Espectro amplio con salto de frecuencia

Patron de Salto 5 por banda, seleccionable por el usuario
Canales de salto 128

Ancho de banda 100 KHz

ocupado

Topcon
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Especificaciones del Receptor

Tabla A-1. Especificaciones del Receptor

Componente Detalles
Técnicade FSK, 64 Kbs
modulacién de
frecuencia
Ganancia del sistema 140 dB

Topologia de Red

Punto a punto, punto a multipunto

Radio Transmisor

Potencia de salida

250 mW (24 dBm)/1 W (30 dBm), seleccionable por
el usuario

Radio Receptor
Sensibilidad -110 dBm en 10-4 BER
Rango dinamico 110dB

Comunicaciones de Datos del Radio

Interfaz seria RS-232
Velocidad de datos 9600, 19200, 38400, 57600 bps, seleccionable por €l
seriales usuario

Tasa efectiva de radio
enlace

9600, 12000, 17000, 24000, 51000 bps, seleccionable
por el usuario

Correccion de errores

FEC (15,7), decodificacion por |6gica mayoritaria

Antenadel Radio

Tipo Conexion flexible para frecuencias de %2 onda
Conector TNC de polaridad invertida
Ganancia 25dBi

Requerimientos de Energia del Radio

Voltaje de
alimentacion

6-16 VDC

P/N 7010-0557-SP
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Especificaciones

Tabla A-1. Especificaciones del Receptor

Componente

Detalles

Consumo de energia

Modo Operativo Voltaje Consumo
(vDC) (W)

Transmisor 0.25W 8.4 1.5
Transmisor 1 W 8.4 29
Receptor 84 0.45

Especificaciones del Modulo Bluetooth

Tipo

Clase 2

Clases de servicio

Varios

Perfiles soportados

LM, L2CAP, SDP, PPP

Cadigo de Pais de
Frecuencia

Américadel Nortey Europa

Almacenamiento y Visualizacion de Datos

Indicadoresy
Controles de Estado

Cuatro LEDs de tres colores y tres teclas de funcion

Caracteristicas de los Datos

Tasa de actualizacion de hasta 20 Hz para
posicionamiento y datos sin procesar en tiempo real
(codigo y portadora)

Fase de cédigo de 10cm y precision de la portadora
de 0.1mm

Version 2.1, 2.2,y 2.3 RTCM SC104 1/0

RTCM Base Mlltiple

Modelos de Variacion Geoide y Magnética

RAIM

Soporta diferentes DATUMs

Exportacién de coordenadas de cuadricula

Soporte CMR y CMR+

Topcon
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Especificaciones del Receptor

Tabla A-1. Especificaciones del Receptor

Componente

Detalles

110

Puertos de
Comunicacion

Hasta cuatro puertos de serie RS232 de alta
velocidad.
Laopcién HiPer Litet+ también tiene un puerto USB.

Conectores Antena Médem, de Energia, USB (sdlo la opcidn
HiPer Lite+)

MINTER Cuatro LEDs internos
Entrada de control ENCENDIDO/APAGADO

Antena

Antena GPS/ Interna

GLONASS

Tipo de Antena Microstrip

Memoria

Memorialnterna

Tarjetaflash compacta (no removible)

Capacidad Estdndar -0 MB
Max —512 MB (HiPer Lite) 0 1 GB (HiPer Litet)
Tiempo de Registro 53 horas (8 MB, 15seg, L1/L2, 7 satélites)
Intervalo de Registro 0.05 a 86400 segundos, dependiendo de |as opciones
adquiridas
Energia

Bateria Interna

Litio-i6n, 4000 mAh, 7.4V

Tamarfio de laBateria | 132 x 35x 18 (mm)
Peso de la Bateria 165 g (1 bateria)
NUmero de baterias 2 baterias

internas

Bateria de cambio

Bateria no descartable

P/N 7010-0557-SP
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Especificaciones

Tabla A-1. Especificaciones del Receptor

Componente

Detalles

Tiempo de Operacion

Con radio APAGADO:
~23.5 horas para el HiPer Lite
~19 horas para el HiPer Litet
Con radio ENCENDIDO y Unicamente en modo de
recepcion:
~19 horas para el HiPer Lite
~16 horas parael HiPer Litet+
Con radio ENCENDIDOQO y (nicamente con
transmision de 0.25 Vatios:
~15 horas para el HiPer Lite
~14 horas para el HiPer Litet+
Con radio ENCENDIDO y Unicamente con
transmision de 1 Vatio:
~13 horas para el HiPer Lite
~10 horas para el HiPer Litet

Energia externa

1 puerto

Voltaje de entrada 6a28V DC (paratrabajo)
9a28V DC (paralabateria de carga)
Corriente Minima de Carga<=2 Amp
Consumo Normal: 2.5W
Méximo: 2.7W

Bateria incorporada

Bateria de repuesto para almacenamiento de fechay
horay de datos, 10 afios minimo de operacion

Medioambiente
Temperatura operativa | -30 C° a+ 60 C° con baterias
Temperaturade -40 C° a+75 C° con baterias

almacenamiento

Caracterigticas fisicas

Carcasa

De auminio extruido, a prueba de lluvia

Color

Amarillo Topcon

Topcon
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Especificaciones del Receptor

Tabla A-1. Especificaciones del Receptor

Componente Detalles
Dimensiones Ancho:159 x Alto:88 x Didmetro:172 mm
Peso 1.74 kg
Antena Interna
Bateria Dos baterias internas
Regulador Externo
Montaje 5/8-11
Sellos Silicio (moldeado en Color)
Teclas Tresteclas:
Encendido/Apagado
Funcion (FN) — iniciar/detener registro de datos,
cambiar modo de informacion
Inicializar —inicializacién del hardware del
receptor
LEDs Cuatro LEDs:
ESTADO —estado del satélitey del receptor
REGISTRO —estado de registro y datos
BATERIA — estado de la bateria
RX — estado del médem
NMEA
Versién de NMEA Version: Salida2.1, 2.2, 2.3, 3.0
Mensajes GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT,

RMC, VTG, ZDA, ROT

Intervalo de salida

1Hz esténdar; 5, 10, 20Hz opcional

DGPS

Formato de correccion

RTCM SC104 Version 2.1,2.2,y 2.3

Tipo de mensaje
RTCM

1, 3,9, 31, 32, 34; eleccionable por €l usuario

P/N 7010-0557-SP
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Especificaciones

Tabla A-1. Especificaciones del Receptor

Componente

Detalles

Intervalo del proceso

1Hz estandar; 5, 10, 20Hz opcional

Intervalo de salida
paralos datos de
correccion RTCM

1Hz esténdar; 5, 10, 20Hz opcional

Méscara de elevacion

0 a 90 grados (independientemente del registro de
datos)

DGPS Multibase

Modo de seleccion de correccion diferencial: Més
Cercano, Mixto, Mejor (opcional)

RTK

Formato de correccion

CMR2/CMR+ (compatible con Trimble), RTCM
SC104 Version 2.2 0 2.3

Tipo de mensgje
RTCM

3, 18, 19, 20, 21, 22; eleccionable por e usuario

Inicializacion de
Ambiguedad

OTF (L1, L1L2)

Longitud de lalinea
de base

Hasta 50 Km. en lamafianay tarde. Hasta 32 Km. a
mediodia.

Tiempo de
inicializacion

5 segundos a 10 minutos dependiendo de la longitud
delalineade base y de las condiciones multipath

Intervalo de salida
para CMR/RTCM

1Hz esténdar; 5, 10, 20Hz opcional

Elevacion

0 a 90 grados (independientemente del registro de
datos)

Modo de solucién

Retardo (sincronizacién)
Extrapolacion (no sincronizada)

Intervalo del proceso

1Hz esténdar; 5, 10, 20Hz opcional

Topcon
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Especificaciones del Receptor

Tabla A-1. Especificaciones del Receptor

Componente Detalles

Latencia Modo de retardo — 20 msegundos a 20 segundos
(depende de la latencia que recibe datos de
correccion del receptor base)
Extrapolacion — 20 a 30 msegundos

Registro de Datossin | El receptor puede registrar datos sin procesar en otro

Procesar intervalo durante la operacion RTK

Estado Fijo, Flotante, DOP, Estado del Data Link, Latencia
del Modem, Satélites comunes, Porcentaje defijacion

Resultados Coordenadas RTK, HRMS, VRMS, Matriz de

Covarianza

Nivel defijacion de
ambigliedad

Umbrales seleccionables
Bajo: 95%; Medio: 99.5%; Alto: 99.9%

Funciones de Rastreo

Reduccion Multipath

Caodigo y Portadora

Configuracién PLL/
DLL

Ancho de banda, orden, gjustable

Configuracion del
bucle de rastreo co-op

Encendido/Apagado, Modo Estético, Ancho de
bandade PLL individual, Ancho de banda de PL
comuln

Intervalo de Codigo y Portadora

Suavizamiento

WAASEGNOS WAAS opcional
EGNOS opcional

Cargador de Baterias (Adaptador AC)

Tamafio Ancho:60 x Largo:112 x Alto:36 mm
Peso 235¢

Temperatura 0C°a+40C°

Operativa

P/N 7010-0557-SP
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Especificaciones

Tabla A-1. Especificaciones del Receptor

Componente

Detalles

Temperaturade
amacenamiento

-40C° a+85C°

Entrada CA 1002240V 1A (110V CA)
47a63Hz

Sdlida CC12V 25A (30W)

Conectors Entrada (CA): Receptécul o estdndar CA de 3 espigas
Salida (CC): SAE

Tiempo decargado de | 7 horas parauna Carga Completa

baterias 6 horas para una Carga del 90%

L os dias Cenicienta es una opcion que convierte una frecuencia
simple (receptor GPS) en una doble frecuencia (receptor GPS +
GLONASS) durante 24 horas cada dos martes a la medianoche
GPS. Consuilte €l sitio web de Topcon para obtener mayor
informacién y las fechas Cenicienta especificas.

@ AVISO

Las especificaciones de desempefio asumen un minimo
de 6 satélites GPS por encima de 15 grados de
elevacion y el cumplimiento de los procedimientos
recomendados en el presente manual.

@ AVISO

En aquellas dreas de multipath alto, durante periodos de
gran PDOP, y durante periodos de mayor actividad
ionosférica, el rendimiento podria disminuir.

Topcon
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Especificaciones del Conector

@ AVISO

Utilice los procedimientos de verificacion robusta en

dreas con multipath extremo o en condiciones de follaje
espeso.

Especificaciones del Conector

L as siguientes secciones detallan |os conectores del HiPer Litey del
HiPer Lite+.

Conector para Radio RF (Médem)

El tipo de conector del médem de Espectro amplio (TPS)
(Tabla A-2) es un conector RF hembra TNC invertido.

Tabla A-2. Especificaciones del Conector del Modem de Espectro Amplio/GSM

Tipo Nombre de la Senal Dir Detalles
TNC Modem 1/0 1/10 Salida RF desde la antena del
Inverso maodem

Conector de Energia

El conector de energia (Figura A-1) es un receptacul o sellado,
de 5 espigas nimero de parte ODU G80F1C-T05QF00-0000.

Figura A-1. Conector de Energia

P/N 7010-0557-SP www.topconpositioning.com
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Especificaciones

La Tabla A-3 presentan las especificaciones del conector de
energia.

Tabla A-3. Especificaciones del Conector de Energia

Numero Nombre de la Seial Dir Detalles
1 Power_INP P Entrada CC 6 a 28 voltios
2 Power_INP P Entrada CC 6 a 28 voltios
3 Power_GND P Tierra, retorno de energia
4 Power_ GND P Tierra, retorno de energia
5 Sin utilizar

Conector Serial C-RS232

En el caso delos puertos A y D. Los conectores RS232
(Figura A-2) son receptacul os sellados, de 7 espigas, nimero de
parte ODU G80F1C-T07QC00-0000.

Figura A-2. Conector RS232

A12
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Especificaciones del Conector

La Tabla A-4 presenta las especificaciones del conector para

cables RS232.

Tabla A-4. Especificaciones del Conector RS232

Numero Nombre de la Seiial Dir Detalles
1 Power_ OUT P Sdlida de Energia
(Voltaje Suministrado)
2 GND - Masa de sefial
3 CTS | Listo paraenvio
4 RTS O Solicitud de envio
5 RXD | Recibir Datos
6 TXD o Transmitir Datos
7 Sin utilizar

Conector USB

Unicamente disponible en receptores HiPer Lite+, el conector
USB es un receptaculo cerrado, de 5 espigas, cable conector de

TPS (Figura A-3).

Figura A-3. Conector USB para Opciones GGD
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Especificaciones

La Tabla A-5 presentalas especificaciones del conector USB.

Tabla A-5. Especificaciones USB

Numero Nombre de la Seiial Dir Detalles
1 Sin utilizar
2 USB_PWR P Entrada de energia del bus
3 GND - Tierra
4 USB D+ 110 USB Datos mas
5 USB D- 110 USB Datos menos

A-14
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Apéndice B

nformacion de
Seguridad

Precauciones Generales

@ AVISO

Para cumplir con los requisitos de la exposicion a la RF,
mantenga por lo menos una distancia de 20cm entre el
usuario y el radio médem GSM.

ADVERTENCIA

Los receptores TPS han sido disefiados para efectuar
levantamiento y para fines relacionados con el
mismo (es decir, el levantamiento de coordenadas,
distancias, angulos, profundidades, y el registro de
tales mediciones). Este producto nunca debera
utilizarse:

— Si el usuario no ha comprendido a cabalidad el
presente manual.

— Después de desactivar los sistemas de seguridad o
efectuar modificaciones a este producto.

— Con accesorios no autorizados.

— Si el sitio en el que se va a realizar el levantamiento
no ofrece las garantias necesarias.
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B-2

Informacién de Seguridad

— En contra de las leyes, normas y regulaciones
vigentes.

@ PELIGRO

NUNCA uTILICE LOS RECEPTORES TPS EN AMBIENTES
PELIGROSOS. SU USO EN LA LLUVIA O NIEVE ESTA
PERMITIDO DURANTE UN TIEMPO LIMITADO.

Advertencias sobre el Paquete Interno
de Baterias

@ PELIGRO

iNUNCA TRATE DE ABRIR LA CUBIERTA DE LOS RECEPTORES
O DE CAMBIAR LAS BATERIAS! jEL USO INCORRECTO DE LAS
BATERIAS DE LITIO-ION PUEDE SER PELIGROSO!

@ PELIGRO

NO INCINERE O CALIENTE EL PAQUETE DE BATERIAS POR
ENCIMA DE 212 GRADOS FARENHEIT (100 GRADOS
CELCIUS). EL CALENTAMIENTO EXCESIVO PODRIA PROVOCAR
DANOS SERIOS E INCLUSO UNA POSIBLE EXPLOSION.

ADVERTENCIA

La manipulacion de las baterias internas por parte de
usuarios finales y/o técnicos no autorizados
invalidara la garantia del receptor.

— No trate de abrir o cambiar el paquete de baterias.

— No desarme el paquete de baterias.
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Advertencias sobre el Uso

— No cargue las baterias en condiciones diferentes a
las especificadas.

— Sélo utilice el cargador de bateria especificado.
— No provoque cortocircuitos.

— No comprima o modifique las baterias.

Advertencias sobre el Uso

chm PRECAUCION

Si el producto ha sufrido una caida, alteracién o ha
sido transportado o embarcado sin el empaque
apropiado, o si es sometido a un trato inadecuado,
podria efectuar mediciones incorrectas.

El propietario debe probar este producto de manera
periddica para asegurar la obtencion de mediciones
precisas.

Si este producto no funciona correctamente, informe
inmediatamente a TPS.

chmr PRECAUCION

Este producto podra ser revisado o reparado
unicamente en los centros de servicio autorizados
por TPS.
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Informacién de Seguridad

Notas:

Topcon
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Apéndice C

erminos de Ia
Garantia

L os equipos de posicionamiento laser y electrénico se encuentra
garantizados contra materiales y fabricaci én defectuosos siempre
gue los mismos sean sometidos a un uso normal y alas aplicaciones
descritas en el presente Manual. El equipo se encuentra garantizado
durante el periodo indicado en la tarjeta de garantia que acompafia
al producto, € cua seiniciad diaen que el producto es vendido al

comprador original por los Distribuidores Autorizados de Topcon.l

Durante €l periodo de garantia, TPS, segiin estime conveniente,
reparard o cambiara este producto sin cargo adicional. Las piezas
reparadas y |os repuestos serén entregados una vez que €l
comprador devuelva los productos dafiados y éstos seran
reacondicionados o nuevos. Esta garantia limitada no incluye el
servicio de reparacion de dafios a producto gque resulten de un
accidente, desastre, uso incorrecto, uso excesivo o modificacion del
producto.

El cliente puede solicitar €l servicio de garantia a un distribuidor
autorizado de servicios de garantiade TPS. Si el producto es
enviado por correo, el comprador se compromete a asegurar €l
producto o aasumir el riesgo de pérdida o dafio durante el
transporte, a prepagar |os cargos de embarque al centro de servicio
de garantia, a utilizar el empaque de embarque original o un
equivalente. El paquete debe incluir unacartaen laque se detalle el
problemay/o defecto del equipo.

1. Lagarantiacontra defectos en la bateria, cargador o cable Topcon es
de 90 dias.
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Términos de la Garantia

Launicaopcién quetiene el comprador paracambiar el producto es
la que se especifica lineas arriba. En ningln caso TPS se hace
responsable por |os dafios u otros reclamos que incluyan el lucro
cesante, pérdida de ahorros u otros dafios incidentales o que
resulten del uso o de laincapacidad para utilizar el producto.
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